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Welcome to the CASPER tutorials page! Here you will find all the current tutorials for the SNAP, SKARAB and Red
Pitaya platforms.
The tutorial repository can be found on github and can be downloaded with the command git clone https://
github.com/casper-astro/tutorials_devel.git.
It is recommended to start with the introduction tutorial for the platform of your liking, then do that platform’s GBE
tutorial and finally move onto the spectrometer or correlator tutorial or the next difficulty tutorial.

SNAP Tutorials

1
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SNAP Tutorials

CHAPTER

1

Environment setup

The recommended OS is Ubuntu (currently 20.04) as it is what the majority of the collaboration are using. This makes
it easier for us to support you. If you are so inclined, you could also use Red Hat, but we definitely do not support
Windows. You are welcome to try but you will be on your own. You could always run Linux in a VM although this
will increase your compile times.
The current compatibility matrix of software needed to run these tutorials is below:
(Note that official support for ROACH plaforms is no longer provided, however this version of mlib_devel contains all
ROACH related documentation and ROACH tutorials can be found here)
Hardware
ROACH1/2
SKARAB

Operating System
Ubuntu 14.04
Ubuntu 20.04

Matlab Version
2013b
2021a

SNAP

Ubuntu 20.04

2021a

Red Pitaya

Ubuntu 20.04

2021a

ZCU216

Ubuntu 20.04

2021a

ZCU208

Ubuntu 20.04

2021a

ZCU111

Ubuntu 20.04

2021a

PYNQ RFSoC
4x2
HTG ZRF1629DR
HTG ZRF1649DR

Ubuntu 20.04

2021a

Ubuntu 20.04

2021a

Ubuntu 20.04

2021a

Xilinx Version
ISE 14.7
Vivado
2021.1
Vivado
2021.1
Vivado
2021.1
Vivado
2021.1
Vivado
2021.1
Vivado
2021.1
Vivado
2021.1
Vivado
2021.1
Vivado
2021.1

mlib_devel branch
commit
branch: roach
branch: m2021a

/

Python Version
Python 2.7
Python 3.8

branch: m2021a

Python 3.8

branch: m2021a

Python 3.8

branch: m2021a

Python 3.8

branch: m2021a

Python 3.8

branch: m2021a

Python 3.8

branch: m2021a

Python 3.8

branch: m2021a

Python 3.8

branch: m2021a

Python 3.8
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Instructions on setting up an environment in which to run these tutorials can be found here. Instructions on setting up
the toolflow-proper can be found here.

1.1 Modifications to be run after installs
ROACH1/2
Xilinx removed support for several hardware pcores we use for ROACH1/2 from ISE 14. So the current solution is
to add the following pcores from the Xilinx 11 install to your XPS_ROACH_BASE/pcores folder or to your 14 install
directory at Xilinx/14.7/ISE_DS/EDK/hw/XilinxProcessorIPLib/pcore.
OPB pcores
• bram_if_cntlr_v1_00_a
• bram_if_cntlr_v1_00_b
• ipif_common_v1_00_c
• opb_arbiter_v1_02_e
• opb_bram_if_cntlr_v1_00_a
• opb_ipif_v3_00_a
• opb_opb_lite_v1_00_a
• opb_v20_v1_10_c
• proc_common_v1_00_a
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2

Tutorial Instructions

If you are new to astronomy signal processing, here is Tutorial 0: some basic introduction into astronomy signal
processing. If you already have a lot of experience on it, you can go directly to the introduction tutorials below for
CASPER FPGA design and implementation.
If you are a beginner, we recommend the Step-by-Step tutorials, however if you should get stuck, prefer a less tedious method of learning, or already have decent feel for these tools, links to Completed tutorials are available with
commented models.

2.1 Vivado
SNAP
1. Introduction Tutorial: Step-by-Step or Completed
2. 10GbE Tutorial: Step-by-Step or Completed
3. Spectrometer Tutorial Step-by-Step or Completed
4. Correlator Tutorial Step-by-Step or Completed
5. Yellow Block Tutorial: Bidirectional GPIO

2.1.1 Tutorial 1: Introduction to Simulink
In this tutorial, you will create a simple Simulink design using both standard Xilinx system generator blockset, as well
as library blocks specific to CASPER boards (so-called “Yellow Blocks”). At the end of this tutorial, you will know
how to generate an fpg file, program it to a CASPER FPGA board, and interact with your running hardware design
using casperfpga via a Python Interface.
Creating Your Design
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Create a New Model
Start Matlab via executing the startsg command, as described here. This ensures that necessary Xilinx and CASPER
libraries are loaded into your by Simulink. When MATLAB starts up, open Simulink by typing simulink on the
MATLAB command line. Start a new model, and save it with an appropriate name. With Simulink, it is very wise to
save early, and often.
There are some Matlab limitations you should be aware-of right from the start:
• Do not use spaces in your filenames or anywhere in the file path as it will break the toolflow.
• Do not use capital letters in your filenames or anywhere in the file path as it will break the toolflow.
• Beware block paths that exceed 64 characters. This refers to not only the file path, but also the path to any
block within your design.
– For example, if you save a model file with a name ~/some_really_long_filename.slx, and have a block
called in a submodule the longest block path would be: some_really_long_filename_submodule_block.
– If you use lots of subsystems, this can cause problems.
Library organization
There are three libraries which you will use when you design firmware in Simulink.
1. The CASPER XPS Library contains “Yellow Blocks” – these are blocks which encapsulate interfaces to hardware (ADCs, Memory chips, CPUs, Ethernet ports, etc.)
2. The CASPER DSP Library contains (mostly green) blocks which implement DSP functions such as filters,
FFTs, etc.
3. The Xilinx Library contains blue blocks which provide low-level functionality such as multiplexing, delaying, adding, etc. The Xilinx library also contains the super-special System Generator block, which contains
information about the type of FPGA you are targeting.
Add Xilinx System Generator and XSG core config blocks
Add a System generator block from the Xilinx library by locating the Xilinx Blockset library’s Basic Elements subsection and dragging a System Generator token onto your new file.

6
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xilinx_select_sysg
Do not configure it directly, but rather add a platform block representing the system you care compiling for. These
can be found in the CASPER XPS System Blockset library. For SNAP (and later) platforms, you need a block which
matches the platform name, which can be found in the library under “platforms”, as shown below.

2.1. Vivado
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casper_xps_select_
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casper_xps_select_
Double click on the platform block that you just added. The Hardware Platform parameter should match the platform
you are compiling for. Once you have selected a board, you need to choose where it will get its clock. In designs
including ADCs you probably want the FPGA clock to be derived from the sampling clock, but for this simple design
(which doesn’t include an ADC) you should use the platform’s on-board clock. To do this, set the User IP Clock
Source to sys_clk. The sys_clk rate is 100 MHz, so you should set this for User IP Clock Rate in the block.
The configuration yellow block knows what FPGA corresponds to which platform, and so it will autmoatically configure the System Generator block which you previously added.
The System Generator and XPS Config blocks are required by all CASPER designs
Flashing LED
To demonstrate the basic use of hardware interfaces, we will make an LED flash. With the FPGA running at ~100MHz
(or greater), the most significant bit (msb) of a 27 bit counter will toggle approximately every 0.67 seconds. We can
output this bit to an LED on your board. Most (all?) CASPER platforms have at least four LEDs, with the exact
configuration depending on the board. We will make a small circuit connecting the top bit of a 27 bit counter to one
of these LEDs. When compiled this will make the LED flash with a 50% duty cycle approximately once a second.

2.1. Vivado
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Add a counter
Add a counter to your design by navigating to Xilinx Blockset -> Basic Elements -> Counter and dragging it onto your
model.

xilinx_select_counter.png
Double-click it and set it for free running, 27 bits, unsigned. This means it will count from 0 to 2^27 - 1, and will then
wrap back to zero and continue.

10
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2.1. Vivado
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Add a slice block to select out the msb
We now need to select the most significant bit (msb) of the counter. We do this using a slice block, which Xilinx
provides. Xilinx Blockset -> Basic Elements -> Slice.

Slice_select.png
Double-click on the newly added slice block. There are multiple ways to select which bit(s) you want. In this case, it
is simplest to index from the upper end and select the first bit. If you wanted the least significant bit (lsb), you can also
index from that position. You can either select the width and offset, or two bit locations.
Set it for 1 bit wide with offset from top bit at zero. As you might guess, this will take the 27-bit input signal, and
output just the top bit.
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Add a GPIO block
From: CASPER XPS library -> IO -> gpio.

2.1. Vivado
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casper_xps_select_

casper_xps_select_
In order to send the 1 bit signal you have sliced off to an LED, you need to connect it to the right FPGA output pin.
To do this you can use a GPIO (general-purpose input/output) block from the XPS library, this allows you to route a
signal from Simulink to a selection of FPGA pins, which are addressed with user-friendly names. Set it to use SNAP’s
LED bank as output. Once you’ve chosen the LED bank, you need to pick which LED you want to output to. Set the
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GPIO bit index to 0 (the first LED) and the data type to Boolean with bitwidth 1. This means your simulink input is a
1 bit Boolean, and the output is LED0.

2.1. Vivado
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Add a terminator
To prevent warnings (from MATLAB & Simulink) about unconnected outputs, terminate all unused outputs using a
Terminator:

From: Simulink -> Sinks -> Terminator
You can also use the Matlab function XlAddTerms, run in the MATLAB prompt, to automatically terminate your
unused outputs.
Connect your design
It is a good idea to rename your blocks to something more sensible, like counter_led instead of just counter. Do this
simply by double-clicking on the name of the block and editing the text appropriately.
2.1. Vivado
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To connect the blocks simply click and drag from the ‘output arrow’ on one block and drag it to the ‘input arrow’ of
another block. Connect the blocks together: Counter -> Slice -> gpio as showing in digram below.

Remember to save your design often.
Software control
To demonstrate the use of software registers to control the FPGA from a computer, we will add a registers so that
the counter in our design can be started, stopped, and reset from software. We will also add a register so that we can
monitor the counter’s current value too.
By the end of this section, you will create a system that looks like this:

Slice_circuit.png
Add the software registers
We need two software registers. One to control the counter, and a second one to read its current value. From the
CASPER XPS System Blockset library, drag two Software Registers onto your design.
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casper_xps_select_memory_swreg.png
Set the I/O direction to From Processor on the first one (counter control) to enable a value to be set from software and
sent to your FPGA design. Set it to To Processor on the second one (counter value) to enable a value to be sent from
the FPGA to software. Set both registers to a bitwidth of 32 bits.

2.1. Vivado
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2.1. Vivado

21

CASPER Tutorials Documentation, Release 0.1

Rename the registers to something sensible. The names you give them here are the names you will use to access them
from software. Do not use spaces, slashes and other funny characters in these. Perhaps counter_ctrl and counter_value,
to represent the control and output registers respectively.
Also note that the software registers have sim_reg and sim_out ports. The input port provides a means of simulating
this register’s value (as would be set by the runtime software) using the sim_reg line. The output port provides a means
to simulate this register’s current FPGA-assigned value.
For now, set the sim_reg port to constant one using a Simulink-type constant. Found in Simulink -> Sources. This will
enable the counter during simulations.

During simulation, we can monitor the counter’s value using a scope (Simulink -> Sinks):
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Here is a good point to note that all blocks from the Simulink library (usually white), will not be compiled into
hardware. They are present for simulation only.
Only Xilinx blocks (they are blue with Xilinx logo) will be compiled to hardware.
You need to use gateway blocks whenever connecting a Simulink-provided block (like a scope or sine-wave generator)
to a from a Xilinx block, this will sample and quantize the simulink signals so that they are compatible with the Xilinx
world. Some blocks (like the software register) provide a gateway internally, so you can feed the input of a software
register with a xilinx signal, and monitor its output with a Simulink scope. However, in general, you must manually
insert these gateways where appropriate. Simulink will issue warnings for any direct connections between the Simulink
and Xilinx worlds.

2.1. Vivado
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Add the counter
You can do this either by copying your existing counter block (copy-paste, or ctrl-click-drag-drop) or by placing a new
one from the library.
Configure it with a reset and enable port as follows:
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2.1. Vivado
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Add the slice blocks
Now we need some way to control the enable and reset ports of the counter. We could do this using two separate
software registers, but this is wasteful since each register is 32 bits anyway.
So we’ll use a single register and slice out one bit for enabling the counter, and another bit for resetting it. Either copy
your existing slice block (copy-paste it or hold ctrl while dragging/dropping it) or add two more from the library.
The enable and reset ports of the counter require boolean values (which Simulink interprets differently from ordinary
1-bit unsigned numbers). Configure the slices as follows:
Slice for enable:

casper_xps_param
Slice for reset:
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casper_xps_param
Connect it all up
Now we need to connect all these blocks together. To neaten things up, consider resizing the slice blocks and hiding
their names. Their function is clear enough from their icon without needing to see their names.
Do so by right-clicking and unchecking Format → Show Block Name. You could do this with the counter too, but it’s
not a good idea with the software registers, because otherwise you wouldn’t know how to address them when looking
at your diagram.

2.1. Vivado
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Adder
To demonstrate some simple mathematical operations, we will create an adder. It will add two numbers on demand and
output the result to another software register. Almost all astronomy DSP is done using fixed-point (integer) notation,
and this adder will be no different.
We will calculate a+b = sum_a_b.
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Add the software registers
Add two more input software registers. These will allow us to specify the two numbers to add. Add another output
register for the sum output.
Either copy your existing software register blocks (copy-paste or holding ctrl while dragging/dropping it) or add three
more from the library. Set the I/O direction to From Processor on the first two and set it to To Processor on the third
one.
Add the adder block
Locate the adder/subtractor block, Xilinx Blockset -> Math -> AddSub and drag one onto your design. This block can
optionally perform addition or subtraction. Let’s leave it set at it’s default, for addition.

2.1. Vivado
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The output register is 32 bits. If we add two 32 bit numbers, we will have 33 bits.
There are a number of ways of fixing this:
• limit the input bitwidth(s) with slice blocks
• limit the output bitwidth with slice blocks
• create a 32 bit adder.
Since you have already seen slice blocks demonstrated, let’s try to set the AddSub block to be a 32 bit saturating adder.
On the second tab, set it for user-defined precision, unsigned 32 bits.
Also, under overflow, set it to saturate. Now if we add two very large numbers, it will simply return 2^32 -1.
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Add the scope and simulation inputs
Either copy your existing scope and simulation constants (copy-paste or ctrl-drag) or place a new one from the library
as before. Set the values of the simulation inputs to anything you like.
Connect it all together
Like this:

2.1. Vivado
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Simulating
The design can be simulated with clock-for-clock accuracy directly from within Simulink. Set the number of clock
cycles that you’d like to simulate and press the play button in the top toolbar.

You can watch the simulation progress in the status bar in the bottom right. It will complete in the blink of an eye for
this small design with just 10 clock cycles.
You can double-click on the scopes to see what the signals look like on those lines. For example, the one connected to
the counter should look like this:

The one connected to your adder should return a constant, equal to the sum of the two numbers you entered. You
might have to press the Autoscale button to scale the scope appropriately.
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Once you have verified that that design functions as you’d like, you’re ready to compile for the FPGA. . .
Compiling
Essentially, you have constructed three completely separate little instruments. You have a flashing LED, a counter
which you can start/stop/reset from software and also an adder. These components are all clocked off the same
156.25MHz system clock crystal and to your specified User IP Clock Rate, but they will operate independently.
In order to compile this to an FPGA bitstream, execute the following command in the MATLAB Command Line
window. THIS COMMAND DEPENDS WHICH PLATFORM YOU ARE TARGETING:
>>

jasper

When a GUI pops up, click “Compile!”. This will run the complete build process, which consists of two stages. The
first involving Xilinx’s System Generator, which compiles any Xilinx blocks in your Simulink design to a circuit which
can be implemented on your FPGA. While System Generator is running, you should see the following window pop
up:

2.1. Vivado
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After this, the second stage involves synthesis of your design through Vivado, which goes about turning your design
into a physical implementation and figuring out where to put the resulting components and signals on your FPGA.
Finally the toolflow will create the final output fpg file that you will use to program your FPGA. This file contains
the bitstream (the FPGA configuration information) as well as meta-data describing what registers and other yellow
blocks are in your design. This file will be created in the ‘outputs’ folder in the working directory of your Simulink
model. Note: Compile time is approximately 15-20 minutes.

Advanced Compiling
Once you are familiar with the CASPER toolflow, you might find you want to run the two stages of the compile
separately. This means that MATLAB will become usable sooner, since it won’t be locked up by the second stage of
the compile. If you want to do this, you can run the first stage of the compile from the MATLAB prompt with
>> jasper_frontend

After this is completed, the last message printed will tell you how to finish the compile. It will look something like:
$ python /path_to/mlib_devel/jasper_library/exec_flow.py -m /home/user/path_to/snap/
˓→tut_intro/snap_tut_intro.slx --middleware --backend --software

You can run this command in a separate terminal, after sourcing appropriate environment variables. Not recommended
for beginners.
Programming the FPGA
Reconfiguration of CASPER FPGA boards is achieved using the casperfpga python library, created by the SA-SKA
group.
Getting the required packages
These are pre-installed on the server in the workshop and you do not need to do any further configuration. However,
should you want to run these tutorials on your own machines, you should download the latest casperfpga libraries from
here.
Copy your .fpg file to your Server
As per the previous figure, navigate to the outputs folder and (secure)copy this across to a test folder on the workshop
server. Instructions to do this are available here
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Connecting to the board
SSH into the server that the SNAP board is connected to and navigate to the folder in which your .fpg file is stored.
Start interactive python by running:
$ ipython

Now import the fpga control library. This will automatically pull-in the KATCP library and any other required communications libraries.
import casperfpga

To connect to the board we create a CasperFpga instance; let’s call it fpga. The CasperFpga constructor requires just
one argument: the IP hostname or address of your FPGA board.
fpga = casperfpga.CasperFpga('SNAP hostname or ip_address')

The first thing we do is program the FPGA with the .fpg file which your compile generated.
fpga.upload_to_ram_and_program('your_fpgfile.fpg')

Should the execution of this command return true, you can safely assume the FPGA is now configured with your
design. You should see the LED on your board flashing. Go check! All the available/configured registers can be
displayed using:
fpga.listdev()

The adder and counter can be controlled by writing to and reading from registers added in the design using:
fpga.write_int('a',10)
fpga.write_int('b',20)
fpga.read_int('sum_a_b')

With any luck, the sum returned by the FPGA should be correct.
You can also try writing to the counter control registers in your design. You should find that with appropriate manipulation of the control register, you can make the counter start, stop, and return to zero.
fpga.write_int('counter_ctrl',10')
fpga.read_uint('counter_value')

Conclusion
This concludes the first CASPER Tutorial. You have learned how to construct a simple Simulink design, program an
FPGA board and interact with it with Python using casperfpga. Congratulations!
While the design you made might not be very complicated, you now have the basic skills required to build more
complex designs which are covered in later tutorials.

2.1.2 Tutorial 2: 10GbE Interface

2.1. Vivado
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Introduction
In this tutorial, you will create a simple Simulink design which uses the SNAP’s 10GbE ports to send data at high
speeds to another port. This could just as easily be another FPGA board or a computer with a 10GbE network interface
card. In addition, we will learn to control the design remotely, using a supplied Python library for KATCP.
In this tutorial, a counter will be transmitted through one SFP+ port and back into another. This will allow a test of the
communications link. This test can be used to test the link between boards and the effect of different cable lengths on
communication robustness.
Background
SNAP boards have two on-board SFP+ ports. The Ethernet interface is driven by an on-board 156.25MHz crystal
oscilator. This clock is then multiplied up on the FPGA by a factor of 66. Thus, the speed on the wire is actually
156.25MHz x 66 = 10.312.5 Gbps. However, 10GbE over single-lane SFP+ connectors uses 64b/66b encoding, which
means that for every 66 bits sent, 66 bits are actually transmitted. This is to ensure proper clocking, since the receiver
recovers and locks-on to the transmitter’s clock and requires edges in the data. Imagine transmitting a string of 0xFF
or 0b11111111. . . which would otherwise generate a DC level on the line, now an extra two bits are introduced which
includes a zero bit which the receiver can use to recover the clock and byte endings. See here for more information.
For this reason, we actually get 10Gbps usable data rate. CASPER’s 10GbE Simulink core sends and receives UDP
over IPv4 packets. These IP packets are wrapped in Ethernet frames. Each Ethernet frame requires a 38 byte header,
IPv4 requires another 20 bytes and UDP a further 16. So, for each packet of data you send, you will incur a cost of at
least 74 bytes. I say at least, because the core will zero-pad some headers to be on a 64-bit boundary. You will thus
never achieve 10Gbps of usable throughput, though you can get close. It pays to send larger packets if you are trying
to get higher throughputs.
The maximum payload length of the CASPER 10GbE core is 8192 bytes (implemented in BRAM) plus another 512
(implemented in distributed RAM) which is useful for an application header. These ports (and hence part of the 10
GbE cores) run at 156.25MHz, while the interface to your design runs at the FPGA clock rate (sys_clk, adcX_clk etc).
The interface is asynchronous, and buffers are required at the clock boundary. For this reason, even if you send data
between two SNAP boards which are running off the same hard-wired clock, there will be jitter in the data. A second
consideration is how often you clock values into the core when you try to send data. If your FPGA is running faster
than the core, and you try and clock data in on every clock cycle, the buffers will eventually overflow. Likewise for
receiving, if you send too much data to a board and cannot clock it out of the receive buffer fast enough, the receive
buffers will overflow and you will lose data. In our design, we are clocking the FPGA at 100 MHz, with the cores
running at 156.25MHz. We can thus clock data into the TX buffer continuously without worrying about overflows.
Create a new model
Start Matlab and open Simulink (either by typing ‘simulink’ on the Matlab command line, or by clicking on the
Simulink icon in the taskbar). A template is provided for Tut2 with a pre-created packet generator in the tutorials_devel
git repository. Get a copy of this template and save it. You will need the SNAP block in the Platforms subdirectory of
the xps_library. Specify a clock frequency of 100 MHz and the clock source “sys_clock”.
Add reset logic
A very important piece of logic to consider when designing your system is how, when and what happens during reset.
In this example we shall control our resets via a software register. We shall have two independent resets, one for the
10GbE cores which shall be used initially, and one to reset the user logic which may be used more often to restart the
user part of the system. Construct reset circuitry as shown below.
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Add a software register
Use a software register yellow block from the CASPER XPS System Blockset for the rst block. Rename it to rst.
It used to be that every register you inserted had to be natively 32-bits, and you were responsible for slicing these 32
bits into different signals if you want to control multiple flags. The latest block can implicitly break the 32-bit registers
out into separate names signals, so we’ll use that. The downside is there are a bunch of settings to configure – you
need to set up the names and data types of your register subfields. You can configure the register as follows:

2.1. Vivado
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Add Goto blocks
Add two Goto blocks from Simulink->Signal Routing. Configure them to have the tags as shown (core_rst and
cnt_rst). These tags will be used by associated From (also found in Simulink->Signal Routing) blocks in other parts
of the design. These help to reduce clutter in your design and are useful for control signals that are routed to many
destinations. They should not be used a lot for data signals as it reduces the ease with which data flow can be seen
through the system.
Add 10GbE and associated registers for data transmission
We will now add the 10GbE block to transmit a counter at a programmable rate.
Add a 10GbE block for data transmission
Add a ten_GbE yellow block from the CASPER XPS System Blockset. It will be used to transmit data and we shall
add another later to receive data. Rename it gbe0. Double click on the block to configure it and set it to be associated
with SFP+ port 0. If your application can guarantee that it will be able to use received data straight away (as our
application can), shallow receive buffers can be used to save resources. This optimisation is not necessary in this case
as we will use a small fraction of resources in the FPGA.

Add registers to provide the target IP address and port number
Add two yellow-block software registers to provide the destination IP address and port number for transmission with
the data. Name one dest_ip and the other dest_port. The registers should be configured to receive their values from
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the processor. Connect them to the appropriate inputs of the gbe0 10GbE block as shown. A Slice block is required to
use the lower 16 bits of data from the dest_port register. Constant blocks from Simulink->Sources with 0 values are
attached to the simulation inputs of the software registers. The destination port and IP address are not important in this
system as it is a loopback example. Add a From block from Simulink->Signal Routing and set the tag to use core_rst,
this enables one to reset the block.

Create a subsystem to generate a counter to transmit as data
We will now implement logic to generate a counter to transmit as data. This is already included in the Template for
Tut 2. Some details are provided here for completeness.
Construct a subsystem for data generation logic
It is often useful to group related functionality and hide the details. This reduces drawing space and complexity of the
logic on the screen, making it easier to understand what is happening. Simulink allows the creation of Subsystems to
accomplish this.
These can be copied to places where the same functionality is required or even placed in a library for use in other
projects and by other people. To create a subsystem, one can highlight the logical elements to be encapsulated, then
right-click and choose Create Subsystem from the list of options. You can also simply add a Subsystem block from
Simulink->Ports & Subsystems.
Subsystems inherit variables from their parent system. Simulink allows one to create a variable whose scope is only a
particular subsystem. To do this, right-click on a subsystem and choose the Create Mask option. The mask created for
that particular subsystem allows one to add parameters that appear when you double-click on the icon associated with
the subsystem.
The mask also allows you to associate an initialisation script with a particular subsystem. This script is called every
time a mask parameter is modified and the Apply button clicked. It is especially useful if the internal structure of a
subsystem must change based on mask parameters. Most of the interesting blocks in the CASPER library use these
initialisation scripts.
Drop a subsystem block into your design and rename it pkt_sim. Then double-click on it to add logic.
Add a counter to generate a certain amount of data
Add a Counter block from Xilinx Blockset->Basic Elements and configure it to be unsigned, free-running, 32-bits,
incrementing by 1 as shown. Add a Relational block, software register and Constant block as shown. In simulation
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this circuit will generate a counter from 0 to 49 and then stop counting. This will allow us to generate 50 data elements
before stopping.
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Add a counter to limit the data rate
As mentioned earlier in this tutorial, it is impossible to supply data to the 10GbE transmission block at the full clock
rate. This would mean transmitting a 64-bit word at 200MHz, and the 10GbE standard only supports up to 156.25MHz
data transmission. We thus want to generate data in bursts such that the transmission FIFOs do not overflow. We thus
add circuitry to limit the data rate as shown below. The logic that we have added on the left generates a reset at a
fixed period determined by the software register. This will trigger the generation of a new packet of data as before. In
simulation this allows us to limit the data rate to 50/200 * 200MHz = 50MHz. Using these values in actual hardware
would limit the data rate to (50/(8/10*156.25)) = 4Gbps.

Finalise logic including counter to be used as data
We will now finalise the data generation logic as shown below. To save time, use the existing logic provided with
the tutorial. Counter1 in the illustration generates the actual data to be transmitted and the enable register allows this
data stream to the transmitting 10GbE core to be turned off and on. Logic linked to the eof output port provides an
indication to the 10GbE core that the final data word for the frame is being sent. This will trigger the core to begin
transmission of the frame of data using the IP address and port number specified.
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Receive blocks and logic
The receive logic is is composed of another 10GbE yellow block with the transmission interface inputs all tied to 0
as no transmission is to be done, however Simulink requires all inputs to be connected. Connecting them to 0 should
ensure that during synthesis the transmission logic for this 10GbE block is removed. Double click on the block to
configure it and set it to be associated with SFP+ port 1.
Buffers to capture received and transmitted data
The casperfpga Python package contains all kinds of methods to interact with your 10GbE cores. For example,
grabbing packets from the TX and RX stream, or counting the number of packets sent and received are all supported,
as long as you turn on the appropriate functionality in the 10GbE yellow block. The settings we’ll use are –
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You can see how to use these functions in the software that accompanies this tutorial.
LEDs and status registers
You can also sprinkle around other registers or LEDs to monitor status of core parameters, or give visual feedback that
the design is doing something sane. Check out the reference model for some examples of potentially useful monitoring
circuitry.
Compilation
Compiling this design takes approximately 20 to 30 minutes. A pre-compiled binary (.fpg file) is made available to
save time.
Programming and interacting with the FPGA
A pre-written python script, ‘’snap_tut_tge.py” is provided. This script programs the fpga with your complied design
(.fpg file) configures the 10GbE Ports and initiates data transfer. The script is run using:
./snap_tut_tge.py <SNAP_IP_ADDRESS>
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If everything goes as expected, you should see a whole bunch of lines running across your screen as the code sets
up the IP/MAC parameters of the 10GbE cores and checks their status, and that the data the cores are sending
and receiving are consistent. Have a look at this code to see how one uses the more advanced (i.e. more complex
that read_int, and write_int) methods casperfpga makes available. Documentation for casperfpga is still a work in
progress(!) but the basic idea is that when you instantiate a CasperFpga, the software intelligently builds python objects into this instance, based on what you put in your design. For example, your Ethernet cores should show up as
objects CasperFpga.gbes.<simulink_block_name> (or CasperFpga.gbes[‘simulink_block_name’]) which have useful
methods like “setup”, which sets the core’s IP/MAC address, or “print_10gbe_core_details” wich will print out useful
status information, like the current state of the core’s ARP cache. iPython and tab-complete are your friend here, there
are lots of handy methods to discover. (I’m still discovering them now :) )
The control software should be(!) well-commented, to explain what’s going on behind the scene as the software
interacts with your FPGA design.
Conclusion
This concludes Tutorial 2. You have learned how to utilize the 10GbE ports on a SNAP to send and receive UDP
packets. You also learned how to further use the Python to program the FPGA and control it remotely using some of
the OOP goodies avaiable in casperfpga.

2.1.3 Tutorial 3: Wideband Spectrometer
Introduction
A spectrometer is something that takes a signal in the time domain and converts it to the frequency domain. In digital
systems, this is generally achieved by utilising the FFT (Fast Fourier Transform) algorithm. However, with a little bit
more effort, the signal to noise performance can be increased greatly by using a Polyphase Filter Bank (PFB) based
approach.
When designing a spectrometer for astronomical applications, it’s important to consider the science case behind it. For
example, pulsar timing searches will need a spectrometer which can dump spectra on short timescales, so the rate of
change of the spectra can be observed. In contrast, a deep field HI survey will accumulate multiple spectra to increase
the signal to noise ratio. It’s also important to note that “bigger isn’t always better”; the higher your spectral and time
resolution are, the more data your computer (and scientist on the other end) will have to deal with. For now, let’s skip
the science case and familiarize ourselves with an example spectrometer.
Setup
This tutorial comes with a completed model file, a compiled bitstream, ready for execution on ROACH, as well as a
Python script to configure the ROACH and make plots. Here
Spectrometer Basics
When designing a spectrometer there are a few main parameters of note:
• Bandwidth: The width of your frequency spectrum, in Hz. This depends on the sampling rate; for complex
sampled data this is equivalent to:
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In contrast, for real or Nyquist sampled data the rate is half this:

as two samples are required to reconstruct a given waveform .
• Frequency resolution: The frequency resolution of a spectrometer, ∆f, is given by

,
and is the width of each frequency bin. Correspondingly, ∆f is a measure of how precise you can measure a frequency.
• Time resolution: Time resolution is simply the spectral dump rate of your instrument. We generally accumulate
multiple spectra to average out noise; the more accumulations we do, the lower the time resolution. For looking
at short timescale events, such as pulsar bursts, higher time resolution is necessary; conversely, if we want to
look at a weak HI signal, a long accumulation time is required, so time resolution is less important.
Simulink / CASPER Toolflow
Simulink Design Overview
If you’re reading this, then you’ve already managed to find all the tutorial files. Jason has gone to great effort to create
an easy to follow simulink model that compiles and works. By now, I presume you can open the model file and have a
vague idea of what’s happening. The best way to understand fully is to follow the arrows, go through what each block
is doing and make sure you know why each step is done. To help you through, there’s some “blockumentation” in the
appendix, which should (hopefully) answer all questions you may have. A brief rundown before you get down and
dirty:
• The all important Xilinx token is placed to allow System Generator to be called to compile the design.
• In the MSSGE block, the hardware Platform is set to “SNAP:xc7k160t” and clock rate is specified as 200MHz.
• The input signal is digitised by the ADC, resulting in four parallel time samples of 8 bits each clock cycle. The
ADC runs at 800MHz, which gives a 400MHz nyquist sampled spectrum. The output range is a signed number
in the range -1 to +1 (ie 7 bits after the decimal point). This is expressed as fix_8_7.
• The four parallel time samples pass through the pfb_fir_real and fft_wideband_real blocks, which together
constitute a polyphase filter bank. We’ve selected 212=4096 points, so we’ll have a 211=2048 channel filter
bank.
• You may notice Xilinx delay blocks dotted all over the design. It’s common practice to add these into the design
as it makes it easier to fit the design into the logic of the FPGA. It consumes more resources, but eases signal
timing-induced placement restrictions.
• The real and imaginary (sine and cosine value) components of the FFT are plugged into power blocks, to
convert from complex values to real power values by squaring. They are also scaled by a gain factor before
being quantised. . .
• The requantized signals then enter the vector accumulators, vacc0 and vacc1, which are simple_bram_vacc 64
bit vector accumulators. Accumulation length is controlled by the acc_cntrl block.
• The accumulated signal is then fed into software registers, odd and even.
Without further ado, open up the model file and start clicking on things, referring the blockumentation as you go.
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adc

The first step to creating a frequency spectrum is to digitize the signal. This is done with an ADC – an Analogue to
Digital Converter. In Simulink, the ADC daughter board is represented by a yellow block. Work through the “iADC
tutorial” if you’re not familiar with the iADC card.
The ADC block converts analog inputs to digital outputs. Every clock cycle, the inputs are sampled and digitized to 8
bit binary point numbers in the range of -1 to 1 and are then output by the ADC. This is achieved through the use of
two’s-compliment representation with the binary point placed after the seven least significant bits. This means we can
represent numbers from -128/128 through to 127/128 including the number 0. Simulink represents such numbers with
a fix_8_7 moniker.
ADCs often internally bias themselves to halfway between 0 and -1. This means that you’d typically see the output of
an ADC toggling between zero and -1 when there’s no input. It also means that unless otherwise calibrated, an ADC
will have a negative DC offset.
The ADC has to be clocked to four times that of the FPGA clock. In this design the ADC is clocked to 800MHz, so
the ROACH will be clocked to 200MHz . This gives us a bandwidth of 400MHz, as Nyquist sampling requires two
samples (or more) each second.
INPUTS
OUTPUTS
The ADC outputs two main signals: i and q, which correspond to the coaxial inputs of the ADC board. In this tutorial,
we’ll only be using input i. As the ADC runs at 4x the FPGA rate, there are four parallel time sampled outputs: i0, i1,
i2 and i3. As mentioned before, these outputs are 8.7 bit.
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pfb_fir_real

There are two main blocks required for a polyphase filter bank. The first is the pfb_fir_real block, which divides
the signal into parallel ‘taps’ then applies finite impulse response filters (FIR). The output of this block is still a
time-domain signal. When combined with the FFT_wideband_real block, this constitutes a polyphase filterbank.
INPUTS/OUTPUTS
As the ADC has four parallel time sampled outputs: i0, i1, i2 and i3, we need four parallel inputs for this PFB
implementation.
PARAMETERS
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fft_wideband_real

The FFT_wideband_real block is the most important part of the design to understand. The cool green of the FFT
block hides the complex and confusing FFT butterfly biplex algorithms that are under the hood. You do need to have a
working knowledge of it though, so I recommend reading Chapter 8 and Chapter 12 of Smith’s free online DSP guide
at (http://www.dspguide.com/). Parts of the documentation below are taken from the [[Block_Documentation | block
documentation]] by Aaron Parsons and Andrew Martens.
INPUTS/OUTPUTS
PARAMETERS
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power

The power block computes the power of a complex number. The power block typically has a latency of 5 and will
compute the power of its input by taking the sum of the squares of its real and imaginary components. The power
block is written by Aaron Parsons and online documentation is by Ben Blackman. In our design, there are two power
blocks, which compute the power of the odd and even outputs of the FFT. The output of the block is 36.34 bits; the
next stage of the design re-quantizes this down to a lower bitrate.
INPUTS/OUTPUTS
PARAMETERS
quant

The quant0 was written by Jason Manley for this tutorial and is not part of the CASPER blockset. The block requantizes from 36.34 bits to 6.5 unsigned bits, in preparation for accumulation by the 32 bit bram_vacc block. This
block also adds gain control, via a software register. The tut3.py script sets this gain control. You would not need
to re-quantize if you used a larger vacc block, such as the 64bit one, but it’s illustrative to see a simple example of
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re-quantization, so it’s in the design anyway. Note that the sync_out port is connected to a block, acc_cntrl, which
provides accumulation control.
INPUTS/OUTPUTS
PARAMETERS
None.
simple_bram_vacc

The simple_bram_vacc block is used in this design for vector accumulation. Vector growth is approximately 28
bits each second, so if you wanted a really long accumulation (say a few hours), you’d have to use a block such
as the qdr_vacc or dram_vacc. As the name suggests, the simple_bram_vacc is simpler so it is fine for this demo
spectrometer. The FFT block outputs 1024 cosine values (odd) and 1024 sine values, making 2048 values in total.
We have two of these bram vacc’s in the design, one for the odd and one for the even frequency channels. The vector
length is thus set to 1024 on both.
PARAMETERS
INPUTS/OUTPUTS
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Even and Odd BRAMs

The final blocks, odd and even, are shared BRAMs, which we will read out the values of using the tut3.py script.
PARAMETERS
INPUTS/OUTPUTS
Software Registers
There are a few control registers, led blinkers, and snap block dotted around the design too:
• cnt_rst: Counter reset control. Pulse this high to reset all counters back to zero.
• acc_len: Sets the accumulation length. Have a look in tut3.py for usage.
• sync_cnt: Sync pulse counter. Counts the number of sync pulses issued. Can be used to figure out board uptime
and confirm that your design is being clocked correctly.
• acc_cnt: Accumulation counter. Keeps track of how many accumulations have been done.
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• led0_sync: Back on topic: the led0_sync light flashes each time a sync pulse is generated. It lets you know your
ROACH is alive.
• led1_new_acc: This lights up led1 each time a new accumulation is triggered.
• led2_acc_clip: This lights up led2 whenever clipping is detected.
There are also some snap blocks, which capture data from the FPGA fabric and makes it accessible to the Power PC.
This tutorial doesn’t go into these blocks (in its current revision, at least), but if you have the inclination, have a look at
their documentation. In this design, the snap blocks are placed such that they can give useful debugging information.
You can probe these through KATCP, as done in Tutorial 1, if interested. If you’ve made it to here, congratulations, go
and get yourself a cup of tea and a biscuit, then come back for part two, which explains the second part of the tutorial
– actually getting the spectrometer running, and having a look at some spectra.
Configuration and Control
Hardware Configuration
The tutorial comes with a pre-compiled fpg file, which is generated from the model you just went through
(snap_tut_spec.fpg) Load up your SNAP. You don’t need to telnet in to the SNAP; all communication and configuration will be done by the python control script called snap_tut_spec.py.
Next, you need to set up your SNAP. Switch it on, making sure that:
• You have some signal on your ADC input.
• You have your 10MHz reference clock connected to the appropriate SNAP input.
The snap_tut_spec.py spectrometer script
Once you’ve got that done, it’s time to run the script. If you’re in linux, browse to where the snap_tut_spec.py file is
in a terminal and at the prompt type
./snap_tut_spec.py <SNAP IP or hostname> -b <fpgfile name>

replacing with the IP address of your SNAP and with your fpgfile. You should see a spectrum like this:
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In the plot, there should be a fixed DC offset spike; and if you’re putting in a tone, you should also see a spike at the
correct input frequency. If you’d like to take a closer look, click the icon that is below your plot and third from the
right, then select a section you’d like to zoom in to. The digital gain (-g option) is set to maximum (0xffff_ffff) by
default to observe the ADC noise floor. Reduce the gain (decrease the value (for a -10dBm input 0x100)) when you
are feeding the ADC with a tone, as not to saturate the spectrum.
Now you’ve seen the python script running, let’s go under the hood and have a look at how the FPGA is programmed
and how data is interrogated. To stop the python script running, go back to the terminal and press ctrl + c a few times.
iPython walkthrough
The tut3.py script has quite a few lines of code, which you might find daunting at first. Fear not though, it’s all pretty
easy. To whet your whistle, let’s start off by operating the spectrometer through iPython. Open up a terminal and type:
ipython

and press enter. You’ll be transported into the magical world of iPython, where we can do our scripting line by line,
similar to MATLAB. Our first command will be to import the python packages we’re going to use:
import corr,time,numpy,struct,sys,logging,pylab

Next, we set a few variables:
katcp_port = 7147

Which we can then use in FpgaClient() such that we can connect to the ROACH and issue commands to the FPGA:
fpga = casperfpga.CasperFpga(snap)

We now have an fpga object to play around with. To check if you managed to connect to your ROACH, type:
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fpga.is_connected()

Let’s set the bitstream running using the progdev() command:
fpga.upload_to_ram_and_program('snap_tut_spec.fpg')

Now we need to configure the accumulation length and gain by writing values to their registers. For two seconds and
maximum gain: accumulation length, 2*(2^28)/2048, or just under 2 seconds:
fpga.write_int('acc_len',2*(2**28)/2048)
fpga.write_int('gain',0xffffffff)

Finally, we reset the counters:
fpga.write_int('cnt_rst',1)
fpga.write_int('cnt_rst',0)

To read out the integration number, we use fpga.read_uint():
acc_n = fpga.read_uint('acc_cnt')

Do this a few times, waiting a few seconds in between. You should be able to see this slowly rising. Now we’re ready
to plot a spectrum. We want to grab the even and odd registers of our PFB:
a_0=struct.unpack('>1024l',fpga.read('even',1024*4,0))
a_1=struct.unpack('>1024l',fpga.read('odd',1024*4,0))

These need to be interleaved, so we can plot the spectrum. We can use a for loop to do this:
interleave_a=[]
for i in range(1024):
interleave_a.append(a_0[i])
interleave_a.append(a_1[i])

This gives us a 2048 channel spectrum. Finally, we can plot the spectrum using pyLab:
pylab.figure(num=1,figsize=(10,10))
pylab.plot(interleave_a)
pylab.title('Integration number %i.'%acc_n)
pylab.ylabel('Power (arbitrary units)')
pylab.grid()
pylab.xlabel('Channel')
pylab.xlim(0,2048)
pylab.show()

Voila! You have successfully controlled the SNAP spectrometer using python, and plotted a spectrum. Bravo! You
should now have enough of an idea of what’s going on to tackle the python script. Type exit() to quit ipython.
snap_tut_spec.py notes ==
Now you’re ready to have a closer look at the snap_tut_spec.py script. Open it with your favorite editor. Again, line
by line is the only way to fully understand it, but to give you a head start, here’s a few notes:
Connecting to the SNAP
To make a connection to the SNAP, we need to know what port to connect to, and the IP address or hostname of our
SNAP. The connection is made on line 73:
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fpga = casperfpga.CasperFpga(snap)

The katcp_port variable is set on line 13, and the roach variable is passed to the script at the terminal (remember that
you typed python snap_tut_spec.py roachname). We can check if the connection worked by using fpga.is_connected(),
which returns true or false:
if fpga.is_connected():

The next step is to get the right bitstream programmed onto the FPGA fabric. The bitstream is set on line 68, from the
options your entered on cli:
bitstream = opts.fpgfile

Then the progdev command is issued on line 108:
fpga.upload_to_ram_and_program(bitstream)

Passing variables to the script
Starting from line 51, you’ll see the following code:
from optparse import OptionParser
p = OptionParser()
p.set_usage('spectrometer.py <ROACH_HOSTNAME_or_IP> [options]')
p.set_description(__doc__)
p.add_option('-l', '--acc_len', dest='acc_len', type='int',default=2*(2**28)/2048,
help='Set the number of vectors to accumulate between dumps. default is 2*(2^28)/
˓→2048, or just under 2 seconds.')
p.add_option('-s', '--skip', dest='skip', action='store_true',
help='Skip reprogramming the FPGA and configuring EQ.')
p.add_option('-b', '--fpg', dest='fpgfile',type='str', default='',
help='Specify the fpg file to load')
opts, args = p.parse_args(sys.argv[1:])
if args==[]:
print 'Please specify a SNAP board. Run with the -h flag to see all options.
˓→\nExiting.'
exit()
else:
snap = args[0]
if opts.fpgfile != '':
bitstream = opts.fpgfile

What this code does is set up some defaults parameters which we can pass to the script from the command line. If the
flags aren’t present, it will default to the values set here.
Conclusion
If you have followed this tutorial faithfully, you should now know:
• What a spectrometer is and what the important parameters for astronomy are.
• Which CASPER blocks you might want to use to make a spectrometer, and how to connect them up in Simulink.
• How to connect to and control a SNAP spectrometer using python scripting.
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In the following tutorials, you will learn to build a correlator, and a polyphase filtering spectrometer using an FPGA
in conjunction with a Graphics Processing Unit (GPU).

2.1.4 Tutorial 4: Wideband Pocket Correlator
Introduction
In this tutorial, you will create a simple Simulink design which uses the ADC on the SNAP and the CASPER DSP
blockset to process a wideband (400MHz) signal, channelize it and output the visibilities.
By this stage, it is expected that you have completed tutorial 1 and tutorial 2 and are reasonably comfortable with
Simulink and basic Python. We will focus here on higher-level design concepts, and will provide you with low-level
detail preimplemented.
Background
Some of this design is similar to that of the previous tutorial, the Wideband Spectrometer. So completion of tutorial 3
is recommended.
Interferometry
In order to improve sensitivity and resolution, telescopes require a large collection area. Instead of using a single,
large dish which is expensive to construct and complicated to maneuver, modern radio telescopes use interferometric
arrays of smaller dishes (or other antennas). Interferometric arrays allow high resolution to be obtained, whilst still
only requiring small individual collecting elements.
Correlation
Interferometric arrays require the relative phases of antennas’ signals to be measured. These can then be used to
construct an image of the sky. This process is called correlation and involves multiplying signals from all possible
antenna pairings in an array. For example, if we have 3 antennas, A, B and C, we need to perform correlation across
each pair, AB, AC and BC. We also need to do auto-correlations, which will give us the power in each signal. ie AA,
BB, CC. We will see this implemented later. The complexity of this calculation scales with the number of antennas
squared. Furthermore, it is a difficult signal routing problem since every antenna must be able to exchange data with
every other antenna.
Polarization
Dish type receivers are typically dual polarized (horizontal and vertical feeds). Each polarization is fed into separate
ADC inputs. When correlating these antennae, we differentiate between full Stokes correlation or a half Stokes
method. A full Stokes correlator does cross correlation between the different polarizations (ie for a given two antennas,
A and B, it multiplies the horizontal feed from A with the vertical feed from B and vice-versa). A half stokes correlator
only correlates like polarizations with each other, thereby halving the compute requirements.
The Correlator
The correlator we will be designing is a 3 input correlator which uses a SNAP board with each ADC operating in
maximum speed mode.
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Creating Your Design
Create a new model
Having started Matlab, open Simulink (either by typing simulink on the Matlab command line, or by clicking the
Simulink icon in the taskbar). Create a new model and add the Xilinx System Generator and SNAP platform blocks
as before in Tutorial 1.
System Generator and Platform Blocks

By now you should have used these blocks a number of times. Pull the System Generator block into your design from
the Xilinx Blockset menu under Basic Elements. The settings can be left on default.
The SNAP platform block can be found under the CASPER XPS System Blockset: Platform subsystem. Set the Clock
Source to adc0_clk and the rest of the configuration as the default.
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Sync Generator

The Sync Generator puts out a sync pulse which is used to synchronize the blocks in the design. See the CASPER
memo on sync pulse generation for a detailed explanation.
This sync generator is able to synchronize with an external trigger input. Typically we connect this to a GPS’s 1pps
output to allow the system to reset on a second boundary after a software arm. This enables us to know precisely the
time at which an accumulation was started. It also allows multiple boards to be synchronized which is vital if we are
using a signal which correlates digitizers hosted on separate boards. To synchronize from an external PPS we can
drive the sync generator logic with the SNAP’s sync_in GPIO input.
Logic is also provided to generate a sync manually via a software input. This allows the design to be used even in the
absence of a 1 pps signal. However, in this case, the time the sync pulse occurs depends on the latency of software
issuing the sync command and the FPGA signal triggering. This introduces some uncertainty in the timestamps
associated with the correlator outputs.

2.1. Vivado

59

CASPER Tutorials Documentation, Release 0.1

ADCs

Connection of the ADCs is as in tutorial 3 except now we are using all three available inputs.
Throughout this design, we use CASPER’s bus_create and bus_expand blocks to simplify routing and make the design
easier to follow.
Control Register

This part of the Simulink design sets up a software register which can be configured in software to control the correlator. Set the yellow software register’s IO direction as from processor. You can find it in the CASPER_XPS System
blockset. The constant block input to this register is used only for simulation.
The output of the software register goes to three slice blocks, which will pull out the individual parameters for use
with configuration. The first slice block (top) is setup as follows:
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The slice block can be found under the Xilinx Blockset → Control Logic. The only change with the subsequent slice
blocks is the Offset of the bottom bit. They are, from top to bottom, respectively,16, 17 & 18.
After each slice block we put an edge_detect block, this outputs true if a boolean input signal is true this clock and
was false last clock. Found under CASPER DSP Blockset → Misc.
Next are the delay blocks. They can be left with their default settings and can be found under Xilinx Blockset →
Common. The delays used here aren’t necessary for the function of the design, but can help meet timing by giving the
compiler an extra cycle of latency to use when routing control signals.
The Goto and From bocks can be found under Simulink-> Signal Routing. Label them as in the block diagram above.
Clip Detect and status reporting
To detect and report signal saturation (clipping) to software, we will create a subsystem with latching inputs.
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The internals of this subsystem (right) consist of delay blocks, registers and cast blocks.
The delays (inputs 2 - 9) can be keep as default. Cast blocks are required as only unsigned integers can be concatenated.
Set their parameters to Unsigned, 1 bit, 0 binary points Truncated Quantization, Wrapped Overflow and 0 Latency.
The Registers (inputs 10 - 33) must be set up with an initial value of 0 and with enable and reset ports enabled. The
status register on the output of the clip detect is set to processor in with unsigned data type and 0 binary point with a
sample period of 1.
PFBs, FFTs and Quantisers
The PFB FIR, FFT and the Quantizer are the heart of this design, there is one set of each for the 3 ADC channels.
However, in order to save resources associated with control logic and PFB and FFT coefficient storage, the independent
filters are combined into a single simulink block. This is configured to process three independent data streams by
setting the “number of inputs” parameter on the PFB_FIR and FFT blocks to 3.

Configure the PFB_FIR_generic blocks as shown below:
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There is potential to overflow the first FFT stage if the input is periodic or signal levels are high as shifting inside the
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FFT is only performed after each butterfly stage calculation. For this reason, we recommend casting any inputs up to
18 bits with the binary point at position 17 (thus keeping the range of values -1 to 1), and then downshifting by 1 bit
to place the signal in one less than the most significant bits.
The fft_wideband_real block should be configured as follows:

The Quantizer Subsystem is designed as seen below. The quantizer cuts the data signals from the FFT output width (18
bits) down to 4 bits. This means that the downstream processing can be implemented with less resources. In particular,
less RAM is needed to store the accumulated correlations. We have to be careful when quantizing signals to make
sure that we’re not either saturating the quantizer, or suffering from low signal levels. Prior to quantizing we multiply
our signals by a runtime programmable set of coefficients, which can be set so as to ensure the quantizer power output
levels are optimal.
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The top level view of the Quantizer Subsystem is as seen below. We repeat this system once for each signal path.
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LEDs
The following sections are more periphery to the design and will only be touched on. By now you should be comfortable putting the blocks together and be able to figure out many of the values and parameters. The complete design is
available in the tutorials repository for reference.
As a debug and monitoring output we can wire up the LEDs to certain signals. We light an LED with every sync pulse.
This is a sort of heartbeat showing that the design is clocking and the FPGA is running.
We also use an LED to give a visual indication of when an accumulation is complete.
Since the signals in our design are very low duty cycle, they won’t naturally make LED flashes which are visible. We
therefore use a pulse extend module to stretch pulses on these signals for 2^24 FPGA clock cycles, which is about 10
ms.

ADC RMS
These blocks calculate the RMS values of the ADCs’ input signals. We subsample the input stream by a factor of four
and do a pseudo random selection of the parallel inputs to prevent false reporting of repetitive signals. This subsampled
stream is squared and accumulated for 2^16 samples.
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The MAC operation
The multiply and accumulate is performed in the dir_x (direct-x) blocks, so named because different antenna signal
pairs are multiplied directly, in parallel (as opposed to the packetized correlators’ X engines which process serially).
Two sets are used, one for the even channels and another for the odd channels. Accumulation for each antenna pair
takes place in BRAM using the same simple vector accumulator used in tut3.
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CONTROL:
The design starts by itself when the FPGA is programmed. The only control register inputs are for resetting counters
and optionally sync’ing to external signal.
Sync LED provides a “heartbeat” signal to instantly see if your design is clocked sensibly.
New accumulation LED gives a visual indication of data rates and dump times.
Accumulation counter provides simple mechanism for checking if a new spectrum output is available. (poll and
compare to last value)
Software
The python scripts are located in the tut_corr tutorial directory. We first need to run poco_init.py to program the FPGA
and configure the design. Then we can run either the auto or the cross correlations plotting scripts (plot_poco_auto.py
and plot_poco_cross.py).
Try running these scripts with the -h option to get a description of optional and required arguments. For an example of
running these scripts and expected outputs, see the ROACH Correlator Tutorial - this tutorial is for the ROACH-2, and
is the tutorial on which this SNAP tutorial is based, so it should be able to give you a general idea of what is going on.

2.1.5 Yellow Block Tutorial: Bidirectional GPIO
This tutorial aims to provide a very entry level introduction to yellow block creation/modification using the JASPER
toolflow. A number of other tutorials and guides already exist. For example, the original ROACH Yellow Block
Tutorial on which this tutorial is based, the Yellow block EDK wiki page, and Dave George’s guide to yellow blocking
the KATADC. Note that the aforementioned links are specific to the Xilinx ISE toolflow, and this tutorial is a guided
tour around the inner workings of the current Xilinx Vivado toolflow.
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In this tutorial, you will modify an existing yellow block to create a yellow block for a bidirectional GPIO n-bit
interface for the SNAP board. This method can be used for the SKARAB or any other CASPER supported board, just
change the name and pin numbers.
NB: CASPER supported boards must have a YAML file describing the physical properties (platform name, FPGA
model, pin locations etc.) of the hardware platform within the jasper_library subdirectory (mlib_devel/
jasper_library/platforms/<platform>.yaml). When porting an unsupported board to the toolflow,
make sure to create a Platform YAML file - see here for an example and explanation of the required fields.
1. Making a Bidirectional GPIO - HDL (Verilog)
We want to design a bidirectional GPIO interface; that means we need to create a bidirectional GPIO module, and
convince the toolflow to instantiate it.
(In most cases when we are porting something into the Toolflow, all verilog/vhdl code is completed, tested, and
working in the form of a Xilinx Vivado project)
The simplest version of a bidirectional GPIO module that can be created is simply a wrapper around a Xilinx IOBUF
instance. An IOBUF (see the 7 series user guide page 39) is a Xilinx module used to connect signals to a bi-directional
external pin. It has the following ports, which are described (using slightly loose terminology) below:
I: the input (i.e., from the FPGA to the GPIO pin )
O: the output (i.e., from the GPIO pin to the FPGA)
IO: the GPIO pin (defined by the user in the Simulink mask later)
T: The control signal, which configures the interface as an output from the device pad to the FPGA (i.e. IO —> O)
when T=1, and an input from the FPGA to the device pad (i.e. I —> IO) when T=0.
We construct a Verilog module “my_gpio_bidir” which wraps ‘n’ number such IOBUF instances (i.e., an n-bit wide
buffer) and also registers the output signal. This simple module will form the entirety of the interface we will turn into
a yellow block. Create a new folder in /mlib_devel/jasper_library/hdl_sources/ named ‘my_gpio_bidir’ and save your
module description as my_gpio_bidir.v there.
NB: n-bit refers to the parameter WIDTH below.
module my_gpio_bidir #(parameter WIDTH=1) (
input
clk,
inout
[WIDTH-1:0] dio_buf, //inout, NOT input(!)
input
[WIDTH-1:0] din_i,
output reg [WIDTH-1:0] dout_o,
input
in_not_out_i
);
// A wire for the output data stream
wire [WIDTH-1:0] dout_wire;
// Buffer the in-out data line
IOBUF iob_data[WIDTH-1:0] (
.O (dout_wire), //the data output
.IO(dio_buf),
//the external in-out signal
.I(din_i),
//the data input
.T(in_not_out_i) //The control signal. 1 for input, 0 for output
);
//register the data output
always @(posedge clk) begin
dout_o <= dout_wire;
(continues on next page)
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(continued from previous page)

end
endmodule

2. Making a Bidirectional GPIO - Simulink
Start by launching MATLAB via the ./startsg \<your startsg.local file>\. Create a new Simulink
model titled ‘tut_gpio_bidir.slx’ and save it.
NB: Now is another good time to remind you to save your Simulink model early and save it often! It is prone to crash
at completely random times.
Grab the ‘gpio’ yellow block from the XPS library. This can be done via the Simulink Library Browser, or by single
clicking anywhere in your model and simply start typing ‘gpio’ then pressing enter on the highlighted block shown.

gpio_yellowblock.png
Rename the block ‘gpio_bidir_a’ as this will serve as our A bank GPIO bidir.
When a block is placed from the library a referenced instance of the block is created, this linked block contains a
link to the parent library block. Structural changes (adding/deleting blocks or ports within the yellow block model)
cannot be made to a linked block and this link must be broken. To do this, right-click on the yellow block. Navigate
to ‘Library Link’ -> click on ‘Disable Link’. Once more, right-click on the yellow block, navigate to ‘Library Lock’
again, and click ‘Break Link’.
Next, click on the arrow on the bottom left corner of the block. This will open the view underneath the base mask of
the block where we will add our own input and output ports. Delete everything that is already underneath this mask as
we will be adding our own ports.

inside_gpio_yellow
Our module has five inputs/outputs. The only ports which need to appear in the yellow block are those that form
connections between your module, and the Simulink model. In our case, these are I, O, and T. The clock signal does
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not come from the Simulink design, but rather some other module. Similarly, the IO signal does not connect to the
Simulink model, but rather refers to an external GPIO pin.
Therefore, our yellow block should have 3 ports. An n-bit input (to be connected to I) named ‘din’, an n-bit output (to
be connected to O) named ‘dout’ and a 1-bit input (to be connected to T) named ‘in_not_out’. Be careful – an input
to the yellow block requires a “Gateway out” of simulink, since the signal needs to go out from the Simulink module,
in to the new GPIO module. Similarly, an output from the yellow block requires a gateway in, since the signal will go
out of the GPIO module and in to the Simulink design. Place these according to the picture below.

initial_block.png
The names of the ports should match the names used in your module, and gateways out should be preceded by
reinterpret and cast blocks to force the correct data types.
Reinterpret block params:
• Force unsigned arithmetic type
• Force binary point of 0
‘din’ Convert block params:
• Fixed point, unsigned arithmetic type
• We will take care of the number of bits through the mask, but set binary point to 0
• Truncate and Wrap
‘in_not_out’ Convert block params:
• Output Type: boolean
Set both Gateway Out blocks to Translate into output port.
Gateway In block params:
• Fixed point, unsigned arithmetic type
• We will take care of the number of bits through the mask, but set binary point to 0
• Truncate and Wrap
Next, you need to tell the toolflow that this is a yellow block, by tagging it as an xps block. Open the block
properties(right-click, then select properties), and tag the block by entering xps:<module_name> in the ‘tag’ field.
In our case the block is tagged ‘xps:my_gpio_bidir’.
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gpio_bidir_proper
We are now almost finished with Simulink, except for one last modification to the block. As we have seen, the
inputs/outputs of the “Simulink” module take the names of the gateway blocks that define them. In order that these
names always be unique, the toolflow mandates that they follow a hierarchical naming scheme. This is defined by:
<model_name><parent_block_name><user_specified_port_name>. Since Simulink ensures that no two blocks have
the same name, this naming scheme always results in a unique port name, no matter how many times you instantiate
your yellow block. Each yellow block has an initialization script which (amongst other possible functions) must
rename gateways in a block according to this convention.
Create the ‘my_gpio_bidir’ block’s initialization script, my_gpio_bidir_mask.m, in the xps_library sub-directory
of mlib_devel. It does nothing except find all the gateways in the block (by looking for blocks whose name ends in
“<user_specified_port_name>”) and renaming them appropriately. As in all things yellow blocky, If in doubt, copy
from another block which works and tweak to your needs. :)
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% find all the gateway in/out blocks
gateway_outs = find_system(gcb, ...
'searchdepth', 1, ...
'FollowLinks', 'on', ...
'lookundermasks', 'all', ...
'masktype','Xilinx Gateway Out Block');
gateway_ins = find_system(gcb, ...
'searchdepth', 1, ...
'FollowLinks', 'on', ...
'lookundermasks', 'all', ...
'masktype','Xilinx Gateway In Block');
% set number of bits for the Convert block
convert_blkHandle = getSimulinkBlockHandle([gcb, '/Convert']);
set_param(convert_blkHandle, 'n_bits', num2str(bitwidth));
if length(bit_index) ~= bitwidth
errordlg('Bit index does not have the same number of elements as the I/O bitwidth.
˓→ When using bitwidths greater than one, you should specify a vector of bit indices
˓→to use.');
end
%rename the gateway outs
for i =1:length(gateway_outs)
gw = gateway_outs{i};
gw_name = get_param(gw, 'Name');
if regexp(gw_name, 'in_not_out_i$')
set_param(gw, 'Name', clear_name([gcb, '_in_not_out_i']));
elseif regexp(gw_name, 'din_i$')
set_param(gw, 'Name', clear_name([gcb, '_din_i']));
else
parent_name = get_param(gw, 'Parent');
errordlg(['Unknown gateway: ', parent_name, '/', gw_name]);
end
end
%rename the gateway ins
for i =1:length(gateway_ins)
gw = gateway_ins{i};
gw_name = get_param(gw, 'Name');
% Set number of bits for gateway in block
set_param(gw, 'n_bits', num2str(bitwidth));
if regexp(gw_name, 'dout_o$')
set_param(gw, 'Name', clear_name([gcb, '_dout_o']));
else
parent_name = get_param(gw, 'Parent');
errordlg(['Unknown gateway: ', parent_name, '/', gw_name]);
end
end

Before we specify the initialization script, we must first create a new mask for the block and add some parameters.
Right click on the block, navigate to ‘Mask’ and click on ‘Edit Mask’. Click on the ‘Parameters & Dialog’ tab of the
dialog box that appears, and remove all parameters already under the ‘Parameters’ dropdown menu.
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initial_gpio_param
Now click-and-drag a popup box over from the left hand side under the ‘Parameters’ folder. Repeat by adding two
edit boxes to the parameters folder.
The configurations for the three boxes you have just added are as follows:
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gpio_bidir_iogrou
Set the ‘Type options’ parameter for ‘iogroup’ by clicking on the pencil next to ‘Popup options’ to (should match the
options in the same popup for the GPIO block):
led
gpio
sync_in
sync_out
zdok0
zdok1
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gpio_bidir_bitwidt
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gpio_bidir_bitinde
We now call the ‘my_gpio_bidir_mask.m’ script by specifiying it in the block’s initilization commands in the block
mask. In the mask editor, add to the initialization section my_gpio_bidir_mask;. This is exactly the same as the
procedure used to call drawing functions for any other (non-yellow) library blocks. Click ‘Apply’ and then ‘Ok’ to
close the editor.
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mask_specification
The result from the mask script will be:

gpio_bidir_block.p
Next, we continue by referring to the picture below. You should copy and paste the ‘gpio_bidir_a’ block and rename
it as ‘gpio_bidir_b’, this second block will be used for B bank GPIO’s. Be sure to set the I/O group and Data bitwidth
for both my_gpio_bidir blocks to ‘gpio’ and 4. Set the GPIO bit index for gpio_bidir_a to the Matlab vector ‘[0, 1, 2,
3]’ and for gpio_bidir_b to the Matlab vector ‘[4, 5, 6, 7]’. The length of these vectors must match the value entered
for Data bitwidth.
Next, drop in 4 software register blocks, named ‘to_gpio_a’, ‘a_is_input’, ‘to_gpio_b’, and ‘b_is_input’. All with the
same parameters shown below:
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Additionally, drop in 2 more software register blocks named ‘from_gpio_a’ and ‘from_gpio_b’. Both with the following parameters:
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Finally, insert 2 gpio blocks that will be configured as leds, name them ‘led_a’ and ‘led_b’. The first with a ‘GPIO bit
index’ of ‘0’ and the second as ‘1’:
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Below is a top-level view of the whole-finished Simulink Model (if you are having any difficulties a completed
Simulink model can be found here):

gpio_bidir_top_lev
Am I on the right track?
To ensure we are on the right track, we will run the ‘jasper’ command in the Matlab terminal and check to see if our
yellow blocks ended up in jasper.per file. This file contains all the peripherals from our Simulink model.
NB: This script will fail because we have not written the proper Python yellow block code yet. This is just to doublecheck on the right track.
When the script fails, open up the build directory (named the same as your simulink model) and open the file
‘jasper.per’ Read through it and ensure you find your new yellow blocks in it (search for the name of your yellow
block). If you don’t then something went wrong, and you should re-read this tutorial to see where you differed. If you
see the yellow block, please continue on.
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Python auto-gen scripts (JASPER Toolflow)
Now we have the module (HDL you wrote first) and Simulink model finished. It is time to write some Python
code so that the toolflow will see our yellow block and instantiate the module. When the toolflow runs, it will look
for xps-tagged blocks in your design. For each one it will construct an instantiation, connecting your yellow block
ports/parameters to the HDL code you wrote. This will all later show up in a top-level auto-generated entity, cleverly
called ‘top.v’.
The toolflow is as follows, starting with the jasper command in the matlab terminal (all scripts can be found in the
mlib_devel directory or yellow_block sub-dir):
jasper.m -> jasper_frontend.m -> exec_flow.py -> toolflow.py -> yellow_block.py -> my_gpio_bidir.py
The last script will be the name of your module as in this case my_gpio_bidir.py. Create this script in the yellow
block sub-directory of mlib_devel. I recommend carefully reading yellow_block.py as the function header comments
are well written and explain what you need to do. :)
NB: I figured out how to create this script by comparing my_gpio_bidir to the gpio yellow block. First I found the
hdl_source file for it. Next I compared the top.v from a different project that contained the gpio block (as top.v contains
the instantiation for the gpio module) Then, I compared the script that generated that instantiation (gpio.py) to the
top.v and hdl source.
Start by first just tweaking the modify_top function to suit your needs, run ‘jasper’ command and fix python errors
until the errors point to the gen_constaints function. Next, repeat the process for the gen_constraints function. Debug
and repeat until you compile w/out errors, look in top.v file in the build directory and you should see your yellow
block instantiation. Carefully add the rest of your functionality from here until your top.v instantiation matches your
HDL code (module).
(Move on to the next section, once the ‘jasper’ command finishes and your yellow block instantiation matches the
module)
NB: The system generated verilog/VHDL code is all lowercase, be sure that your ports and signals match
accordingly.
The code for the my_gpio_bidir yellow block is below (pay particular attention to the comments):
from yellow_block import YellowBlock
from constraints import PortConstraint
from helpers import to_int_list
class my_gpio_bidir(YellowBlock):
def initialize(self):
# Set bitwidth of block (this is determined by the 'Data bitwidth' parameter
˓→in the Simulink mask)
self.bitwidth = int(self.bitwidth)
# add the source files, which have the same name as the module (this is the
˓→verilog module created above)
self.module = 'my_gpio_bidir'
self.add_source(self.module)
def modify_top(self,top):
# port name to be used for 'dio_buf'
external_port_name = self.fullname + '_ext'
# get this instance from 'top.v' or create if not instantiated yet
inst = top.get_instance(entity=self.module, name=self.fullname, comment=self.
˓→fullname)
# add ports necessary for instantiation of module
inst.add_port('clk', signal='user_clk', parent_sig=False)
# parent_port=True, and dir='input', so add an input to 'top.v'
(continues on next page)
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inst.add_port('dio_buf', signal=external_port_name, dir='inout', width=self.
˓→bitwidth, parent_port=True)
inst.add_port('din_i', signal='%s_din_i'%self.fullname, width=self.bitwidth)
inst.add_port('dout_o', signal='%s_dout_o'%self.fullname, width=self.bitwidth)
inst.add_port('in_not_out_i', signal='%s_in_not_out_i'%self.fullname)
# add width parameter from 'Data bitwidth' parameter in Simulink mask
inst.add_parameter('WIDTH', str(self.bitwidth))
def gen_constraints(self):
# add port constraint to user_const.xdc for 'inout' ()
return [PortConstraint(self.fullname+'_ext', self.io_group, port_
˓→index=range(self.bitwidth), iogroup_index=to_int_list(self.bit_index))]

Testing
Now we need to test. The python script for this tutorial is an automated testing of the Bidirectional GPIO block we
just made. It sets one GPIO bank (a or b) as output, the other as an input. It then writes to one output bank and reads
the others input. After which it swaps the modes of each bank in order to demonstrate that each bank can be either an
input or output (bidirectional) and repeats the same manner of write/reading.
Run the script included below in the terminal using the command:
./tut_gpio_bidir.py -f <Generated fpg file here> <SNAP hostname or ip addr>

NB: You may need to run chmod +x ./tut_gpio_bidir.py first.
#!/usr/bin/env python
'''
Script for testing the Bi-Directional GPIO Yellow Block created for CASPER Tutorial 7.
Author: Tyrone van Balla, January 2016
Reworked for SNAP and tested: Brian Bradford, May 2018
'''
import casperfpga
import time
import sys
import numpy as np
fpgfile = 'tut_gpio_bidir.fpg'
fpgas = []
def exit_clean():
try:
for f in fpgas: f.stop()
except:
pass
exit()
def exit_fail():
print 'FAILURE DETECTED. Exiting . . .'
exit()
if __name__ == '__main__':
import argparse
parser = argparse.ArgumentParser()
(continues on next page)
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parser.add_argument("snap", help="<SNAP_HOSTNAME or IP>")
parser.add_argument("-f", "--fpgfile", type=str, default=fpgfile, help="Specify
˓→the fpg file to load")
parser.add_argument("-i", "--ipython", action='store_true', help="Enable iPython
˓→control")
args = parser.parse_args()
if args.snap == "":
print 'Please specify a SNAP board. \nExiting'
exit()
else:
snap = args.snap
if args.fpgfile != '':
fpgfile = args.fpgfile
# try:
print "Connecting to server %s . . . "%(snap),
fpga = casperfpga.CasperFpga(snap)
time.sleep(1)
if fpga.is_connected():
print 'ok\n'
else:
print 'ERROR connecting to server %s . . .'%(snap)
exit_fail()
# program fpga with bitstream
print '------------------------'
print 'Programming FPGA...',
sys.stdout.flush()
fpga.upload_to_ram_and_program(fpgfile)
time.sleep(1)
print 'ok'
# intialize gpio bank control registers
fpga.write_int('a_is_input', 1)
fpga.write_int('b_is_input', 1)
if args.ipython:
# open ipython session for manual testing of yellow block
# list all registers first
print '\nAvailable Registers:'
registers = fpga.listdev()
for reg in registers:
if not('sys' in reg):
print '\t',
print reg
else:
pass
print '\n'
# how to use
(continues on next page)
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print 'Use "fpga" as the fpga object\n'
import IPython; IPython.embed()
print 'Exiting . . .'
exit_clean()
'''
Automated testing of Bidirectional GPIO Block.
Sets one GPIO bank as output, other as input.
Writes to output bank, reads input.
Swaps mode of banks to demonstrate either bank can be either input or output.
'''
print '#################################'
# Send from GPIO_LED (B) to GPIO_GPIO (A)
print '\nConfiguring to send from GPIO_LED (B) to GPIO_GPIO (A)\n'
fpga.write_int('a_is_input', 1) # GPIO_GPIO as input
fpga.write_int('b_is_input', 0) # GPIO_LED as output
print 'Initial Values: A: %s, B: %s\n' % (np.binary_repr(fpga.read_int('from_gpio_a'),
˓→ width=4), np.binary_repr(fpga.read_int('from_gpio_b'), width=4))
print 'Writing 0xF to B . . . \n'
fpga.write_int('to_gpio_a', 0) # dummy data written to GPIO_GPIO
fpga.write_int('to_gpio_b', 0xFFFF) # data written to GPIO_LED
time.sleep(0.01)
print 'A: 0 <------------- B: 0xF\n'
from_a = fpga.read_int('from_gpio_a') # read GPIO_GPIO
from_b = fpga.read_int('from_gpio_b') # read GPIO_LED
print 'Readback values: A: %s, B: %s\n' % (np.binary_repr(from_a, width=4), np.binary_
˓→repr(from_b, width=4))
print 'Writing 0x0 to B . . . \n'
print 'A: 0xF <---------- B: 0x0\n'
fpga.write_int('to_gpio_a', 0xFFFF) # dummy data written to GPIO_GPIO
fpga.write_int('to_gpio_b', 0x0) # data written to GPIO_LED
time.sleep(0.01)
from_a = fpga.read_int('from_gpio_a') # read GPIO_GPIO
from_b = fpga.read_int('from_gpio_b') # read GPIO_LED
print 'Readback values: A: %s, B: %s\n' % (np.binary_repr(from_a, width=4), np.binary_
˓→repr(from_b, width=4))
print '##################################'
# Send from GPIO_GPIO (A) to GPIO_LED (B)
print '\nConfiguring to send from GPIO_GPIO (A) to GPIO_LED (B)\n'
fpga.write_int('a_is_input', 0) # GPIO_GPIO as output
fpga.write_int('b_is_input', 1) # GPIO_LED as input
print 'Initial Values: A: %s, B: %s\n' % (np.binary_repr(fpga.read_int('from_gpio_a'),
(continues on next page)
˓→ width=4), np.binary_repr(fpga.read_int('from_gpio_b'), width=4))
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print 'Writing 0x0 to A . . . \n'
fpga.write_int('to_gpio_a', 0) # data written to GPIO_GPIO
fpga.write_int('to_gpio_b', 0xFFFF) # dummy data written to GPIO_LED
time.sleep(0.01)
print 'A: 0 -------------> B: 0xF\n'
from_a = fpga.read_int('from_gpio_a') # read GPIO_GPIO
from_b = fpga.read_int('from_gpio_b') # read GPIO_LED
print 'Readback values: A: %s, B: %s\n' % (np.binary_repr(from_a, width=4), np.binary_
˓→repr(from_b, width=4))
print 'Writing 0xF to A . . . \n'
print 'A: 0xF ----------> B: 0x0\n'
fpga.write_int('to_gpio_a', 0xFFFF) # data written to GPIO_GPIO
fpga.write_int('to_gpio_b', 0x0) # dummy data written to GPIO_LED
time.sleep(0.01)
from_a = fpga.read_int('from_gpio_a') # read GPIO_GPIO
from_b = fpga.read_int('from_gpio_b') # read GPIO_LED
print 'Readback values: A: %s, B: %s\n' % (np.binary_repr(from_a, width=4), np.binary_
˓→repr(from_b, width=4))
# except KeyboardInterrupt:
#
exit_clean()
# except Exception as inst:
#
exit_fail()
exit_clean()

Your results without wiring pins on the SNAP board should look something close to:
Connecting to server rpi2-11 . . .

ok

-----------------------Programming FPGA... ok
#################################
Configuring to send from GPIO_LED (B) to GPIO_GPIO (A)
Initial Values: A: 0000, B: 0000
Writing 0xF to B . . .
A: 0 <------------- B: 0xF
Readback values: A: 0000, B: 1111
Writing 0x0 to B . . .
A: 0xF <---------- B: 0x0
(continues on next page)
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Readback values: A: 1111, B: 0000
##################################
Configuring to send from GPIO_GPIO (A) to GPIO_LED (B)
Initial Values: A: 1111, B: 0000
Writing 0x0 to A . . .
A: 0 -------------> B: 0xF
Readback values: A: 0000, B: 0000
Writing 0xF to A . . .
A: 0xF ----------> B: 0x0
Readback values: A: 1111, B: 1111

Now we will wire up the pins on the SNAP board correctly. Put the following female jumpers between pins on the J9
GPIO (refer to page 14 of SNAP Schematic if necessary):
• TEST0 and TEST4
• TEST1 and TEST5
• TEST2 and TEST6
• TEST3 and TEST7
After this, run the same script again. The expected results are:
Connecting to server rpi2-11 . . .

ok

-----------------------Programming FPGA... ok
#################################
Configuring to send from GPIO_LED (B) to GPIO_GPIO (A)
Initial Values: A: 0000, B: 0000
Writing 0xF to B . . .
A: 0 <------------- B: 0xF
Readback values: A: 1111, B: 1111
Writing 0x0 to B . . .
A: 0xF <---------- B: 0x0
Readback values: A: 0000, B: 0000
##################################
Configuring to send from GPIO_GPIO (A) to GPIO_LED (B)
(continues on next page)
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Initial Values: A: 1111, B: 1111
Writing 0x0 to A . . .
A: 0 -------------> B: 0xF
Readback values: A: 0000, B: 0000
Writing 0xF to A . . .
A: 0xF ----------> B: 0x0
Readback values: A: 1111, B: 1111

If you matched the result above, then congratulations you’ve successfully created and tested your first yellow block!
If not, start by ensuring your original HDL code was correct to begin with, then debug the yellow block Python script
you wrote.
Add yellow block to XPS Library
1. Create a new Simulink model with the name identical to your yellow block name (rename your yellow block if
it is an unacceptable model name)
2. Add your yellow block to the model. (This should be the only block in the model)
3. Add your yellow block mask script to ‘xps_library’ folder if needed.
4. Save your Simulink model in the ‘xps_models’ folder (please put it in the directory that makes sense, otherwise
create a new directory)
5. Launch Matlab via the ./startsg script in mlib_devel directory.
6. Double-click on ‘xps_library’ directory from the ‘Current Folder’ pane on the left-hand side of the Matlab
window.
7. Run xps_build_new_library, click ‘Yes’ on overwrite dialog prompt and ignore any warnings.
8. For any models you wish to link with this new library, open the model and
update_casper_blocks(bdroot) in the Matlab command window. (Preferably all your models)

run

Now help out CASPER by adding more yellow blocks to our library :)

Author: Brian Bradford, June 1, 2018
Credit to Jack Hickish for original ROACH yellow block tutorial, in which I based this from.
SKARAB
1. Introduction Tutorial Step-by-Step or Completed
2. 40GbE Tutorial Step-by-Step or Completed
3. HMC Tutorial Step-by-Step or Completed
4. Spectrometer Tutorials Step-by-Step or Completed
5. ADC Synchronous Data Acquisition Tutorials
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2.1.6 Tutorial 1: Introduction to Simulink
In this tutorial, you will create a simple Simulink design using both standard Xilinx system generator blockset, as well
as library blocks specific to CASPER boards (so-called “Yellow Blocks”). At the end of this tutorial, you will know
how to generate an fpg file, program it to a CASPER FPGA board, and interact with your running hardware design
using casperfpga via a Python Interface.
Creating Your Design
Create a New Model
Start Matlab via executing the startsg command, as described here. This ensures that necessary Xilinx and CASPER
libraries are loaded into your by Simulink. When MATLAB starts up, open Simulink by typing simulink on the
MATLAB command line. Start a new model, and save it with an appropriate name. With Simulink, it is very wise to
save early and often.
There are some Matlab limitations you should be aware-of right from the start:
• Do not use spaces in your filenames or anywhere in the file path as it will break the toolflow.
• Do not use capital letters in your filenames or anywhere in the file path as it will break the toolflow.
• Beware block paths that exceed 64 characters. This refers to not only the file path, but also the path to any
block within your design.
– For example, if you save a model file with a name ~/some_really_long_filename.slx, and have a block
called in a submodule the longest block path would be: some_really_long_filename_submodule_block.
– If you use lots of subsystems, this can cause problems.
Library organization
There are three libraries which you will use when you design firmware in Simulink.
1. The CASPER XPS Library contains “Yellow Blocks” – these are blocks which encapsulate interfaces to hardware (ADCs, Memory chips, CPUs, Ethernet ports, etc.)
2. The CASPER DSP Library contains (mostly green) blocks which implement DSP functions such as filters,
FFTs, etc.
3. The Xilinx Library contains blue blocks which provide low-level functionality such as multiplexing, delaying, adding, etc. The Xilinx library also contains the super-special System Generator block, which contains
information about the type of FPGA you are targeting.
Add Xilinx System Generator and XSG core config blocks
Add a System generator block from the Xilinx library by locating the Xilinx Blockset library’s Basic Elements subsection and dragging a System Generator token onto your new file.
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xilinx_select_sysg
Do not configure it directly, but rather add a platform block representing the system you care compiling for. These can
be found in the CASPER XPS System Blockset library. For SKARAB (and later) platforms, you need a block which
matches the platform name, which can be found in the library under “platforms”, as shown below.
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casper_xps_select_
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casper_xps_select_platform_ska
Double click on the platform block that you just added. The Hardware Platform parameter should match the platform
you are compiling for. Once you have selected a board, you need to choose where it will get its clock. In designs
including ADCs you probably want the FPGA clock to be derived from the sampling clock, but for this simple design
(which doesn’t include an ADC) you should use the platform’s on-board clock. To do this, set the User IP Clock
Source to sys_clk. The on-board clock frequency should be greater than 156.25 MHz. 230 MHz should work well.
The configuration yellow block knows what FPGA corresponds to which platform, and so it will autmoatically configure the System Generator block which you previously added.
The System Generator and XPS Config blocks are required by all CASPER designs
Add an Ethernet core block
An Ethernet core must be present in every SKARAB design to facilitate communication with the board via Ethernet. In the case of some later tutorials, such as the 40GE Interface tutorial, this core is used within the design
itself and so does not need to be added separately. However, in this tutorial, we won’t need an Ethernet core for
anything other than basic communication using the casperfpga library and so one must be added specifically for
this purpose. Yellow blocks for both 1GbE and 40GbE exist for the SKARAB - a pre-configured template containing a 40GbE core exists within the tutorials_devel repo at /tutorials_devel/skarab/tut_intro/
skarab_tut_intro_template.slx. Open this design in a new simulink window, and copy the subsystem
block containing the core across to your design.
Your design should now contain the following three blocks:
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tut_intro_subsyste
Flashing LED
To demonstrate the basic use of hardware interfaces, we will make an LED flash. With the FPGA running at ~100MHz
(or greater), the most significant bit (msb) of a 27 bit counter will toggle approximately every 0.67 seconds. We can
output this bit to an LED on your board. Most (all?) CASPER platforms have at least four LEDs, with the exact
configuration depending on the board (for example, SKARAB has four green LEDs and four red LEDs). We will
make a small circuit connecting the top bit of a 27 bit counter to one of these LEDs. When compiled this will make
the LED flash with a 50% duty cycle approximately once a second.
Add a counter
Add a counter to your design by navigating to Xilinx Blockset -> Basic Elements -> Counter and dragging it onto your
model.

xilinx_select_counter.png
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Double-click it and set it for free running, 27 bits, unsigned. This means it will count from 0 to 2^27 - 1, and will then
wrap back to zero and continue.
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Add a slice block to select out the msb
We now need to select the most significant bit (msb) of the counter. We do this using a slice block, which Xilinx
provides. Xilinx Blockset -> Basic Elements -> Slice.

Slice_select.png
Double-click on the newly added slice block. There are multiple ways to select which bit(s) you want. In this case, it
is simplest to index from the upper end and select the first bit. If you wanted the least significant bit (lsb), you can also
index from that position. You can either select the width and offset, or two bit locations.
Set it for 1 bit wide with offset from top bit at zero. As you might guess, this will take the 27-bit input signal, and
output just the top bit.
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Add a GPIO block
From: CASPER XPS library -> IO -> gpio.
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casper_xps_select_

casper_xps_select_
In order to send the 1 bit signal you have sliced off to an LED, you need to connect it to the right FPGA output pin. To
do this you can use a GPIO (general-purpose input/output) block from the XPS library, this allows you to route a signal
from Simulink to a selection of FPGA pins, which are addressed with user-friendly names. Set it to use SKARAB’s
LED bank as output. Once you’ve chosen the LED bank, you need to pick which LED you want to output to. Set the
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GPIO bit index to 0 (the first LED) and the data type to Boolean with bitwidth 1. This means your simulink input is a
1 bit Boolean, and the output is LED0.

104

Chapter 2. Tutorial Instructions

CASPER Tutorials Documentation, Release 0.1

2.1. Vivado

105

CASPER Tutorials Documentation, Release 0.1

Add a terminator
To prevent warnings (from MATLAB & Simulink) about unconnected outputs, terminate all unused outputs using a
Terminator:

From: Simulink -> Sinks -> Terminator
You can also use the Matlab function XlAddTerms, run in the MATLAB prompt, to automatically terminate your
unused outputs.
Connect your design
It is a good idea to rename your blocks to something more sensible, like counter_led instead of just counter. Do this
simply by double-clicking on the name of the block and editing the text appropriately.
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To connect the blocks simply click and drag from the ‘output arrow’ on one block and drag it to the ‘input arrow’ of
another block. Connect the blocks together: Counter -> Slice -> gpio as showing in digram below.

Remember to save your design often.
Software control
To demonstrate the use of software registers to control the FPGA from a computer, we will add a registers so that
the counter in our design can be started, stopped, and reset from software. We will also add a register so that we can
monitor the counter’s current value too.
By the end of this section, you will create a system that looks like this:

Slice_circuit.png
Add the software registers
We need two software registers. One to control the counter, and a second one to read its current value. From the
CASPER XPS System Blockset library, drag two Software Registers onto your design.
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casper_xps_select_memory_swreg.png
Set the I/O direction to From Processor on the first one (counter_ctrl) to enable a value to be set from software and
sent to your FPGA design. Set it to To Processor on the second one (counter_value) to enable a value to be sent from
the FPGA to software. Set both registers to a bitwidth of 32 bits.
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Rename the registers to something sensible. The names you give them here are the names you will use to access them
from software. Do not use spaces, slashes and other funny characters in these. Perhaps counter_ctrl and counter_value,
to represent the control and output registers respectively.
Also note that the software registers have sim_reg and sim_out ports. The input port provides a means of simulating
this register’s value (as would be set by the runtime software) using the sim_reg line. The output port provides a means
to simulate this register’s current FPGA-assigned value.
For now, set the sim_reg port to constant one using a Simulink-type constant. Found in Simulink -> Sources. This will
enable the counter during simulations.

During simulation, we can monitor the counter’s value using a scope (Simulink -> Sinks):
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Here is a good point to note that all blocks from the Simulink library (usually white), will not be compiled into
hardware. They are present for simulation only.
Only Xilinx blocks (they are blue with Xilinx logo) will be compiled to hardware.
You need to use gateway blocks whenever connecting a Simulink-provided block (like a scope or sine-wave generator)
to a from a Xilinx block, this will sample and quantize the simulink signals so that they are compatible with the Xilinx
world. Some blocks (like the software register) provide a gateway internally, so you can feed the input of a software
register with a xilinx signal, and monitor its output with a Simulink scope. However, in general, you must manually
insert these gateways where appropriate. Simulink will issue warnings for any direct connections between the Simulink
and Xilinx worlds.
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Add the counter
You can do this either by copying your existing counter block (copy-paste, or ctrl-click-drag-drop) or by placing a new
one from the library.
Configure it with a reset and enable port as follows:

2.1. Vivado

113

CASPER Tutorials Documentation, Release 0.1

114

Chapter 2. Tutorial Instructions

CASPER Tutorials Documentation, Release 0.1

Add the slice blocks
Now we need some way to control the enable and reset ports of the counter. We could do this using two separate
software registers, but this is wasteful since each register is 32 bits anyway.
So we’ll use a single register and slice out one bit for enabling the counter, and another bit for resetting it. Either copy
your existing slice block (copy-paste it or hold ctrl while dragging/dropping it) or add two more from the library.
The enable and reset ports of the counter require boolean values (which Simulink interprets differently from ordinary
1-bit unsigned numbers). Configure the slices as follows:
Slice for enable:

casper_xps_param
Slice for reset:
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casper_xps_param
Connect it all up
Now we need to connect all these blocks together. To neaten things up, consider resizing the slice blocks and hiding
their names. Their function is clear enough from their icon without needing to see their names.
Do so by right-clicking and unchecking Format → Show Block Name. You could do this with the counter too, but it’s
not a good idea with the software registers, because otherwise you wouldn’t know how to address them when looking
at your diagram.
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Adder
To demonstrate some simple mathematical operations, we will create an adder. It will add two numbers on demand and
output the result to another software register. Almost all astronomy DSP is done using fixed-point (integer) notation,
and this adder will be no different.
We will calculate a+b = sum_a_b.
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Add the software registers
Add two more input software registers. These will allow us to specify the two numbers to add. Add another output
register for the sum output.
Either copy your existing software register blocks (copy-paste or holding ctrl while dragging/dropping it) or add three
more from the library. Set the I/O direction to From Processor on the first two and set it to To Processor on the third
one.
Add the adder block
Locate the adder/subtractor block, Xilinx Blockset -> Math -> AddSub and drag one onto your design. This block can
optionally perform addition or subtraction. Let’s leave it set at it’s default, for addition.
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The output register is 32 bits. If we add two 32 bit numbers, we will have 33 bits.
There are a number of ways of fixing this:
• limit the input bitwidth(s) with slice blocks
• limit the output bitwidth with slice blocks
• create a 32 bit adder.
Since you have already seen slice blocks demonstrated, let’s try to set the AddSub block to be a 32 bit saturating adder.
On the second tab, set it for user-defined precision, unsigned 32 bits.
Also, under overflow, set it to saturate. Now if we add two very large numbers, it will simply return 2^32 -1.
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Add the scope and simulation inputs
Either copy your existing scope and simulation constants (copy-paste or ctrl-drag) or place a new one from the library
as before. Set the values of the simulation inputs to anything you like.
Connect it all together
Like this:
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Simulating
The design can be simulated with clock-for-clock accuracy directly from within Simulink. Set the number of clock
cycles that you’d like to simulate and press the play button in the top toolbar.

You can watch the simulation progress in the status bar in the bottom right. It will complete in the blink of an eye for
this small design with just 10 clock cycles.
You can double-click on the scopes to see what the signals look like on those lines. For example, the one connected to
the counter should look like this:

The one connected to your adder should return a constant, equal to the sum of the two numbers you entered. You
might have to press the Autoscale button to scale the scope appropriately.
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Once you have verified that that design functions as you’d like, you’re ready to compile for the FPGA. . .
Compiling
Essentially, you have constructed three completely separate little instruments. You have a flashing LED, a counter
which you can start/stop/reset from software and also an adder. These components are all clocked off the same
156.25MHz system clock crystal and to your specified User IP Clock Rate, but they will operate independently.
In order to compile this to an FPGA bitstream, execute the following command in the MATLAB Command Line
window. THIS COMMAND DEPENDS WHICH PLATFORM YOU ARE TARGETING:
>>

jasper

This will run the complete build process, which consists of two stages. The first involving Xilinx’s System Generator,
which compiles any Xilinx blocks in your Simulink design to a circuit which can be implemented on your FPGA.
While System Generator is running, you should see the following window pop up:

After this, the second stage involves synthesis of your design through Vivado, which goes about turning your design
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into a physical implementation and figuring out where to put the resulting components and signals on your FPGA.
Finally the toolflow will create the final output fpg file that you will use to program your FPGA. This file contains
the bitstream (the FPGA configuration information) as well as meta-data describing what registers and other yellow
blocks are in your design. This file will be created in the ‘outputs’ folder in the working directory of your Simulink
model. Note: Compile time is approximately 15-20 minutes.

Advanced Compiling
Once you are familiar with the CASPER toolflow, you might find you want to run the two stages of the compile
separately. This means that MATLAB will become usable sooner, since it won’t be locked up by the second stage of
the compile. If you want to do this, you can run the first stage of the compile from the MATLAB prompt with
>> jasper_frontend

After this is completed, the last message printed will tell you how to finish the compile. It will look something like:
$ python /path_to/mlib_devel/jasper_library/exec_flow.py -m /home/user/path_to/skarab/
˓→tut_intro/skarab_tut_intro.slx --middleware --backend --software

You can run this command in a separate terminal, after sourcing appropriate environment variables. Not recommended
for beginners.
Programming the FPGA
Reconfiguration of CASPER FPGA boards is achieved using the casperfpga python library, created by the SA-SKA
group.
Getting the required packages
These are pre-installed on the server in the workshop and you do not need to do any further configuration. However,
should you want to run these tutorials on your own machines, you should download the latest casperfpga libraries from
here.
Copy your .fpg file to your Server
As per the previous figure, navigate to the outputs folder and (secure)copy this across to a test folder on the workshop
server. Instructions to do this are available here
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Connecting to the board
SSH into the server that the SKARAB board is connected to and navigate to the folder in which your .fpg file is stored.
Start interactive python by running:
$ ipython

Now import the fpga control library. This will automatically pull-in the KATCP library and any other required communications libraries.
import casperfpga

To connect to the board we create a CasperFpga instance; let’s call it fpga. The CasperFpga constructor requires just
one argument: the IP hostname or address of your FPGA board.
fpga = casperfpga.CasperFpga('skarab hostname or ip_address')

The first thing we do is program the FPGA with the .fpg file which your compile generated.
fpga.upload_to_ram_and_program('your_fpgfile.fpg')

Should the execution of this command return true, you can safely assume the FPGA is now configured with your design.
The SKARAB’s Front Panel LEDs are, by default, displaying inherent Board
Support Package diagnostics.
More details on this can be found here.
The control of the Front
Panel LEDs can be switched between BSP functionality and your Simulink design via a control signal.
This control is available to you in casperfpga through control_front_panel_leds_read() and
control_front_panel_leds_write(dsp_override=True). You should see the LED on your board
flashing. Go check! All the available/configured registers can be displayed using: fpga.listdev() The adder and counter
can be controlled by writing to and reading from registers added in the design using:
fpga.write_int('a',10)
fpga.write_int('b',20)
fpga.read_int('sum_a_b')

With any luck, the sum returned by the FPGA should be correct.
You can also try writing to the counter control registers in your design. You should find that with appropriate manipulation of the control register, you can make the counter start, stop, and return to zero.
fpga.write_int('counter_ctrl',10')
fpga.read_uint('counter_value')

Conclusion
This concludes the first CASPER Tutorial. You have learned how to construct a simple Simulink design, program an
FPGA board and interact with it with Python using casperfpga. Congratulations!
While the design you made might not be very complicated, you now have the basic skills required to build more
complex designs which are covered in later tutorials.
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Introduction
In this tutorial, you will create a simple Simulink design which uses the SKARAB’s 40GbE ports to send data at high
speeds to another port. This could just as easily be another SKARAB board or a computer with a 40GbE network
interface card. In addition, you will learn to control the design remotely using a supplied Python library for KATCP.
The UDP packets sent by the SKARAB will be recorded to disk.
This tutorial essentially implements the transmission of a counter through one QSFP+ port and back into another. This
allows for a test of the communications link in terms of performance and reliability. This test can be used to test the
link between boards and the effect of different cable lengths on communications quality.
Background
For more info on the SKARAB please follow this link to the SKARAB hardware platform. Of particular interest for
this tutorial is the section on the QSFP+ Mezzanine Card.
The maximum payload length of the 40GbE core is 8192 bytes (implemented in BRAM) plus another 512 bytes
(implemented in distributed RAM) - which is useful for an application header. These ports (and hence part of the
40 GbE cores) run at 156.25MHz, while the interface to your design runs at the FPGA clock rate (sys_clk, etc).
The interface is asynchronous and buffers are required at the clock boundary. For this reason, even if you send data
between two SKARAB boards which are running off the same hard-wired clock, there will be jitter in the data. A
second consideration is how often you clock values into the core when you try to send data. If your FPGA is running
faster than the core, and you attempt to clock data in on every clock cycle, the buffers will eventually overflow.
Likewise for receiving, if you send too much data to a board and cannot clock it out of the receive buffer fast enough,
the receive buffers will overflow and you will lose data. In our design we are clocking the FPGA at 200MHz with the
cores running at 156.25MHz. We will therefore not be able to clock data into the Tx buffer continuously for very long
before it overflows. If this doesn’t make much sense to you now don’t panic, it will become clear after you’ve tried it.
Tutorial Outline
This tutorial will be run in an explain-and-explore kind of way. There are too many blocks for us to run through each
one and its respective configuration. Hence, each section will be generally explained and it is up to you to explore
the design and understand the detail. Please don’t hesitate to ask any questions during the tutorial session. If you are
doing these tutorials outside of the CASPER workshop please email any questions to the CASPER email list.
This tutorial consists of 2 designs: a transmitter and a receiver. We will look at the transmitting design first.
Tx Design
As with the previous tutorial, drop down a Xilinx XSG Block and then the SKARAB platform yellow block. Configure
the clock frequency to 170Mhz. Firstly, we use a software register to control our system. In this design we are using a
single 32-bit register with the lower 6 bits being used for the following logic signals:
• 40GbE core reset,
• Debug logic reset,
• Packet reset,
• Transmit enable,
• Packet enable, and
• Snap block arming.
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This software register also takes in some simulation stimuli. Try playing with these and stimulate the design using the
play button on the top of the window. It is advisable to use a short simulation time as more complex designs can take
ages to simulate.

Each packet that is sent from the FPGA fabric can be sent to a specified IP and port. These values are configurable
and, in this case, are set via software registers. These could also be set dynamically from the fabric as required.

This is the start of the logic to build up our payload. The decimation register is used to control the rate at which packets
are sent. Have a look at lines 307-312 of the Tx python script to see how this value is calculated and used.

Here is the rest of the payload generation logic. We are creating 2 ramps and a walking-1 pattern. The payload is
generated using a combination of counters, slice blocks, delays, adders and comparators. The ramps and walking-1
are concatenated together and put into the payload buffer by toggling the tx_valid signal on the 40GbE core. The
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tx_data bus is 256 bits wide so only 256 bits can be clocked in on a clock cycle. The buffer can accept a payload of
up to 8192 bytes. Once all the data we require is in the payload buffer we toggle the tx_end_of_frame signal to
send the packet into the ether.

As a method of debugging, the transmit side also as some data snapshot (snap, not SNAP) blocks which can capture
data as it is sent to the core. The snap block is a BRAM which can be triggered to capture data on a particular signal
and then read out from software. They are very useful for debugging and checking the data at particular stages through
your design.
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The design also has a counter that keeps track of each time the overflow or almost-full lines are driven high by the
core. This will tell us if we have any overflow or almost-overflowing buffers.

Now take a look through the Tx python script to see how the registers are being set and the debug snap blocks are used
to validate the data being sent. This should be well commented, but please ask questions where things aren’t clear.
Rx Design
For the receiver design do the same as the previous design by dropping down an XSG block and the SKARAB platform
block. Configure the clock rate to 230Mhz. We want this to be well above the clock rate of the transmit design so that
we can handle the variable rate from the transmitter and not overflow our buffers.
Again we have a control register which manages resets, enables and snap block triggering.

This is the receiving 40GbE. If the Tx-side is all tied to zero (0) this interface is not used. The Rx side is connected up
to labels which are used to reduce the wires running around the design.
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The following blocks split out the walking 1 and the ramps from the received data.

Here each of the split data are written into snap blocks. The snap blocks are triggered by the end-of-frame signal and
the write enable is driven by the rx_valid signal.
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Here we have counters used to count any errors on the receiver’s side. They are fed into software registers for access
from software.
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Here are more registers used for debugging; they count any errors in the expected data, the ramps and the walking 1.
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This writes the packet header data into a snap block just to provide more debugging data.
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Running the python script
Once you are finished examining the designs and feel that you have a good handle on them. Look through the python
tx script. Try to figure out how to call the script with the correct parameters and files. You might have to scp the files
to the control server, then run it and see what data you can get out. You can also start an ipython session to manually
connect and run each of the commands. If you are running the tutorial during the workshop the facilitators should
have the control server information up to view, or look here to find the workshop_setup.md documentation. If you are
running the tutorials elsewhere please familiarise yourself with your local setup/server(s) in order to run the tutorial.
The python script, tut_40gbe.py, does all the heavy lifting for the communication aspect of the tutorial. The script
allows you to specify a few parameters and subsequently programs the boards, transmits and receives the test data.
Script arguments
Much like most python scripts, you can query the arguments via:
$ python tut_40gbe.py --help
usage: tut_40gbe_tx.py [-h] [--txhost TXHOST] [--rxhost RXHOST]
[--txfpg TXFPG] [--rxfpg RXFPG] [--pktsize PKTSIZE]
[--rate RATE] [--decimate DECIMATE] [-p] [-i]
[--loglevel LOG_LEVEL]
Script and classes for SKARAB Tutorial 2
optional arguments:
-h, --help
--txhost TXHOST
--rxhost RXHOST
--txfpg TXFPG
--rxfpg RXFPG
--pktsize PKTSIZE
--rate RATE
--decimate DECIMATE
-p, --program
-i, --ipython
--loglevel LOG_LEVEL

show this help message and exit
Hostname or IP for the TX SKARAB. (default: )
Hostname or IP for the RX SKARAB. (default: )
Programming file for the TX SKARAB. (default: )
Programming file for the RX SKARAB. (default: )
Packet length to send (in words). (default: 160)
TX bitrate, in Gbps. (default: 2.0)
Decimate the datarate by this much. (default: -1)
Program the SKARABs (default: False)
Start IPython at script end. (default: False)
log level to use, default None, options INFO, DEBUG,
ERROR (default: INFO)

As per the info above, we can see that running the 40GbE tutorial script requires the following (compulsory) parameters:
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• The IPs or Hostnames of SKARABs assigned to do the Transmitting and Receiving of data.
– It is also worth mentioning that the SKARABs you intend on using to carry out this tutorial must have at
least one QSFP+ cable plugged in to each board.
• Programming files for the Tx and Rx SKARABs. These fpg-files will be output after the build process is
executed on Tx and Rx simulink models.
– There are already-built versions of these images available in the working directory, namely
tut_40gbe_tx.fpg and tut_40gbe_rx.fpg. Feel free to use these if you don’t want to wait
for the build process to complete.
• The -p or –program flag dictates whether the programming files specified in the -txfpg and -rxfpg flags
will be programmed to the board (using the method you learnt in the previous tutorial)
– I would suggest specifying this flag purely to minimise the ‘setup’ work you need to do to get the tutorial
running.
– You could run the tutorial script without specifying this flag, however that would require programming the
two SKARABs with the associated fpg-files before running the script. Nothing major.
The other flags already have default values and don’t need to be specified unless you want to, for example, test how
different parameters change the behaviour of the system. An example of the script execution is show below:
$ python tut_40gbe.py --txhost skarab020201-01 --rxhost skarab020202-01 --txfpg tut_
˓→40gbe_tx.fpg --rxfpg tut_40gbe_rx.fpg -p

Of course, please do make sure you are in the correct directory holding the tut_40gbe.py script. Equally, substitute
tut_40gbe_tx.fpg and tut_40gbe_rx.fpg for the paths to your generated fpg-files in the event you ran
through the build process. These files should be in tut_40gbe_tx/outputs/ and tut_40gbe_rx/outputs/
. After executing the script as above you should see something resembling the following being printed to your terminal
window:
INFO:root:Connecting to SKARABs
*
*
INFO:root:Programming SKARABs
*
*
INFO:root: Done programming TXer
*
*
INFO:root: Done programming RXer
skarab020202-01
INFO:root:Setting TX destination to 10.0.0.2.
INFO:root:Sending data at 1.970Gbps (0.177Ghz * 256 / 23)
INFO:root:Setting RX port.
INFO:root:Starting TX.
INFO:root:Some RX stats:
INFO:root:
valid: 7432640
INFO:root:
eof: 221779039
INFO:root:
badframe: 0
INFO:root:
overrun: 0
------------------------- pkt_000 ------------------------ctr mark
walking_one
pkt_ctr
ramp
0 7777
32
47491
1
1 7777
64
47491
2
2 7777
128
47491
3
3 7777
256
47491
4
(continues on next page)
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(continued from previous page)

4 7777

512

47491

5

*
*
*
*
*

If you see any errors do make a note of them! Regardless, please ask if you have any questions, of which I am sure
there will be many.

2.1.8 Tutorial 3: HMC Interface
AUTHORS: A. Isaacson and A. van der Byl
EXPECTED TIME: 2 hours
Introduction
In this tutorial, you will create a simple Simulink design which writes and reads to/from the HMC Mezzanine Card
that is plugged into the SKARAB Mezzanine 0 MegaArray slot - refer to SKARAB for more information. In addition,
we will learn to control the design remotely, using a supplied Python library for KATCP.
In this tutorial, a counter will be used to generate HMC test write data. Another counter will be used to read the test
data from the HMC. The write and read data rate can be controlled by a software register to read and write every
second clock cycle or read and write every clock cycle. This test can be used to demonstrate the throughput that the
HMC can handle. This tutorial will also explain why the HMC read data needs to be reordered and shows a way of
doing this using BRAM with BRAM read and write control.
Background
SKARAB boards have four MegaArray mezzanine slots. Mezzanine 3 is traditionally used for the QSFP+ Mezzanine
Card, which makes provision for the 40GbE Interface functionality - refer to SKARAB. The rest of the Mezzanine
slots (0, 1 and 2) can be used for the HMC Mezzanine Card. This tutorial assumes that the HMC Mezzanine Card is
fitted in mezzanine 0 slot. The SKARAB board can have up to three HMC Mezzanine Cards.
The HMC Mezzanine Card is fitted with a single Micron HMC MT43A4G80200 – 4GB 8H DRAM stack device. The
HMC (Hybrid Memory Cube) Mezzanine Card, is a 4GB, serialised memory, which uses 16 x 10Gbps SERDES lanes
to the FPGA per a mezzanine site. The HMC hardware works using the OpenHMC core designed by Juri Schmidt
who works for the Computer Architecture Group at the University of Heidelberg CAG and OpenHMC. The OpenHMC
core is designed to be fully configurable, but this tutorial is using the configuration: 256 bit data transfer and 4 FLITS
per a word.
The HMC yellow block makes provision for two links: Link 2 and Link 3. Each Link uses 8 x TX/RX GTH full
duplex lines rated at 10Gbps each. This can be higher, but we are using it at this rate. This means that theoretically
each link can handle 80Gbps throughput. The reality is that the HMC interface uses a protocol (FLIT = Floating Unit),
which has a 128 bit (64 bit header and 64 bit tail), so at least half of that data is header and so the actual throughput
will be in the region of 40Gbps. This has been tested successfully at 32 Gbps, with both links active. This tutorial will
only write and read from link 3, so can handle a throughput between 32Gbps - 40Gbps. This tutorial tests the HMC
with a write/read throughput of 29.44Gbps (pass) and a write/read throughput of 58.88Gbps (fail). The user will see
the difference in the HMC data and status monitoring when the HMC read and write mechanism is successful and
compare it to when it is unsuccessful.
The HMC memory has controller logic built in as well as stacked DRAM. This controller logic and stacked DRAM
are divided into vaults. It is important to note that due to the DRAM refresh cycles when you request data (i.e. read)
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from the HMC you will not always get the reads returned to you in the correct order. The HMC will only return data
that has been requested only when the vault is available. If the vault is not available then it will handle other requests
that are available. This out of order return allows the HMC to meet the higher throughput, but it does mean that the
data read from the HMC needs to reordered before using it. This tutorial will show you how to do this.
The HMC address scheme is user configurable, but also has set patterns and we are using one of the set patterns. The
FLITs per a word (FPW) is also configurable, but the HMC yellow block is using 4 FLITS per a word. Each Flit is
128 bits, so 512 bits in total. The HMC is running at a 156.25MHz rate and the data width (after the header and tail
have been removed) is 256bits. This gives a maximum data throughput of 256bits x 156.25MHz = 40Gbps.
It is important to note that each write uses 3 x FLITS and each read uses 1 x FLIT, so if you try to interleave read and
writes then there will be a loss of throughput as the HMC devices are not being accessed nominally, as the FLITS per
a word is set to 4. It is important to write and read simultaneously in order to achieve the correct throughput. It is not
possible to read and write from the same address simultaneously and so there needs to be an offset between the read
and write address. This tutorial uses an offset between the write and read addresses.
The address structure also influences the overall latency in the device. If you access a vault from a link that is not
hardware linked to the vault then there will be additional latency to move from one vault to another. There are 16
vaults for this particular HMC device. All links can access all the vaults. The hardware linking looks as follows:
Link 0: vault 0, 1, 2, 3 (Link 0 is not available)
Link 1: vault 4, 5, 6, 7 (Link 1 is not available)
Link 2: vault 8, 9, 10, 11
Link 3: vault 12, 13, 14, 15
Therefore, using Link 2 and Link 3 try and use their corresponding vaults if the goal is to minimise latency, but in
order to maximise throughput then circle the write and read address through all the vaults so that there will always be
data available to process. This tutorial cycles through a limited address space to demonstrate this.
The HMC yellow block is using a 4GB device with 32 Byte Max Block size, which is shown in Table 13 below. The
HMC firmware handles the request address bits 0-4 and 32-33. The HMC yellow block write and read address is 27
bits, which is mapped to request address bit 5-31 of the 32-Byte Max Block Size, which is shown in Table 13 below.
Bit 5 is the LSB and bit 31 is the MSB.
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More information on the HMC device (Rev D) and OpenHMC controller (Rev 1.5) can be found under the following
repo (in the “hmc” folder):
SKARAB Docs (master branch)
Create a new model
Start Matlab and open Simulink (either by typing ‘simulink’ on the Matlab command line, or by clicking on the
Simulink icon in the taskbar). A template is provided for this tutorial with a pre-created HMC reordering function,
SKARAB XSG core config or platform block, Xilinx System Generator block and a 40GbE yellow block (required
for communication with the board). Get a copy of this template and save it as a new design in the directory in which
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you are saving your tutorial models. Within this design, make sure the SKARAB XSG_core_config_block or platform
block is configured for:
1. Hardware Platform: “SKARAB:xc7vx690t”
2. User IP Clock source: “sys_clk”
3. User IP Clock Rate (MHz): 230 (230MHz clock derived from 156.25MHz on-board clock). This clock domain
is used for the Simulink design
The rest of the settings can be left as is. Click OK.
Add control and reset logic
A very important piece of logic to consider when designing your system is how, when and what happens during
reset. In this example we shall control our resets via a software register. We shall have one reset to reset the HMC
design counters and trigger the data capture snap blocks. We shall have one data rate select, which will control/select
the throughput through the HMC and we shall have one HMC write/read enable signal, which allows the user to
disable/enable the process, so that the hmc read counter, write counter and hmc out counter all represent the same
instant in time. Construct reset and control circuitry as shown below.

Add a software register
Use a software register yellow block from the CASPER XPS Blockset->Memory for the reg_cntrl block. Rename it to
reg_cntrl. Configure the I/O direction to be From Processor. Attach two Constant blocks from the Simulink->Sources
section of the Simulink Library Browser to the input of the software register and make the value 0 and 1 as shown
above.
Add Goto Blocks
Add three Goto blocks from Simulink->Signal Routing. Configure them to have the tags as shown (rst_cntrl,
data_rate_sel and wr_rd_en). These tags will be used by associated From (also found in Simulink->Signal Routing) blocks in other parts of the design. These help to reduce clutter in your design and are useful for control signals
that are routed to many destinations. They should not be used a lot for data signals as it reduces the ease with which
data flow can be seen through the system.
Add a write and read counter to generate test data for the HMC
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Add Counter Blocks
Add four Counter blocks from Xilinx Blockset->Basic Elements and configure it to be unsigned, free-running, 9-bits,
incrementing by 1 as shown below - the block parameters are the same for all counters. The first counter represents
the write data, the second counter represents the write address, the third counter represents the read data and the fourth
counter represents the read address as shown below.
Add Delay Blocks
Add the delay blocks from Xilinx Blockset->Basic Elements and configure it as shown below. The read enable is
delayed by 256 clock cycles in order to prevent the read and write address from clashing. It also allows ample time for
a write to occur before reading occurs. The HMC write enable and read enable signal are aligned in order to ensure
that the HMC reading and writing happen concurrently.
Add Goto and From Blocks
Add Goto and From blocks from Simulink->Signal Routing as shown below. Configure them to have the tags as
shown.
Add Gateway Out Blocks and Scopes
Add Gateway Out blocks from Xilinx Blockset->Data Types as shown below. Remember to disable the “translate into
output port” check. The purpose of the gateway out block is because we are connecting Xilinx blocks to the Simulink
scope. You don’t need a gateway, but a warning will be generated when you compile the simulink block (Ctrl+D).
Add Scopes from Simulink->Sinks, in order to visually display the signals after simulation as shown below.
In simulation this circuit will generate a write & read address and data counter from 0 to 511 and the counter will wrap
around after 511 as it is only 9 bits. This will allow us to generate simple test data for the HMC in order to analyse
the memory writing and reading process. If the data is the same as the address then it is easier to see what is going
on. Also, if the counter overflows all the time then it is easier to compare the HMC write with the HMC read and the
HMC reorder process.
The dotted red-lines represent the counter enable signal path and that is generated by the data rate control function in
the section below.
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Add functionality to control the write and read data rate
As mentioned earlier in this tutorial, it is impossible to perform HMC read and write at the full clock rate. This would
mean writing/reading a 256 bit word at 230MHz (58.88Gbps), and the HMC firmware supports up to a maximum of
256 bit at 156.25MHz (40Gbps) data throughput. We thus want to limit the data rate, so that the HMC firmware FIFOs
do not overflow. We thus add circuitry to limit the data rate as shown below. The logic that we have added below
can either enable the HMC write and read counters every clock cycle or enable the HMC write and read counters
every second cycle. There is a multiplexer, which is controlled via a software register that can select either rate for
demonstration purposes.
Implement the function that performs the write and read data rate control as shown below:
Add a Counter Block
Add one Counter block from Xilinx Blockset->Basic Elements and configure it to be unsigned, free-running, 2-bits,
incrementing by 1 as shown below. This counter is used to divide the data rate by 2 using the LSB of the counter.
Add Xilinx Constant Blocks
Add three Constant blocks from Xilinx Blockset->Basic Elements and configure it to be a 1 or a 0 as shown below.
All constants must be boolean.
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Add Slice Block
Add a Slice block from the Xilinx Blockset-> Basic Elements, as shown below. Configure it to select the least
significant bit.
Add From Blocks
Add From blocks from Simulink->Signal Routing as shown below. Configure them to have the tags as shown below.
Add Xilinx Convert (cast) Block
Add a Xilinx Convert block from Xilinx Blockset-> Data Types. Configure it to be boolean.
Add Xilinx Bus Multiplexer (Mux) Block
Add a Xilinx Mux block from Xilinx Blockset-> Basic Elements. Configure it to have two inputs, 1 clock cycle latency
and full output precision, as shown below.
Add Xilinx Logical Block
Add a Xilinx logical block from Xilinx Blockset-> Basic Elements. Configure it to have four inputs, no latency and
full output precision, as shown below.
Add Gateway Out and To Workspace Block (Optional)
Add Gateway Out blocks from Xilinx Blockset->Data Types as shown below. Remember to disable the “translate into
output port” check. The purpose of the gateway out block is because we are connecting Xilinx blocks to the Simulink
workspace variable. You don’t need a gateway, but a warning will be generated when you compile the simulink block
(Ctrl+D).
Add to To Workspace blocks from Simulink->Sinks as shown below. This captures all the simulation data to the
Matlab workspace variable. This makes it easier to see if data is aligned than just looking at the scope display. This
step is optional, but you are welcome to try it.
The dotted red lines indicates where it interfaces with the HMC write and read control functionality in the section
above.
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Add HMC and associated registers for error monitoring
We will now add the HMC yellow block in order to write and read to the HMC Mezzanine Card on the SKARAB.
Add the HMC yellow block for memory accessing
Add a HMC yellow block from the CASPER XPS Blockset->Memory, as shown below. It will be used to write and
read data to/from the HMC memory on the Mezzanine Card. Rename it to hmc. Double click on the block to configure
it and set it to be associated with Mezzanine slot 0. Make sure the simulation memory depth is set to 22 and the latency
is set to 5. The randomise option should be checked, as this will ensure that the read HMC data is out of sequence,
which emulates the operation of the HMC. This is explained above.
Add the Xilinx constant blocks as shown below - the tag is 9 bits, the data is 256 bits, the address is 27 bits and the
rest is boolean. Add Xilinx cast blocks to write data (cast to 256 bits), write/read address (cast to 27 bits) and hmc
data out (cast to 9 bits). Add the GoTo and From blocks and name them as shown below.
Link 2 is not used, so the outputs can be terminated, as shown below. Add the terminator block from Simulink->Sinks
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Add a register to provide HMC status monitoring
Add one yellow-block software register to provide the HMC status (1 bit). Name it as shown below. The register
should be configured to send its value to the processor. Connect it to the HMC yellow block as shown below using
GoTo blocks. A Convert (cast) block is required to interface with the 32 bit registers. Delay blocks are also required.
To workspace blocks from Simulink->Sinks are attached to the simulation outputs of the software registers.
The HMC status is made up of the HMC OK flag. If there are any errors with the HMC initialisation, HMC POST
(Power On Self Test), FLIT transactions or HMC ERRSTAT register then this flag will be set to “0”. It takes a
maximum of 1.2s for the HMC lanes to align and the initialisation process to complete. Once this is done then
internally generated test data is written into the HMC. The data is then read out and compared with the data written in.
If there is a match then POST passes and the internal POST OK flag is set to ‘1’. In this case, HMC initialisation done
will be ‘1’ when the initialisation is successful and the POST process has finished. The internal POST OK flag will
only be set to ‘1’ when the memory test is successful. Therefore, the user can only start writing and reading to/from
the HMC when HMC Ok is set to ‘1’. If this flag is ‘0’ then the HMC did not properly start up or data has been
corrupted. Refer to the HMC Data Rate Control functionality above, which uses this flag to only start the write and
read process when they are asserted.
The internal HMC receive FLIT protocol error status register (HMC ERRSTAT) is 7 bits. If any of these bits are ‘1’
then this means an error has occurred. This should always be ‘0’. In order to decode what this error means there is a
table in the HMC data sheet on page 48 Table 20.
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The HMC is connected to the wishbone interface and hence, it is possible to read back the internal HMC status registers
using casperfpga - see below for how to do this.
Implement the HMC reordering functionality
We will now implement logic to reorder the data that is read out of sequence from the HMC. This is critical, as the
data is no use to us if it is out of sequence. This is already included in the template for this tutorial, so please use this
functionality as is to save time. Some details are provided here for completeness.
The logic below looks complicated, but it is not. The HMC does not read back the data in the order it was requested
due to how the HMC vaults operate and the DRAM refresh cycles. This makes the HMC readback undeterministic.
The HMC reorder BRAM (512 Deep) reorders all the data read back from the HMC. This will synchronise the reorder
readouts by using the read out tag as the write address of the reorder BRAM. It turns out through experience that the
maximum delay can be in the order of 256 tags, when the data is requested. The function below does the following:
1. It ensures that the HMC has written at least 256 words into the reorder BRAM before reading out of the reorder
BRAM.
2. It makes sure the read pointer does not exceed the write pointer i.e. do not read data that has not been written
yet.
3. Once the read pointer reaches count 256 then it waits until the write pointer count is at 512 and then continues
to read the rest of the reorder BRAM while the write pointer starts from 0 again. This prevents the write and
read pointers from clashing. This is essentially a bank swopping control mechanism.
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Buffers to capture HMC write, HMC read and HMC reordered read data
The HMC write data (input), HMC read data (output) and HMC reordered data need to be connected to bitfield
snapshot blocks for data capture analysis (located in CASPER DSP Blockset->Scopes), as shown below. These blocks
(hmc_in_snap, hmc_out_snap and hmc_reorder_snap) are identical internally. Using these blocks, we can capture data
as it is written and compare it to the data we have read and finally to the data that has been reordered.
Bitfield snapshot blocks are a standard way of capturing snapshots of data in the CASPER tool-set. A bitfield snap
block contains a single shared BRAM allowing capture of 128-bit words.

The ctrl register in a snap block allows control of the capture. The least significant bit enables the capture. Writing a
rising edge to this bit primes the snap block for capture. The 2nd least most significant bit allows the choice of a trigger
source. The trigger can come from an external source or be internal and immediately. The 3rd most least significant
bit allows you to choose the source of the valid signal associated with the data. This may also be supplied externally
or be immediately enabled.
The basic principle of the snap block is that it is primed by the user and then waits for a trigger at which point it
captures a block of data and then waits to be primed again. Once primed the addr output register returns an address
of 0 and will increment as data is written into the BRAMs. Upon completion the addr register will contain the final
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address. Reading this value will show that the capture has completed and the results may be extracted from the shared
BRAMs.
In the case of this tutorial, the arming and triggering is done via software. The trigger is the rst signal. The “we”
signal on the snapshot blocks is the data valid signal. Configure and connect the snap blocks as shown above. The
Convert (cast) blocks should all be to 9 bits. The delays should be as shown above, as this aligns the data correctly.
The following settings should be used for the bitfield snapshot blocks: storage medium should be BRAM, number
of samples (“2^?”) should be 13, Data width 64, all boxes unchecked except “use DSP48s to implement counters”,
Pre-snapshot delay should be 0.
HMC status registers
We shall now look at some registers to monitor the progress of our HMC writing and reading. We shall be able to
check how many HMC write and read requests were issued and compare it to actual data read out of the memory via
registers. We shall be able to check if the HMC is handling the throughput for the writing and reading via registers.
Write status registers
• ‘’hmc_wr_cnt” is attached to a counter that increments when the HMC write enable signal is asserted ‘1’. It
keeps a count of the number of write requests.
• ‘’hmc_empty_wr_cnt” is attached to a counter that will increment only when the HMC write enable signal and
HMC write ready signal are asserted ‘1’. This is optional.
• ‘’hmc_wr_err” is a register that allows us to check if the HMC is meeting the write throughput by incrementing
a counter every time the write enable signal is asserted ‘1’ when the HMC write ready signal is deasserted ‘0’
i.e. the HMC yellow block is still busy reading from the FIFO and is not ready for more write data.
Read status registers
• ‘’hmc_rd_cnt” is attached to a counter that increments when the HMC read enable signal is asserted ‘1’. It keeps
a count of the number of read requests.
• ‘’hmc_empty_rd_cnt” is attached to a counter that will increment only when the HMC read enable signal and
HMC read ready signal are asserted ‘1’. This is optional.
• ‘’hmc_out_cnt” is attached to a counter that will increment only when the HMC data valid signal is asserted ‘1’.
It keeps a count of the number of valid read data coming from the memory.
• ‘’hmc_rd_err” is a register that allows us to check if the HMC is meeting the read throughput by incrementing
a counter every time the read enable signal is asserted ‘1’ when the HMC read ready signal is deasserted ‘0’ i.e.
the HMC yellow block is still busy reading from the FIFO and is not ready for more write data.
From tag rst_cntrl should go through an edge_detect block (rising and active high) to create a pulsed rst signal, which
is used to trigger and reset the counters in the design. This is located in CASPER DSP Blockset -> Misc.
It should look as follows when you have added all the relevant registers:
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You should now have a complete Simulink design. Compare it with the complete hmc tutorial *.slx model provided to
you before continuing if unsure.
Simulink Simulation
Press CTRL+D to compile the tutorial first and make sure there are no errors before simulating. If there are any errors
then a diagnostic window will pop up and the errors can be addressed individually.
The design can be simulated with clock-for-clock accuracy directly from within Simulink. Set the number of clock
cycles that you’d like to simulate and press the play button in the top toolbar. I would suggest make it 3000 in order to
see a few cycles.

You can watch the simulation progress in the status bar in the bottom right. It may take a minute or two to simulate
3000 clock cycles.
Double-click on the scopes in the design to see what the signals look like on those lines. For example, the
hmc_wr_add_s, hmc_rd_add_s, hmc_wr_en_s and hmc_rd_en_s scopes should look like below. You might have
to press the Autoscale button to scale the scope appropriately. Note how the HMC read address is delayed by 256
clock cycles from the HMC write address. Note how the HMC write enable is aligned with the HMC read enable.
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Double-click on the scopes at the output of the HMC yellow block. The hmc_data_out_s and hmc_rd_tag_out_s
scopes should look like below. You might have to press the Autoscale button to scale the scope appropriately. Note
how the HMC read tag output data and the HMC read data output are out of sequence. This data is useless to us in this
form. It needs to be reordered.
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Finally lets double-click on the scopes at the output of the HMC reordering function. The hmc_reord_rd_add_s,
hmc_reord_rd_en_s and the hmc_reord_data_s scopes should look like below. You might have to press the Autoscale
button to scale the scope appropriately. Note how the data increases in a linear ramp and then stays at 255 for a period
of time and then begins to increase in a linear ramp until it reaches 511 and then resets. If you compare with the HMC
reorder read enable signal then the data is actually still a ramp, as not all of the data is valid. This makes sense as the
HMC reordering logic will only read from the BRAM once the write pointer is at address 255 and then again when
the write pointer is at 511. This prevents the write and read pointers from clashing as explained above.
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Once you have verified that that design functions as you’d like, you’re ready to compile for the FPGA. . .
Compilation
It is now time to compile your design into a FPGA bitstream. This is explained below, but you can also refer to
the Jasper How To document for compiling your toolflow design. This can be found in the ReadtheDocs mlib_devel
documentation link:
https://casper-toolflow.readthedocs.io
In order to compile this to an FPGA bitstream, execute the following command in the MATLAB Command Line
window:
jasper

This will run the process to generate the FPGA bitstream and output Vivado compile messages to the MATLAB
Command Line window along the way. During the compilation and build process Vivado’s system generator will be
run, and the windows below should pop up with the name of your slx file in the window instead of tut_1. The same
applies below in the output file path - tut_1 will be replaced with the name of your slx file. In my case it is “tut_hmc”.
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Execution of this command will result in an output .bof and .fpg file in the ‘outputs’ folder in the working directory
of your Simulink model. Note: Compile time is approximately 45-50 minutes, so a pre-compiled binary (.fpg file) is
made available to save time.

Programming the FPGA
Reconfiguration of the SKARAB’s SDRAM is done via the casperfpga python library. The casperfpga package for
python, created by the SA-SKA group, wraps the Telnet commands in python and is used in the CASPER community.
We will focus on programming and interacting with the FPGA using this method.
Getting the required packages
These are pre-installed on the server in the workshop and you do not need to do any further configuration, but if you
are not working from the lab then refer to the How To Setup CasperFpga Python Packages document for setting up the
python libraries for casperfpga. This can be found in the “casperfpga” repo wiki (to be deprecated) located in GitHub
and the ReadtheDocs casperfpga documentation link:
casperfpga README.md
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Copy your .fpg file to your NFS server
As per the previous figure, navigate to the outputs folder and (secure)copy this across to a test folder on the workshop
server.
scp path_to/your/model_folder/your_model_name/outputs/your_fpgfile.fpg user@server:/
˓→path/to/test/folder/

Connecting to the board
SSH into the server that the SKARAB is connected to and navigate to the folder in which your .fpg file is stored.
Start interactive python by running:
ipython

Now import the fpga control library. This will automatically pull-in the KATCP library and any other required communications libraries.
import casperfpga

To connect to the SKARAB we create an instance of the SKARAB board; let’s call it fpga. The wrapper’s fpgaclient
initiator requires just one argument: the IP hostname or address of the SKARAB board.
fpga = casperfpga.CasperFpga('skarab_name or ip_address')

The first thing we do is configure the FPGA.
fpga.upload_to_ram_and_program('your_fpgfile.fpg')

All the available/configured registers can be displayed using:
fpga.listdev()

The FPGA is now configured with your design. The registers can now be read back. For example, the HMC status
register can be read back from the FPGA by using:
fpga.read_uint('hmc_status') or fpga.registers.hmc_status.read_uint();

The value returned should be 1, which indicates that the HMC has successfully completed initialisation, POST OK
passes and data is not corrupted.
If you need to write to the reg_cntrl register then do the following:
fpga.registers.reg_cntrl.write(data_rate_sel= False), where data_rate_sel = False
(29.44Gbps), data_rate_sel = True (58.88Gbps)

˓→

fpga.registers.reg_cntrl.write(rst = 'pulse'), this creates a pulse on the rst signal
fpga.registers.reg_cntrl.write(wr_rd_en= True) , where wr_rd_en = False (disable HMC
write/read), wr_rd_en = True (Enable the HMC write/read)

˓→

You can read back the HMC mezzanine site, HMC die revisions and internal status registers by doing the following:
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fpga.hmcs.hmc.mezz_site, this returns the mezzanine site that fpga.hmcs.hmc is
˓→connected to
fpga.hmcs.hmc.get_hmc_revision(), this reads back the HMC firmware and product
˓→revisions
fpga.hmcs.hmc.get_hmc_status(), this reads back the HMC status of the OpenHMC
˓→Controller - refer to OpenHMC controller document to understand the status bits
˓→located under "hmc" in [SKARAB Docs](https://github.com/casper-astro/casper˓→hardware/tree/master/FPGA_Hosts/SKARAB/docs) (master branch)

Manually typing these commands by hand will be cumbersome, so it is better to create a Python script that will do all
of this for you. This is described below.
Running a Python script and interacting with the FPGA
A pre-written python script, ‘’tut_hmc.py” is provided. The code within the python script is well commented and
won’t be explained here. The user can read through the script in his/her own time. In summary, this script programs
the fpga with your complied design (.fpg file), writes to the control registers, initates the HMC write & read process,
reads back the HMC snap shot captured data and status registers while displaying them to the screen for analysis. In
order to run this script you will need to edit the file and change the target SKARAB IP address and the *.fpg file, if
they are different. The script is run using:
python tut_hmc.py

If everything goes as expected, you should see a whole bunch of text on your screen - this is the output of the snap
block and status register contents.
Analysing the Display Data
You should see something like this:
user@server:~$ python tut_hmc.py
connecting to SKARAB...
done
programming the SKARAB...
done
arming snapshot blocks...
done
triggering the snapshots and reset the counters...
done
enabling the HMC write and read process...
done
reading the snapshots...
done
disabling the HMC write and read process...
done
reading back the status registers...
hmc rd cnt: 55527004
hmc wr cnt: 55527004
hmc out cnt: 55527004
hmc wr err: 0
hmc rd err: 0
hmc status: 1
(continues on next page)
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rx crc err cnt: 0
hmc error status: 0
done
Displaying the snapshot block data...
HMC SNAPSHOT CAPTURED INPUT
----------------------------Num wr_en wr_addr wr_data wr_rdy rd_en rd_addr rd_tag rd_rdy
[0] 1 1 1 1 0 0 0 1
[1] 1 2 2 1 0 0 0 1
[2] 1 3 3 1 0 0 0 1
[3] 1 4 4 1 0 0 0 1
[4] 1 5 5 1 0 0 0 1
[5] 1 6 6 1 0 0 0 1
[6] 1 7 7 1 0 0 0 1
[7] 1 8 8 1 0 0 0 1
[8] 1 9 9 1 0 0 0 1
[9] 1 10 10 1 0 0 0 1
[10] 1 11 11 1 0 0 0 1
....
[589] 1 78 78 1 1 462 462 1
[590] 1 79 79 1 1 463 463 1
[591] 1 80 80 1 1 464 464 1
[592] 1 81 81 1 1 465 465 1
[593] 1 82 82 1 1 466 466 1
[594] 1 83 83 1 1 467 467 1
[595] 1 84 84 1 1 468 468 1
[596] 1 85 85 1 1 469 469 1
[597] 1 86 86 1 1 470 470 1
[598] 1 87 87 1 1 471 471 1
[599] 1 88 88 1 1 472 472 1
HMC SNAPSHOT CAPTURED OUTPUT
----------------------------Num hmc_read_tag_out hmc_data_out
[1] 1 1
[2] 2 2
[3] 3 3
[4] 4 4
[5] 5 5
[6] 6 6
[7] 7 7
[8] 8 8
[9] 9 9
[10] 10 10
[11] 12 12
[12] 11 11
[13] 13 13
....
[588] 75 75
[589] 77 77
[590] 78 78
[591] 79 79
[592] 80 80
[593] 81 81
[594] 82 82
[595] 83 83
[596] 84 84
[597] 85 85
(continues on next page)
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[598] 86 86
[599] 87 87
HMC REORDER SNAPSHOT CAPTURED OUTPUT
------------------------------------Num rd_en rd_addr data_out
[1] 1 1 1
[2] 1 2 2
[3] 1 3 3
[4] 1 4 4
[5] 1 5 5
[6] 1 6 6
[7] 1 7 7
[8] 1 8 8
[9] 1 9 9
[10] 1 10 10
[11] 1 11 11
[12] 1 12 12
[13] 1 13 13
[14] 1 14 14
[15] 1 15 15
....
[588] 1 76 76
[589] 1 77 77
[590] 1 78 78
[591] 1 79 79
[592] 1 80 80
[593] 1 81 81
[594] 1 82 82
[595] 1 83 83
[596] 1 84 84
[597] 1 85 85
[598] 1 86 86
[599] 1 87 87

The above results show that the HMC is meeting the 29.44Gbps throughput, as the HMC write error register
(hmc_wr_err) and HMC read error register (hmc_rd_err) is 0, which means the HMC is always ready for data when
the HMC write/read request occurs. Note that the HMC read count (hmc_rd_cnt), HMC write count (hmc_wr_cnt)
and HMC read out count (hmc_out_cnt) are all equal, which is expected. Compare the HMC snapshot output data
and the HMC reorder snapshot captured output data - notice how the HMC snapshot output data is out of sequence
in places and the HMC snapshot reorder data is in sequence again. There is no missing data. This is how the HMC
should work.
Edit the tut_hmc.py script again and change the data rate to 58.88Gbps. Rerun as above and this time notice that the
difference in the above registers and snapshot data. What do you see? You should see that HMC read count, HMC
write count and HMC read out count values do not match. The HMC write error register and HMC read error register
should be non zero, which indicates that the HMC is asserting write and read requests when the HMC write and read
ready signals are not asserted, which means the FIFO is not being cleared fast enough. The HMC read output data will
still be out of sequence, but data will be lost. This can be clearly seen in the HMC reorder snapshot captured output.
Other notes
• iPython includes tab-completion. In case you forget which function to use, try typing library_name.tab
• There is also onboard help. Try typing library_name.function?
• Many libraries have onboard documentation stored in the string library_name.doc

162

Chapter 2. Tutorial Instructions

CASPER Tutorials Documentation, Release 0.1

• KATCP in Python supports asynchronous communications. This means you can send a command, register a callback
for the response and continue to issue new commands even before you receive the response. You can achieve much
greater speeds this way. The Python wrapper in the corr package does not currently make use of this and all calls are
blocking. Feel free to use the lower layers to implement this yourself if you need it!
Conclusion
This concludes the HMC Interface Tutorial for SKARAB. You have learned how to utilize the HMC interface on a
SKARAB to write and read data to/from the HMC Mezzanine Card. You also learned how to further use Python to
program the FPGA and control it remotely using casperfpga.

2.1.9 Tutorial 4: Wideband Spectrometer
The SKARAB wideband spectrometer tutorials make use of a SKARAB ADC Board. There are two different bandwidth modes available for a SKARAB ADC Board depending on which ADC module is on the board. These are
detailed in the table below:
Bandwidth
Mode
DDC Mode
Bypass Mode

Sampling
quency
3 GSPS
2.8 GSPS

Fre-

Decimation Factor
4
None (bypassed)

SKARAB ADC Support
All SKARAB ADC Board Types
Only SKARAB ADC Boards
ADC32RF45

with

As such, there are two versions of wideband spectrometer tutorial, one for each mode. Links to these are given below:
1. Wideband Spectrometer - DDC Mode
2. Wideband Spectrometer - Bypass Mode
For more information on working with the SKARAB ADC Board please see Tutorial 5: SKARAB ADC Synchronous
Data Acquisition
Tutorial 4: Wideband Spectrometer - DDC Mode
Introduction
A spectrometer is something that takes a signal in the time domain and converts it to the frequency domain. In digital
systems, this is generally achieved by utilising the FFT (Fast Fourier Transform) algorithm.
When designing a spectrometer for astronomical applications, it’s important to consider the science case behind it. For
example, pulsar timing searches will need a spectrometer which can dump spectra on short timescales, so the rate of
change of the spectra can be observed. In contrast, a deep field HI survey will accumulate multiple spectra to increase
the signal to noise ratio. It’s also important to note that “bigger isn’t always better”; the higher your spectral and time
resolution are, the more data your computer (and scientist on the other end) will have to deal with. For now, let’s skip
the science case and familiarize ourselves with an example spectrometer.
Setup
This tutorial comes with a completed model file, a compiled bitstream, ready for execution on SKARAB, as well as a
Python script to configure the SKARAB and make plots. Here
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Spectrometer Basics
When designing a spectrometer there are a few main parameters of note:
• Bandwidth: The width of your frequency spectrum, in Hz. This depends on the sampling rate; for complex
sampled data this is equivalent to:

In contrast, for real or Nyquist sampled data the rate is half this:

as two samples are required to reconstruct a given waveform .
• Frequency resolution: The frequency resolution of a spectrometer, ∆f, is given by

,
and is the width of each frequency bin. Correspondingly, ∆f is a measure of how precise you can measure a frequency.
• Time resolution: Time resolution is simply the spectral dump rate of your instrument. We generally accumulate
multiple spectra to average out noise; the more accumulations we do, the lower the time resolution. For looking
at short timescale events, such as pulsar bursts, higher time resolution is necessary; conversely, if we want to
look at a weak HI signal, a long accumulation time is required, so time resolution is less important.
Simulink / CASPER Toolflow
Simulink Design Overview
If you’re reading this, then you’ve already managed to find all the tutorial files. By now, I presume you can open the
model file and have a vague idea of what’s happening. The best way to understand fully is to follow the arrows, go
through what each block is doing and make sure you know why each step is done. To help you through, there’s some
“blockumentation” in the appendix, which should (hopefully) answer all questions you may have. A brief rundown
before you get down and dirty:
• In the slx file, you’ll notice a subsystem block in the top left corner of the design. If you click into it, you’ll
see it contains a 40 GbE core. That core used to instantiante the board support package and the microblaze
controller, but it is no longer the case. The board support package and the microblaze controller are now part of
the SKARAB platform block. However, as was mentioned in Tutorial 1, a 40 GbE or 1 GbE core is still required
in a SKARAB design for communication purposes.
• The all important Xilinx token is placed to allow System Generator to be called to compile the design.
• In the MSSGE block, the hardware type is set to “SKARAB:xc7vx690t” and clock rate is specified as
187.5MHz. This frequency is specially chosen to avoid overflows on the ADC. Implementing other clock
frequencies will require you to use the data valid port leaving the ADC yellow block.
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• The input signal is digitised by the ADC, resulting in eight parallel time samples of 16 bits each clock cycle:
four in i and four in q. The ADC runs at 3 GHz but decimates by a factor of four, which gives a 375 MHz
nyquist sampled spectrum. The SKARAB ADC uses a digital downconverter, which has a default frequency of
1 GHz. The output range is a signed number in the range -1 to +1 (ie 15 bits after the decimal point). This is
expressed as fix_16_15.
• Unlike the other CASPER spectrometer tutorials, we use the complex FFT block here. The SKARAB ADC
produces demultiplexed i and q channels that are concatenated and fed to the FFT block.
• You may notice Xilinx delay blocks dotted all over the design. It’s common practice to add these into the design
as it makes it easier to fit the design into the logic of the FPGA. It consumes more resources, but eases signal
timing-induced placement restrictions.
• The real and imaginary (sine and cosine value) components of the FFT are plugged into power blocks, to convert
from complex values to real power values by squaring.
• The requantized signals then enter the vector accumulators, simple_bram_vacc0 through simple_bram_vacc3,
which are 64 bit vector accumulators. Accumulation length is controlled by the acc_cntrl block.
• The accumulated signal is then fed into software registers, mem1 through mem4.
Without further ado, open up the model file and start clicking on things, referring to the blockumentation as you go.

2.1. Vivado

165

CASPER Tutorials Documentation, Release 0.1

adc

The first step to creating a frequency spectrum is to digitize the signal. This is done with an ADC – an Analogue to
Digital Converter.
The ADC block converts analog inputs to digital outputs. Every clock cycle, the inputs are sampled and digitized to
16 bit binary point numbers in the range of -1 to 1 and are then output by the ADC. This is achieved through the use of
two’s-compliment representation with the binary point placed after the seven least significant bits. This means we can
represent numbers from -32768 through to 32767 including the number 0. Simulink represents such numbers with a
fix_16_15 moniker.
ADCs often internally bias themselves to halfway between 0 and -1. This means that you’d typically see the output of
an ADC toggling between zero and -1 when there’s no input. It also means that unless otherwise calibrated, an ADC
will have a negative DC offset.
The SKARAB ADC is clocked at 3.0 GHz. There is a decimation factor of 4, so the sample rate is 750 MHz. The i
and q channels each have a demux factor of 4, so the FPGA is clocked at 187.5 MHz. The bandwidth for a 750 MHz
sample rate is 375 MHz, as Nyquist sampling requires two samples (or more) each second.
INPUTS
OUTPUTS
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The SKARAB ADC has four channels and a series of eight outputs for each. The outputs for a channel comprise four
demultiplexed i’s and four demultiplexed q’s. The i0 port is concatenated with the q0 port to form a complex stream
using the real/imaginary-to-complex block. Similarly, the i1 port is concatenated with the q1 port, i2 with q2, and i3
with q3.
fft

The FFT block is the most important part of the design to understand. The cool green of the FFT block hides the
complex and confusing FFT butterfly biplex algorithms that are under the hood. You do need to have a working
knowledge of it though, so I recommend reading Chapter 8 and Chapter 12 of Smith’s free online DSP guide at
(http://www.dspguide.com/). Parts of the documentation below are taken from the [[Block_Documentation | block
documentation]] by Aaron Parsons and Andrew Martens.
INPUTS/OUTPUTS
PARAMETERS
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power

The power block computes the power of a complex number. The power block typically has a latency of 5 and will
compute the power of its input by taking the sum of the squares of its real and imaginary components. The power
block is written by Aaron Parsons and online documentation is by Ben Blackman.
In our design, there are two power blocks, which compute the power of the odd and even outputs of the FFT. The
output of the block is 36.34 bits; the next stage of the design re-quantizes this down to a lower bitrate.
INPUTS/OUTPUTS
PARAMETERS
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simple_bram_vacc

The simple_bram_vacc block is used in this design for vector accumulation. Vector growth is approximately 28
bits each second, so if you wanted a really long accumulation (say a few hours), you’d have to use a block such
as the qdr_vacc or dram_vacc. As the name suggests, the simple_bram_vacc is simpler so it is fine for this demo
spectrometer. The FFT block demultiplexed frequency bins directly to the accumulator and memory blocks. These
streams are multiplexed in softawre using the tut_spec.py script.
PARAMETERS
INPUTS/OUTPUTS
Software Registers
There are a few control registers, led blinkers, and snap block dotted around the design too:
• cnt_rst: Counter reset control. Pulse this high to reset all counters back to zero.
• acc_len: Sets the accumulation length. Have a look in tut_spec.py for usage.
• sync_cnt: Sync pulse counter. Counts the number of sync pulses issued. Can be used to figure out board uptime
and confirm that your design is being clocked correctly.
• acc_cnt: Accumulation counter. Keeps track of how many accumulations have been done.
• led0_sync: Back on topic: the led0_sync light flashes each time a sync pulse is generated. It lets you know your
ROACH is alive.
• led1_new_acc: This lights up led1 each time a new accumulation is triggered.
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• led2_acc_clip: This lights up led2 whenever clipping is detected.
There are also some snap blocks, which capture data from the FPGA fabric and makes it accessible to the Power PC.
This tutorial doesn’t go into these blocks (in its current revision, at least), but if you have the inclination, have a look
at their documentation.
If you’ve made it to here, congratulations, go and get yourself a cup of tea and a biscuit, then come back for part two,
which explains the second part of the tutorial – actually getting the spectrometer running, and having a look at some
spectra.
Configuration and Control
Hardware Configuration
The tutorial comes with a pre-compiled bof file, which is generated from the model you just went through
(tut_spec.fpg). All communication and configuration will be done by the python control script called tut_spec.py.
Next, you need to set up your SKARAB. Switch it on, making sure that:
• Your tone source is set within the band of the ADC. The default digital downconverter setting is 1 GHz, so signals
within 375 MHz of this frequency should pass. In the tut_spec.py script, 1 GHz is mapped to DC. In our setup, we set
the tone frequency to 1.054 GHz. If you use a different tone frequency, be sure to update the freq_range_mhz =
[0,80] in the Python script so that the plot covers the range of your tone.
The tut_spec.py spectrometer script
Once you’ve got that done, it’s time to run the script. First, check that you’ve connected the ADC to mega-array
connector, and that the clock source is connected to clk_i of the ADC. Now, if you’re in linux, browse to where the
tut3.py file is in a terminal and at the prompt type
./tut_spec.py <skarab IP or hostname> -l <accumulation length> -b <fpgfile name>

replacing with the IP address of your SKARAB, is the number of accumulations, and with your fpgfile. You should
see a spectrum like this:
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Take some time to inspect the tut_spec.py script. It is quite long, but don’t be intimiated. Most of the script is
configuration for the ADC. The import lines begin after the #START OF MAIN comment. There, you will see that
the script
• Instantiates the casperfpga connection with the SKARAB
• Uploads the fpg file
• Sets the ADC
• Records ADC snapshots, interleaves them and writes to a file adcN_data.txt where N is 0..4
• Plots the spectral outputs of the memory blocks
Conclusion
If you have followed this tutorial faithfully, you should now know:
• What a spectrometer is and what the important parameters for astronomy are.
• Which CASPER blocks you might want to use to make a spectrometer, and how to connect them up in Simulink.
• How to connect to and control a SKARAB spectrometer using python scripting.
Tutorial 4: Wideband Spectrometer - Bypass Mode
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Preface
This tutorial is adapted from the original one found Here. It is now leveraged to support ADC operating in Digital
Down Convereter (DDC) Bypass bandwidth mode. The ADC modules based on ADC32RF45 chips which support
both DDC and DDC Bypass bandwidth modes are applicable in this tutorial while focussing only on the DDC Bypass
mode.
Introduction
A spectrometer is something that takes a signal in the time domain and converts it to the frequency domain. In digital
systems, this is generally achieved by utilising the FFT (Fast Fourier Transform) algorithm.
When designing a spectrometer for astronomical applications, it’s important to consider the science case behind it. For
example, pulsar timing searches will need a spectrometer which can dump spectra on short timescales, so the rate of
change of the spectra can be observed. In contrast, a deep field HI survey will accumulate multiple spectra to increase
the signal to noise ratio. It’s also important to note that “bigger isn’t always better”; the higher your spectral and time
resolution are, the more data your computer (and scientist on the other end) will have to deal with. For now, let’s skip
the science case and familiarize ourselves with an example spectrometer.
Setup
This tutorial comes with completed model files, compiled bitstreams, ready for execution on SKARAB, as well as
Python scripts to configure the SKARAB and make plots. Here
Spectrometer Basics
When designing a spectrometer there are a few main parameters of note:
• Bandwidth: The width of your frequency spectrum, in Hz. This depends on the sampling rate; for complex
sampled data this is equivalent to:

In contrast, for real or Nyquist sampled data the rate is half this:

as two samples are required to reconstruct a given waveform .
• Frequency resolution: The frequency resolution of a spectrometer, ∆f, is given by

,
and is the width of each frequency bin. Correspondingly, ∆f is a measure of how precise you can measure a frequency.
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• Time resolution: Time resolution is simply the spectral dump rate of your instrument. We generally accumulate
multiple spectra to average out noise; the more accumulations we do, the lower the time resolution. For looking
at short timescale events, such as pulsar bursts, higher time resolution is necessary; conversely, if we want to
look at a weak HI signal, a long accumulation time is required, so time resolution is less important.
Simulink / CASPER Toolflow
Simulink Design Overview
If you’re reading this, then you’ve already managed to find all the tutorial files. By now, I presume you can open the
model files and have a vague idea of what’s happening. The best way to understand fully is to follow the arrows, go
through what each block is doing and make sure you know why each step is done. To help you through, there’s some
“blockumentation” in the appendix, which should (hopefully) answer all questions you may have. A brief rundown
before you get down and dirty:
In the Main Blocks section, you’ll notice that:
• the Xilinx token is placed to allow System Generator to be called to compile the design.
• In the SKARAB platform block, the hardware type is set to “SKARAB:xc7vx690t” and clock rate is specified
as 176MHz when the sys_clk user IP clock is selected. This frequency is specially chosen to avoid overflows
on the ADC. Implementing other clock frequencies will require you to use the data valid port leaving the ADC
yellow block. When the adc_clk user IP clock is selected, the clock rate defaults to 175MHz.
At the bottom of the design you will find the GbE Interface and the 40GbE Interface blocks. As was mentioned in
Tutorial 1, the GbE Interface or the 40GbE Interface is required in the SKARAB design for communication purposes,
particularly to enable the design to be controlled from the python test script.
In the ADC Data Capture block, there are several components which are responsible for the capturing and processing
the input signal. A brief run down is outlined below:
• The input signal is digitised by the ADC, resulting in sixteen parallel time samples of 12 bits each clock cycle.
The ADC runs at 2.8 GHz. The sixteen samples are provided at a rate of 175MHz: [(2.8 GHz]/[16 samples per
output clock cycles]) = 175MHz. Note that the ADC is operated in DDC bypass mode and provides the full
bandwidth of 1.4 GHz.The output range is a signed number in the range -1 to +1 (ie 15 bits after the decimal
point). This is expressed as fix_16_15
• In this tutorial we use the fft_wideband_real FFT block. The SKARAB ADC yellow block produces demultiplexed real channels that are fed to the FFT block. This FFT block outputs only positive frequencies (negative
frequencies are the mirror images of their positive counterparts), so the number of output ports (8) is half the
number of input ports (16)
• You may notice Xilinx delay blocks dotted all over the design. It’s common practice to add these into the design
as it makes it easier to fit the design into the logic of the FPGA. It consumes more resources, but eases signal
timing-induced placement restrictions
• The real and imaginary (sine and cosine value) components of the FFT are plugged into power blocks, to convert
from complex values to real power values by squaring
• The requantized signals then enter the vector accumulators, simple_bram_vacc1 through simple_bram_vacc8,
which are 64 bit vector accumulators. Accumulation length is controlled by the acc_cntrl block
• The accumulated signal is then fed into bram memory blocks, mem1 through mem8
Without further ado, open up the model file and start clicking on things, referring to the blockumentation as you go.
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adc

The first step to creating a frequency spectrum is to digitize the signal. This is done with an ADC – an Analogue to
Digital Converter.
The ADC block converts analog inputs to digital outputs. Every clock cycle, the inputs are sampled and digitized to
12 bit binary point numbers in the range of -1 to 1 and are then output by the ADC. This is achieved through the use
of two’s-compliment representation with the binary point placed after the seven least significant bits. This means we
can represent numbers from -4096 through to 4095 including the number 0. Simulink represents such numbers with a
fix_12_11 moniker.
ADCs often internally bias themselves to halfway between 0 and -1. This means that you’d typically see the output of
an ADC toggling between zero and -1 when there’s no input. It also means that unless otherwise calibrated, an ADC
will have a negative DC offset.
The SKARAB ADC is clocked at 2.8 GHz. It is operated in DDC bypass mode while outputting sixteen parallel
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samples, so the FPGA is clocked at 175 MHz. The bandwidth for a 2.8 GHz sample rate is 1.4 GHz, as Nyquist
sampling requires two samples (or more) each second.
PARAMETERS The Yellow Block parameters are as follows:
• Mezzanine slot: Mezzanine slot (0 to 3) of the SKARAB where the SKARAB ADC board is installed.
• Master/Slave: The Master performs clocking (generates adc_clk) and synchronisation functions. There should
only be one Master SKARAB ADC Yellow Block in a Simulink design while the remaining (if any) need to be
Slaves.
OUTPUTS
The Yellow Block outputs are as follows:
fft

The FFT block is the most important part of the design to understand. The cool green of the FFT block hides the
complex and confusing FFT butterfly biplex algorithms that are under the hood. You do need to have a working
2.1. Vivado
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knowledge of it though, so I recommend reading Chapter 8 and Chapter 12 of Smith’s free online DSP guide at The
Scientist and Engineer’s Guide to Digital Signal Processing. Parts of the documentation below are taken from the
[[Block_Documentation | block documentation]] by Aaron Parsons and Andrew Martens.
INPUTS/OUTPUTS
PARAMETERS
power

The power block computes the power of a complex number. The power block typically has a latency of 5 and will
compute the power of its input by taking the sum of the squares of its real and imaginary components. The power
block is written by Aaron Parsons and online documentation is by Ben Blackman.
The output of the block is 36.35 bits; the next stage of the design re-quantizes this down to a lower bitrate.
INPUTS/OUTPUTS
PARAMETERS
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simple_bram_vacc

The simple_bram_vacc block is used in this design for vector accumulation. Vector growth is approximately 28
bits each second, so if you wanted a really long accumulation (say a few hours), you’d have to use a block such
as the qdr_vacc or dram_vacc. As the name suggests, the simple_bram_vacc is simpler so it is fine for this demo
spectrometer. The FFT block demultiplexed frequency bins directly applied to the accumulator and memory blocks.
These streams are multiplexed in softawre using the tut_spec_byp.py script.
PARAMETERS
INPUTS/OUTPUTS
The simple bram blocks labelled mem1 to mem8 are used to store the accumulated signal. The address width of the
blocks is set at 8 to allow 256 (2^8) values to be stored in each of the eight blocks.
Software Registers
There are a few control registers, led blinkers, and snap block dotted around the design too:
• cnt_rst: Counter reset control. Pulse this high to reset all counters back to zero
• acc_len: Sets the accumulation length. Have a look in tut_spec_byp.py for usage
• sync_cnt: Sync pulse counter. Counts the number of sync pulses issued. Can be used to figure out board uptime
and confirm that your design is being clocked correctly
• acc_cnt: Accumulation counter. Keeps track of how many accumulations have been done
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• led0_sync: Back on topic: the led0_sync light flashes each time a sync pulse is generated. It lets you know your
SKARAB is alive
• led1_new_acc: This lights up led1 each time a new accumulation is triggered
• clr_bc: Generates a pulse necessary to arm the snapshot blocks in the design
There are some snap blocks, which capture data from the FPGA fabric and makes it accessible to the Power PC. This
tutorial doesn’t go into these blocks (in its current revision, at least), but if you have the inclination, have a look at
their documentation.
If you’ve made it to here, congratulations, go and get yourself a cup of tea and a biscuit, then come back for part two,
which explains the second part of the tutorial – actually getting the spectrometer running, and having a look at some
spectra.
Configuration and Control
Hardware Configuration
The tutorial comes with a pre-compiled fpg file, which is generated from the model you just went through
(tut_spec_byp.fpg). All communication and configuration will be done by the python control script called
tut_spec_byp.py.
Next, you need to set up your SKARAB as shown in the diagram below.

Switch it on, making sure that:
• Your tone source is set within the band of the ADC and is connected on channel 0 of the ADC. The ADC is
operated in DDC bypass bandwidth mode. The set tone source frequency should be observed on the spectrum
as is. In our setup, we set the tone frequency to 1.054 GHz.
• Make sure the 10MHz reference is connected up, otherwise the script will fail along the way.
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The tut_spec_byp.py spectrometer script
Once you’ve got that done, it’s time to run the script. If you’re in linux, browse to where the tut_spec_byp.py file is in
a terminal and at the prompt type
python tut_spec_byp.py <skarab IP or hostname> -l <accumulation length> -b <fpgfile
name>

˓→

replacing with the IP address of your SKARAB, is the number of accumulations, and with your fpgfile. You should
see a spectrum like this:

Take some time to inspect the tut_spec_byp.py script. It is quite long, but don’t be intimidated. Most of the script is
configuration for the ADC. The important lines begin after the #START OF MAIN comment. There, you will see
that the script
• Instantiates the casperfpga connection with the SKARAB
• Uploads the fpg file
• Sets the ADC
• Records ADC snapshots, interleaves them and writes to a file adcN_data.txt where N is 0..4
• Plots the spectral outputs of the memory blocks
2.1. Vivado
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Conclusion
If you have followed this tutorial faithfully, you should now know:
• What a spectrometer is and what the important parameters for astronomy are
• Which CASPER blocks you might want to use to make a spectrometer, and how to connect them up in Simulink
• How to connect to and control a SKARAB spectrometer using python scripting

2.1.10 Tutorial 5: SKARAB ADC Synchronous Data Acquisition
There are currently two versions of the SKARAB ADC tutorial available. Links and descriptions of each are given
below:
1. [Latest] SKARAB ADC Synchronous Data Acquisition
This is the latest version of the tutorial that uses the latest firmware and possible hardware configurations available.
This tutorial explains how a Simulink design can be created and controlled to perform synchronised ADC sampling
among the channels of one or more SKARAB ADC boards that are installed in one or more SKARAB systems.
2 [Previous] 2.8 GSPS, N-channel, Synchronous Data Acquisition
This is the previous version of the tutorial for users working with older versions of firmware and hardware configurations. This tutorial explains how to capture synchronised ADC sampled data from one or more SKARABS, each of
which is populated with a single SKARAB ADC board.
Tutorial 5 [latest]: SKARAB ADC Synchronous Data Acquisition
Introduction
This tutorial explains how a Simulink design can be created and controlled to perform synchronised ADC sampling
among the channels of one or more SKARAB ADC boards that are installed in one or more SKARAB systems. The
Simulink design is created using the CASPER Toolflow and the software control of the synchronised sampling is
performed using the casperfpga Python library.
SKARAB ADC Board Overview
The SKARAB ADC board has four analogue channels which can each be sampled at a maximum rate of 3 GSPS. The
sampling is either performed by two dual-channel TI ADC32RF80 ADC ICs or two dual-channel TI ADC32RF45
ADC ICs. The board also contains a PLL which locks to a reference clock to derive and provide sampling clocks to
the ADC ICs. Both the ADC32RF45 and ADC32RF80 include DDCs, but only the ADC32RF45 allows the DDCs to
be bypassed to provide the full bandwidth.
There are two different bandwidth modes in which the SKARAB ADC board can be used: “Bypass Mode” and “DDC
Mode”. The differences between these modes are summarised in the following table:
Note that other sampling frequencies are available using the PLL of the SKARAB ADC board and that other decimation factors are provided by the ADC ICs. Please contact Peralex Electronics for more information.
The SKARAB ADC board is available in three ordering variants. These ordering variants are summarised in the table
below:
Please contact Peralex Electronics for more information.
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SKARAB ADC Hardware Setup
It is possible to, not only perform synchronised sampling among the four channels of a single SKARAB ADC board,
but also to perform synchronised sampling among all the channels of multiple SKARAB ADC boards.
In cases where synchronised sampling among only four channels are required, a single SKARAB ADC board will
be installed in a SKARAB system. During operation, a synchronisation signal is sent from the Virtex-7 FPGA to a
SKARAB ADC board to allow synchronised sampling among the four channels.
In cases where synchronised sampling among more than four channels is required, one option is to install more
SKARAB ADC boards in a SKARAB system. In this case, the synchronistaion signal is daisy chained. Up to three
SKARAB ADC boards can be installed in a system. The first SKARAB ADC board in the chain is referred to as the
“Master” while the rest are referred to as the “Slaves”.
Another option to allow synchronised sampling among more than four channels is to use more than one SKARAB
system. This allows the number of SKARAB ADC boards in the hardware setup to extend beyond three. In this case,
the synchronisation signal is daisy chained from the SKARAB ADC board Master to the the rest of the SKARAB
ADC board Slaves among the SKARAB systems. Similarly, the SKARAB system containing the Master SKARAB
ADC board is referred to as the “Master”, while the remaining SKARAB systems are referred to as the “Slaves”. The
connections inside the SKARAB systems are made by Peralex Electronics while the connections outside will be made
by the user of the hardware setup. The user will also terminate the synchronisation signal at the last system with 50
Ohm.
As the number of channels that need to be synchronised increases (for example 80), the length of the daisy chained
synchronisation signal increases as well, and may become too long. In these cases, the SKARAB SYNC multiplier is
used.
Contact Peralex Electronics for more details of these, and potentially other, hardware setups.
SKARAB ADC Yellow Block
Overview
Each SKARAB ADC board installed in a SKARAB system needs a corresponding Yellow Block in a Simulink design
so that synchronised ADC sample data can be captured. There are two types of Yellow Blocks, namely: the DDC
Mode SKARAB ADC Yellow Block and the Bypass Mode SKARAB ADC Yellow Block. The DDC Mode SKARAB
ADC Yellow Block (named “skarab_adc4x3g_14” in the CASPER Toolflow) can be used along with any SKARAB
ADC board variant since they all support the DDC bandwidth mode. The Bypass Mode SKARAB ADC Yellow Block
(named “skarab_adc4x3g_14_byp” in the CASPER Toolflow) can only be used along with a SKARAB ADC board
that supports the Bypass bandwidth mode.
Master and Slaves
The clocking and synchronisation functions can only be performed by one of the SKARAB ADC Yellow Blocks in a
Simulink design. The SKARAB ADC Yellow Block that performs these functions are known as the “Master” while
the others are known as the “Slaves”. If only one SKARAB ADC Yellow Block is used in the Simulink design, it
needs to be set as the “Master”. If there are more than one SKARAB ADC Yellow Blocks in the design, one needs to
be set as the Master while the remaining ones are set as the Slaves. Also, if a SKARAB ADC board needs to be used
as a Master in a hardware setup, its corresponding SKARAB ADC Yellow Block needs to be set as the Master too.
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Description of DDC Mode SKARAB ADC Yellow Block (skarab_adc4x3g_14)
This Yellow Block provides four 16-bit I/Q sample pairs from each of the four channels of the SKARAB ADC board
as output (in parallel). For a 3 GSPS sampling frequency that is decimated by 4, the four sample pairs are provided at
a rate of 187.5 MSPS:
When decimated by 8, 16 or 32, the four sample pairs are provided at rates of 93.75, 46.875 or 23.4375 MSPS,
respectively.
The Yellow Block parameters are as follows:
• Mezzanine slot: Mezzanine slot (0 to 3) of the SKARAB where the SKARAB ADC board is installed.
• Master/Slave: The Master performs clocking (generates adc_clk) and synchronisation functions. There should
only be one Master SKARAB ADC Yellow Block in a Simulink design while the remaining (if any) need to be
Slaves.
• Decimation Modes: The two available options are “4, 8, 16” or “4, 8, 16, 32”. The decimate-by-32 mode
requires additional processing inside the FPGA which would consume unnecessary logic resources if it was not
required. Thus, an option was added to exclude it.
The Yellow Block outputs are as follows:
• adc0_data_i_out<X> (where X: 0 to 3): Four successive 16-bit I samples from channel 0
• adc0_data_q_out<X> (where X: 0 to 3): Four successive 16-bit Q samples from channel 0
• adc1_data_i_out<X> (where X: 0 to 3): Four successive 16-bit I samples from channel 1
• adc1_data_q_out<X> (where X: 0 to 3): Four successive 16-bit Q samples from channel 1
• adc2_data_i_out<X> (where X: 0 to 3): Four successive 16-bit I samples from channel 2
• adc2_data_q_out<X> (where X: 0 to 3): Four successive 16-bit Q samples from channel 2
• adc3_data_i_out<X> (where X: 0 to 3): Four successive 16-bit I samples from channel 3
• adc3_data_q_out<X> (where X: 0 to 3): Four successive 16-bit Q samples from channel 3
• adc0_data_val_out: Channel 0 sample data valid signal
• adc1_data_val_out: Channel 1 sample data valid signal
• adc2_data_val_out: Channel 2 sample data valid signal
• adc3_data_val_out: Channel 3 sample data valid signal
Description of Bypass Mode SKARAB ADC Yellow Block (skarab_adc4x3g_14_byp)
This Yellow Block provides sixteen 12-bit samples from each of the four channels of the SKARAB ADC board as
output (in parallel). For a 2.8 GSPS sampling frequency, the sixteen samples are provided at a rate of 175 MSPS:
The Yellow Block parameters are as follows:
• Mezzanine slot: Mezzanine slot (0 to 3) of the SKARAB where the SKARAB ADC board is installed.
• Master/Slave: The Master performs clocking (generates adc_clk) and synchronisation functions. There should
only be one Master SKARAB ADC Yellow Block in a Simulink design while the remaining (if any) need to be
Slaves.
The Yellow Block outputs are as follows:
• adc0_data_out<X> (where X: 0 to 15): Sixteen successive 12-bit samples from channel 0
• adc1_data_out<X> (where X: 0 to 15): Sixteen successive 12-bit samples from channel 1
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• adc2_data_out<X> (where X: 0 to 15): Sixteen successive 12-bit samples from channel 2
• adc3_data_out<X> (where X: 0 to 15): Sixteen successive 12-bit samples from channel 3
• adc0_data_val_out: Channel 0 sample data valid signal
• adc1_data_val_out: Channel 1 sample data valid signal
• adc2_data_val_out: Channel 2 sample data valid signal
• adc3_data_val_out: Channel 3 sample data valid signal
Simulink Design Clocking Considerations
Please note the User IP Clock source parameter of the SKARAB Yellow Block. Either sys_clk or adc_clk can be
selected to clock the User IP. The implications of choosing either clock source follows:
• adc_clk is a clock generated by a SKARAB ADC Yellow Block with a frequency that matches its output clock
rate. Its frequency is either 187.5 or 175 MHz depending on whether the DDC or Bypass Mode SKARAB
ADC Yellow Block is used, respectively. When using the Bypass Mode SKARAB ADC Yellow Block or the
DDC Mode SKARAB ADC Yellow Block in decimate-by-4 mode, the valid signals of the Yellow Blocks are
permanently asserted, and therefore does not need to be monitored after initial assertion. However, if the DDC
Mode SKARAB ADC Yellow Block is used in other (8, 16, 32) decimation modes, the decimated sample rate is
lower than 187.5 MHz, and the valid signals will need to be respected. Also, when using adc_clk, the Simulink
Design User IP will not be clocked until initialisation of the SKARAB ADC board along with its corresponding
SKARAB ADC Yellow Block.
• sys_clk is a free running clock which has no relation to the sampling rate of the SKARAB ADC board. By
necessity, the selected sys_clk frequency must be greater than the SKARAB ADC Yellow Block sample data
output rate. Thus, the user needs to respect the data valid signals of the SKARAB ADC Yellow Block on
subsequent processing blocks. This clocking scheme allows subsequent signal processing to run at a higher
clock rate than the SKARAB ADC Yellow Block data output rate. However, not all Yellow Blocks support
clock gating (data valid) signals. Also, an advantage of sys_clk is that the clocking of the Simulink Design User
IP is independent of the initialisation of any of the SKARAB ADC boards or their corresponding SKARAB
ADC Yellow Blocks.
Example Designs
The following example designs are provided to demonstrate synchronised ADC sampling in a hardware setup that
contains one or more SKARAB ADC boards (installed in a set of one or more SKARAB systems):
• Four Simulink design models, one of which will be used to create an fpg file to upload to each of the SKARAB
systems. The design model to use depends on the number of SKARAB ADC boards per SKARAB (one or two)
as well as the bandwidth mode in which they need to be used (DDC or Bypass).
• A Python test script (using the casperfpga library) which uploads the fpg file (created from any of the four
Simulink design models) to the SKARABs and then controls them to perform synchronised sampling. The
usage of this script is described in its comments.
• Two ADC data plotting Matlab scripts which overlays the captured ADC data from all sampled channels. The
usage of these scripts are described in their comments.
Each of the four Simulink design models consists of the following components:
• One or two SKARAB ADC Yellow Blocks used to perform synchronised sampling among several SKARAB
ADC boards (in DDC or Bypass mode).
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• Multiple Snapshot Yellow Blocks which are used to capture the ADC sample data recovered by the SKARAB
ADC Yellow Blocks.
• Several components which are used to provide a GbE and a 40 GbE interface to the design so that the design
can be controlled from the Python test script.
• The Xilinx System Generator, which is a plug-in to Simulink that enables designers to develop high-performance
DSP systems for Xilinx FPGAs such as the Virtex-7 FPGA on the SKARAB.
• The SKARAB Yellow Block, which is used to create the Simulink design for the SKARAB platform.
The user of the Simulink design needs to do the following before creating an fpg file from it:
• Set the Mezzanine Slot of each SKARAB ADC Yellow Block to indicate where its corresponding SKARAB
ADC board is installed.
• Set the User IP Clock Source of the design.
• If a DDC Mode SKARAB ADC Yellow Block is used in the design, set the decimation modes that should be
supported.
• Ensure that there is only one Master SKARAB ADC Yellow Block in the design.
The links to the Simulink design models are:
• Simulink design model with one DDC mode SKARAB ADC Yellow Block
• Simulink design model with one Bypass mode SKARAB ADC Yellow Block
• Simulink design model with two DDC mode SKARAB ADC Yellow Blocks
• Simulink design model with two Bypass mode SKARAB ADC Yellow Blocks
The link to the Python test script is:
• Python test script
The links to the ADC data plotting MATLAB scripts are:
• DDC mode ADC data plotting MATLAB script
• Bypass mode ADC data plotting MATLAB script
SKARAB ADC Firmware Version Requirements
A SKARAB ADC board needs to be programmed with firmware version 2.2 to be compatible with the latest casperfgpa
functions and the SKARAB ADC Yellow Blocks. The skarab_adc_reconfig.py Python script can be used to update the
SKARAB ADC board firmware to this version. Please read the comments in the header of this script for an explanation
of how to use it.
Two bin file variants of the SKARAB ADC firmware version 2.2 are provided: EMB124901U8R2_DDC.bin and
EMB124901U8R2_BYP.bin. The only difference between them is the default bandwidth mode in which they configure
the SKARAB ADC board on startup. EMB124901U8R2_DDC.bin configures it in DDC mode on startup, while
EMB124901U8R2_BYP.bin configures it in Bypass mode on startup. When only using a SKARAB ADC board in
a single bandwidth mode, the appropriate bin file can be chosen so that it is not required to configure the SKARAB
ADC board after startup using a casperfpga function.
The skarab_adc_reconfig.py Python script and the two bin files can be found here: SKARAB ADC FW
WARNING: Please ensure that the power and network connection to the SKARAB is stable before using this script.
There is a possibility that the SKARAB ADC board can be bricked if the firmware update process is interrupted by
a power or network failure. In this case, the SKARAB ADC board will need to be returned to Peralex Electronics so
that its firmware can be restored to a working state.
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CASPER Toolflow and casperfpga Library Requirements
Please install the following versions of the CASPER Toolflow and casperfpga library:
ska-sa devel branch of the CASPER Toolflow
ska-sa devel branch of the casperfpga library
Test Procedure
1. Open one of the provided Simulink design models and modify it as required (as described in the “Example
Designs” section)
2. Build an fpg file from the modified Simulink design model
3. Set up the hardware test configuration according to the information described in the “SKARAB ADC Hardware
Setup” section
4. Allow a DHCP or BOOTP server on the network to allocate IP addresses to the SKARABs. An example of the
IP address allocation is listed in the table below:
1. Power on the SKARAB Systems and confirm that their IP address allocation was successful (e.g. PING)
2. Read the Python test script comments and set the script configuration as required
3. Run the Python test script which will upload the created fpg file to the SKARAB systems, perform synchronised
ADC data sampling, and then write the sample data to text files
4. Run one of the ADC data plotting Matlab scripts to plot the captured ADC sample data from the text files
The design files and documentation for this tutorial were supplied by Peralex Electronics. However, please feel free,
as always, to contact the CASPER email list with questions/issues and we will do our best to help (or find someone
who can).
Tutorial 5 [previous]: 2.8 GSPS, N-channel, Synchronous Data Acquisition
Introduction
This tutorial explains how to capture synchronised ADC sampled data from one or more SKARABS, each of which
is populated with a single PI-12533.02G SKARAB ADC32RF45X2 Mezzanine Module. In this tutorial, the internal
DDCs of the ADC32RF45 dual ADCs are bypassed.
The PI-12533.02G SKARAB ADC32RF45X2 Mezzanine Module contains four ADCs which by default sample at 2.8
GSPS (other sample rates are possible using the on-board sample rate generator).
This tutorial comes with the following:
• A Simulink design model, from which an fpg file will be created.
• A Python test script (which uses the casperfpga library) to upload the fpg file to the SKARABs and then control
them to perform synchronized sampling.
• An ADC data plotting Matlab script which overlays the captured ADC data from all sampled channels.
The directories for these files can be accessed via the following links:
• Simulink design model
• Python test script
• ADC data plotting script
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Simulink Design Overview
The Simulink design consists of the following:
• The SKARAB_ADC4X3G14_BYP Yellow Block which is used to synchronise a SKARAB ADC32RF45X2
Mezzanine Module to others and to recover synchronized ADC sample data from it.
• Multiple Snapshot Yellow Blocks which are used to capture the ADC sample data recovered by the
SKARAB_ADC4X3G14_BYP Yellow Block.
• Several components which are used to provide a GbE and a 40 GbE interface to the design so that the design
can be controlled from the Python test script.
• The Xilinx System Generator, which is a plug-in to Simulink that enables designers to develop high-performance
DSP systems for Xilinx FPGAs such as the Virtex 7 FPGA on the SKARAB.
• The SKARAB Yellow Block, which is used to create the Simulink design for the SKARAB platform.
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SKARAB_ADC4X3G14_BYP Yellow Block Description
The SKARAB_ADC4X3G14_BYP provides sixteen 12-bit samples from each of the four ADCs of the module in
parallel as output. For a 2.8 GSPS sampling frequency, the sixteen samples are provided at a rate of 175 (2800/16)
MSPS from the Yellow Block.
The SKARAB_ADC4X3G14_BYP Yellow Block parameters are as follows:
• Mezzanine slot: Mezzanine slot (0 to 3) of the SKARAB where the SKARAB ADC32RF45X2 Mezzanine
Module is installed.
• Clock Master/Slave: Determines if the Yellow Block is generating the “adc_clk” or not. If only one
SKARAB_ADC4X3G14_BYP Yellow Block is used in the Simulink design, this should be set to “Master”.
If more than one is used in the design, the parameter of one should be set to “Master” while the parameter of the
rest should be set to “Slave”.
The SKARAB_ADC4X3G14_BYP Yellow Block outputs are as follows:
• adc0_data_out<X> (where X: 0 to 15): Sixteen successive 12-bit samples from ADC 0
• adc1_data_out<X> (where X: 0 to 15): Sixteen successive 12-bit samples from ADC 1
• adc2_data_out<X> (where X: 0 to 15): Sixteen successive 12-bit samples from ADC 2
• adc3_data_out<X> (where X: 0 to 15): Sixteen successive 12-bit samples from ADC 3
• adc0_data_val_out: ADC 0 sample data valid signal
• adc1_data_val_out: ADC 1 sample data valid signal
• adc2_data_val_out: ADC 2 sample data valid signal
• adc3_data_val_out: ADC 3 sample data valid signal
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SKARAB Yellow Block Clocking
Please note the User IP Clock source parameter of the SKARAB Yellow Block. In this Simulink design example, either
sys_clk or adc_clk can be selected to clock the User IP. The implications of choosing either clock source follows:
• adc_clk is a clock generated by the SKARAB_ADC4X3G14_BYP Yellow Block with a frequency that matches
its output clock rate of 175 MHz when operating at a 2.8 GSPS sample rate ([2.8 GSPS]/[16 samples per
output clock cycle]=175 MHz). As a result the valid signal of SKARAB_ADC4X3G14_BYP Yellow Block is
permanently asserted, and therefore does not need to be monitored after initial assertion.
• sys_clk is a free running clock which has no relation to the sampling rate of the ADCs. By necessity, the
selected sys_clk frequency must be greater than the SKARAB_ADC4X3G14_BYP Yellow Block’s output
clock rate of 175 MHz. The sixteen output samples are then being generated at a lower clock rate (175
MHz) than the user clock rate (sys_clk). As a result, the user needs to respect the data valid signal of the
SKARAB_ADC4X3G14_BYP Yellow Block on subsequent processing blocks. This clocking scheme allows
subsequent signal processing to run at a higher clock rate than the SKARAB_ADC4X3G14_BYP Yellow Block
output clock rate. However, not all Yellow Blocks support clock gating (data valid) signals.

Usage Instructions
1. Create an fpg file from the provided Simulink design.
2. Set
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3. Allow a DHCP or BOOTP server on the network to allocate IP addresses to the SKARABs. Example:

4. Power on the SKARABs and confirm that their IP address allocation was successful (e.g. PING).
5. Edit the Python test script configuration (under the section “1. SCRIPT CONFIG”) to point to the created fpg
file, specify the allocated IPs of the SKARABs, etc.
6. Run the Python test script which will upload the created fpg file to them, perform synchronised ADC data
sampling, and then write the sample data to text files.
7. Run the ADC data plotting script to plot the captured ADC sample data from the text files.
The design files and documentation for this tutorial were supplied by Peralex. However, please feel free, as always, to
contact the CASPER email list with questions/issues and we will do our best to help (or find someone who can).
Red Pitaya
1. Guide to Setting Up Your New Red Pitaya
2. Introduction Tutorial Step-by-Step or Completed
3. ADC and DAC Interface Tutorial Step-by-Step or Completed
4. Spectrometer Tutorial Step-by-Step or Completed
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2.1.11 Guide to Setting Up Your New Red Pitaya
This guide will show you how to setup your Red Pitaya (RP) for use with the casper tools - mlib_devel and
casperfpga.
Setting up the Red Pitaya involves installing and building a few things through script commands on the Red Pitaya OS.
If you need to install a blank SD card with the Red Pitaya OS please follow the setup instructions on the Red Pitaya
site here, otherwise use the SD card that came supplied with the hardware.
Running the script on a preloaded RP SD Card
• This will not affect the running of the native RP software, they run happily side-by-side
• Insert your SD card and boot the RP, ensuring that the RP is connected to your Ethernet network
• SSH into the RP using the hostname printed on the Ethernet port of the board (default user:root password:root)
• Run the following script on the RP:
# make sure /etc/hosts exists
touch /etc/hosts
# make sure localhost is in /etc/hosts (required by tcpborphserver3)
grep -q localhost /etc/hosts || echo "127.0.0.1 localhost" >> /etc/hosts
# install git
apt-get install git
# clone katcp
git clone https://github.com/ska-sa/katcp.git
# build katcp
cd katcp
make all
# copy executables to /bin
cp cmd/kcpcmd /bin/
cp fpg/kcpfpg /bin/
cp tcpborphserver3/tcpborphserver3 /bin/
# create startup service file
echo "Description=TCPBorphServer allows programming and communication with the FPGA
Wants=network.target
After=syslog.target network-online.target
[Service]
Type=simple
ExecStart=/bin/tcpborphserver3
Restart=on-failure
RestartSec=10
KillMode=process
[Install]
WantedBy=multi-user.target" > /etc/systemd/system/tcpborphserver.service
# reload services
systemctl daemon-reload
# enable the service
systemctl enable tcpborphserver
# start the service
systemctl start tcpborphserver
# check the status of your service
systemctl status tcpborphserver

• This will install git on the RP, clone and build tcpborphserver (a server designed to control and speak to CASPER
hardware using KATCP) and then set it to run on startup.
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• Your RP is now casperized and you can communicate with it via casperfpga. For details on installing
casperfpga, please see here.

2.1.12 Tutorial 1: Introduction to Simulink
In this tutorial, you will create a simple Simulink design using both standard Xilinx system generator blockset, as well
as library blocks specific to CASPER boards (so-called “Yellow Blocks”). At the end of this tutorial you will know:
• How to generate an fpg file,
• Program it to a CASPER FPGA board (specifically the Red Pitaya), and
• Interact with your running hardware design using casperfpga via an interactive Python Interface.
Creating Your Design
Create a New Model
Start MATLAB via executing the startsg command, as described here. This ensures that necessary Xilinx and CASPER
libraries are loaded into development environment by Simulink. When MATLAB starts up, open Simulink by typing
simulink on the MATLAB command line. Start a new model, and save it with an appropriate name. With Simulink,
it is very wise to save early and often.
There are some Matlab limitations you should be aware-of right from the start:
• Do not use spaces in your filenames or anywhere in the file path as it will break the toolflow.
• Do not use capital letters in your filenames or anywhere in the file path as it will break the toolflow.
• Beware block paths that exceed 64 characters. This refers to not only the file path, but also the path to any
block within your design.
– For example, if you save a model file with a name ~/some_really_long_filename.slx, and have a block
called in a submodule the longest block path would be: some_really_long_filename_submodule_block.
– If you use lots of subsystems, this can cause problems.
Library organization
There are three libraries which you will use when you design firmware in Simulink. More information on the toolflow
itself can be found here.
1. The CASPER XPS Library contains “Yellow Blocks” – these are blocks which encapsulate interfaces to hardware (ADCs, Memory chips, CPUs, Ethernet ports, etc.)
2. The CASPER DSP Library contains (mostly green) blocks which implement DSP functions such as filters,
FFTs, etc.
3. The Xilinx Library contains blue blocks which provide low-level functionality such as multiplexing, delaying, adding, etc. The Xilinx library also contains the super-special System Generator block, which contains
information about the type of FPGA you are targeting.
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Add Xilinx System Generator and XSG core config blocks
Add a System generator block from the Xilinx library by locating the Xilinx Blockset library’s Basic Elements subsection and dragging a System Generator token onto your new file.

xilinx_select_sysg
Do not configure it directly, but rather add a platform block representing the system you care compiling for. These can
be found in the CASPER XPS System Blockset library. For Red Pitaya (and later) platforms, you need a block which
matches the platform name, which can be found in the library under “platforms”, as shown below.
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casper_xps_select_
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casper_xps_select_
Double click on the platform block that you just added. The Hardware Platform parameter should match the platform
you are compiling for. Once you have selected a board you need to choose its clock source. The Red Pitaya Platform
Yellow Block has default parameters which do not need to be changed for this tutorial. However, a good rule of thumb
for designs including ADCs, you probably want the FPGA clock to be derived from the sampling clock.
The configuration Yellow Block knows what FPGA corresponds to which platform and will automatically configure
the System Generator block which you previously added.
The System Generator and XPS Config blocks are required by all CASPER designs
Flashing LED
To demonstrate the basic use of hardware interfaces we will make an LED flash. With the FPGA running at ~100MHz
(or greater), the most significant bit (MSB) of a 27 bit counter will toggle approximately every 0.67 seconds. We can
output this bit to an LED on your board. Most (all?) CASPER platforms have at least four LEDs, with the exact
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configuration depending on the board. We will make a small circuit connecting the top bit of a 27 bit counter to one
of these LEDs. When compiled this will make the LED flash with a 50% duty cycle approximately once a second.
Add a counter
Add a counter to your design by navigating to Xilinx Blockset -> Basic Elements -> Counter and dragging it onto your
model.

xilinx_select_counter.png
Double-click it and set it for free running, 27 bits, unsigned. This means it will count from 0 to 2^27 - 1, and will then
wrap back to zero and continue.
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Add a slice block to select out the msb
We now need to select the most significant bit (msb) of the counter. We do this using a slice block, which Xilinx
provides. Xilinx Blockset -> Basic Elements -> Slice.

Slice_select.png
Double-click on the newly-added slice block. There are multiple ways to select which bit(s) you want. In this case, it
is simplest to index from the upper end and select the first bit. If you wanted the least significant bit (LSB), you can
also index from that position. You can either select the width and offset, or two bit locations.
Set it for 1 bit wide with offset from top bit at zero. As you might guess, this will take the 27-bit input signal, and
output just the top bit.
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Add a GPIO block
From: CASPER XPS library -> gpio.
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casper_xps_select_

casper_xps_select_
In order to send the 1-bit signal you have sliced off to an LED, you need to connect it to the right FPGA output pin.
To do this you can use a GPIO (general-purpose input/output) block from the XPS library, this allows you to route a
signal from Simulink to a selection of FPGA pins, which are addressed with user-friendly names. Set it to use Red
Pitaya’s LED bank as output. Once you’ve chosen the LED bank, you need to pick which LED you want to output to.
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Set the GPIO bit index to 0 (the first LED) and the data type to Boolean with bitwidth 1. This means your simulink
input is a 1 bit Boolean, and the output is LED0.
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Add a terminator
To prevent warnings (from MATLAB & Simulink) about unconnected outputs, terminate all unused outputs using a
Terminator:

From: Simulink -> Sinks -> Terminator
You can also use the Matlab function XlAddTerms, run in the MATLAB prompt, to automatically terminate your
unused outputs.
Connect your design
It is a good idea to rename your blocks to something more sensible, like counter_led instead of just counter. Do this
simply by double-clicking on the name of the block and editing the text appropriately.
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To connect the blocks simply click and drag from the ‘output arrow’ on one block and drag it to the ‘input arrow’ of
another block. Connect the blocks together: Counter -> Slice -> gpio as showing in digram below.

Remember to save your design often.
Software control
To demonstrate the use of software registers to control the FPGA from a computer, we will add registers so that the
counter in our design can be started, stopped, and reset from software. We will also add a register so that we can
monitor the counter’s current value too. By the end of this section you will create a system that looks like this:

Slice_circuit.png
Add the software registers
We need two software registers:
1. To control the counter, and
2. To read its current value.
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casper_xps_select_memory_swreg.png
Set the I/O direction to From Processor on the first one (counter_ctrl) to enable a value to be set from software and
sent to your FPGA design. Set it to To Processor on the second one (counter_value) to enable a value to be sent from
the FPGA to software. Set both registers to a bitwidth of 32 bits.
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Rename the registers to something sensible, the names you give them here are the names you will use to access
them from software. Do not use spaces, slashes and other special characters in these. Perhaps counter_ctrl and
counter_value to represent the control and output registers respectively.
Also note that the software registers have sim_reg and sim_out ports. The input port provides a means of simulating
this register’s value (as would be set by the runtime software) using the sim_reg line. The output port provides a means
to simulate this register’s current FPGA-assigned value.
For now, set the sim_reg port to constant one using a Simulink-type constant. This can be found in Simulink ->
Sources, and will enable the counter during simulations.

During simulation we can monitor the counter’s value using a scope (Simulink -> Sinks):
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Here is a good point to note that all blocks from the Simulink library are usually white in colour, and will not be
compiled into hardware. i.e. They are present for simulation only. Xilinx blocks are usually blue in colour with the
Xilinx logo, and will be compiled to hardware.
You need to use gateway blocks whenever connecting a Simulink-provided block (like a scope or sine-wave generator)
to and from a Xilinx block. This will sample and quantize the Simulink signals so that they are compatible with the
Xilinx world. Some blocks (like the software register) provide a gateway internally, so you can feed the input of a
software register with a Xilinx signal, and monitor its output with a Simulink scope. However, in general, you must
manually insert these gateways where appropriate. Simulink will issue warnings for any direct connections between
the Simulink and Xilinx domains.
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Add the counter
You can do this either by copying your existing counter block (copy-paste, or ctrl-click-drag-drop) or by placing a new
one from the library. Configure it with a reset and enable port as follows:
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Add the slice blocks
Now we need some way to control the enable and reset ports of the counter. We could do this using two separate
software registers, but this is wasteful since each register is 32 bits anyway.
So we’ll use a single register and slice out one bit for enabling the counter, and another bit for resetting it. Either copy
your existing slice block (copy-paste it or hold ctrl while dragging/dropping it) or add two more from the library.
The enable and reset ports of the counter require boolean values (which Simulink interprets differently from ordinary
1-bit unsigned numbers). Configure the slices as follows:
Slice for enable:

casper_xps_param
Slice for reset:
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casper_xps_param
Connect it all up
Now we need to connect all these blocks together. To neaten things up, consider resizing the slice blocks and hiding
their names. Their function is clear enough from their icon without needing to see their names.
Do so by right-clicking and unchecking Format → Show Block Name. You could do this with the counter too, but it’s
not a good idea with the software registers, because otherwise you wouldn’t know how to address them when looking
at your diagram.
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Adder
To demonstrate some simple mathematical operations, we will create an adder. It will add two numbers on demand and
output the result to another software register. Almost all astronomy DSP is done using fixed-point (integer) notation,
and this adder will be no different.
We will calculate a+b = sum_a_b.
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Add the software registers
Add two more input software registers. These will allow us to specify the two numbers to add. Add another output
register for the sum output.
Either copy your existing software register blocks (copy-paste or holding ctrl while dragging/dropping it) or add three
more from the library. Set the I/O direction to From Processor on the first two and set it to To Processor on the third
one.
Add the adder block
Locate the adder/subtractor block, Xilinx Blockset -> Math -> AddSub and drag one onto your design. This block can
optionally perform addition or subtraction. Let’s leave it set at it’s default, for addition.
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The output register is 32 bits. If we add two 32 bit numbers, we will have 33 bits.
There are a number of ways of fixing this:
• limit the input bitwidth(s) with slice blocks
• limit the output bitwidth with slice blocks
• create a 32 bit adder.
Since you have already seen slice blocks demonstrated, let’s try to set the AddSub block to be a 32 bit saturating adder.
On the second tab, set it for user-defined precision, unsigned 32 bits.
Also, under overflow, set it to saturate. Now if we add two very large numbers, it will simply return 2^32 -1.
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Add the scope and simulation inputs
Either copy your existing scope and simulation constants (copy-paste or ctrl-drag) or place a new one from the library
as before. Set the values of the simulation inputs to anything you like.
Connect it all together
Like this:
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Simulating
The design can be simulated with clock-for-clock accuracy directly from within Simulink. Set the number of clock
cycles that you’d like to simulate and press the play button in the top toolbar.

You can watch the simulation progress in the status bar in the bottom right. It will complete in the blink of an eye for
this small design with just 10 clock cycles.
You can double-click on the scopes to see what the signals look like on those lines. For example, the one connected to
the counter should look like this:

The one connected to your adder should return a constant, equal to the sum of the two numbers you entered. You
might have to press the Autoscale button to scale the scope appropriately.
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Once you have verified that that design functions as you’d like, you’re ready to compile for the FPGA. . .
Compiling
Essentially, you have constructed three completely separate little instruments.
1. You have a flashing LED,
2. A counter which you can start/stop/reset from software, and
3. A simple adder.
These components are all clocked off the same clock source specified in your platform’s properties, but they will
operate independently.
In order to compile this to an FPGA bitstream, execute the following command in the MATLAB Command Line
window. THIS COMMAND DEPENDS WHICH PLATFORM YOU ARE TARGETING:
>>

jasper

This will run the complete build process, which consists of two stages. The first involving Xilinx’s System Generator,
which compiles any Xilinx blocks in your Simulink design to a circuit which can be implemented on your FPGA.
While System Generator is running, you should see the following window pop up:
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After this, the second stage involves synthesis of your design through Vivado, which goes about turning your design
into a physical implementation and figuring out where to put the resulting components and signals on your FPGA.
Finally the toolflow will create the final output fpg file that you will use to program your FPGA. This file contains
the bitstream (the FPGA configuration information) as well as meta-data describing what registers and other Yellow
Blocks are in your design. This file will be created in the ‘outputs’ folder in the working directory of your Simulink
model. Note: Compile time is approximately 15-20 minutes.
$ cd red_pitaya/tut_intro/red_pitaya_tut_intro/outputs/
$ ls
red_pitaya_tut_intro-<datetime>.fpg red_pitaya_tut_intro-<datetime>.bof

Advanced Compiling
Once you are familiar with the CASPER toolflow, you might find you want to run the two stages of the compile
separately. This means that MATLAB will become usable sooner, since it won’t be locked up by the second stage of
the compile. If you want to do this, you can run the first stage of the compile from the MATLAB prompt with
>> jasper_frontend

After this is completed, the last message printed will tell you how to finish the compile. It will look something like:
$ python /path_to/mlib_devel/jasper_library/exec_flow.py -m /home/user/path_to/red_
˓→pitaya/tut_intro/red_pitaya_tut_intro.slx --middleware --backend --software

You can run this command in a separate terminal after navigating to the tutorials_devel/vivado_2018/
directory and sourcing appropriate environment variables.
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$ source startsg.local.hpw2019
$ source startsg
$ python /path_to/mlib_devel/jasper_library/exec_flow.py -m /home/user/path_to/red_
˓→pitaya/tut_intro/red_pitaya_tut_intro.slx --middleware --backend --software

Programming the FPGA
Reconfiguration of CASPER FPGA boards is achieved using the casperfpga python library, created by the SA-SKA
group.
Getting the required packages
These are pre-installed on the server in the workshop and you do not need to do any further configuration. However,
should you want to run these tutorials on your own machines, you should download the latest casperfpga libraries from
here.
Copy your .fpg file to your Server
Navigate to the outputs folder (eg red_pitaya/tut_intro/red_pitaya_tut_intro/outputs/) and (secure)copy this across to
a test folder on the workshop server. Instructions to do this are available here. If you are running the tutorial on your
own machine, with the Red Pitaya connected directly to your machine, you do not need to complete this step.
Connecting to the board
SSH into the server that the Red Pitaya board is connected to and navigate to the folder in which your .fpg file is stored.
Once again, running this tutorial with the Red Pitaya connected directly to your machine means you do not need to
complete this step and can complete the following from the outputs folder on your own machine (provided you have
installed casperfpga).
Start interactive python by running:
$ ipython

Now import the fpga control library. This will automatically pull-in the KATCP library and any other required communications libraries.
import casperfpga

To connect to the board we create a CasperFpga instance; let’s call it fpga. The CasperFpga constructor requires just
one argument: the IP hostname or address of your FPGA board.
fpga = casperfpga.CasperFpga('red_pitaya_hostname or ip_address')

The first thing we do is program the FPGA with the .fpg file which your compile generated.
fpga.upload_to_ram_and_program('<your_fpgfile.fpg>')

Should the execution of this command return true, you can safely assume the FPGA is now configured with your
design. You should see the LED on your board flashing. Go check! All the available/configured registers can be
displayed using: fpga.listdev(). The adder and counter can be controlled by writing to and reading from
registers added in the design using:
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fpga.write_int('a',10)
fpga.write_int('b',20)
fpga.read_int('sum_a_b')

With any luck, the sum returned by the FPGA should be correct.
You can also try writing to the counter control registers in your design. You should find that with appropriate manipulation of the control register, you can make the counter start, stop, and return to zero.
fpga.write_int('counter_ctrl', 1)
fpga.read_uint('counter_value')

Conclusion
This concludes the first CASPER Tutorial. You have learned how to construct a simple Simulink design, program an
FPGA board and interact with it with Python using casperfpga. Congratulations!
While the design you made might not be very complicated, you now have the basic skills required to build more
complex designs which are covered in later tutorials.

2.1.13 Tutorial 2 : ADC and DAC Interface
AUTHORS: A. Isaacson
EXPECTED TIME: 2-4 hours
Introduction
In this tutorial, you will create a simple Simulink design which interfaces to both the dual channel ADC and interleaved
DAC that are utilised on the Red Pitaya 125-10 boards - refer to Red Pitaya Docs: ReadtheDocs and Red Pitaya Docs:
Github for more information. In addition, we will learn to control the design remotely, using a supplied Python library
for KATCP.
In this tutorial, the user will be able to input a source sinusoidal signal from the signal generator on either channel 1
or channel 2 of the ADC input and be able to monitor these signals on the channel 1 and channel 2 DAC outputs using
an oscilloscope. The user will be able to change the frequency and amplitude of the signal generator and notice the
expected change on the oscilloscope if the Simulink design is connected correctly, as explained below. The user can
verify the ADC digital data by using a logic analyser configured to read signed data and/or Simulink snap shots, which
can be used to capture the ADC data. The python scripts can be utilised to read back this captured data and there are
matlab scripts which can be utilised to display this data. The user will also be able to see what happens to the ADC
and DAC data when the Digital Signal Processing (DSP) clock is increased from 125MHz to 200MHz.
Required Equipment
The following equipment is required:
1. Oscilloscope, 50MHz, +/-2Vpp, Qty 1
2. Signal Generator, 1MHz-50MHz, +/-2Vpp, Qty 1
3. Logic Analyzer, 1GSps, 2 pods with fly leads, Qty 1
4. SMA Cables, Male to Male, Qty 2
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Background
The Red Pitaya 125-10 board consists of a dual channel 10 bit ADC and DAC - refer to Red Pitaya Docs: ReadtheDocs
and Red Pitaya Docs: Github for more information on the Red Pitaya. There are currently two versions of the Red
Pitaya (125-10 and the 125-14) - refer to Red Pitaya Hardware Comparison for differences between the boards.
The Red Pitaya 125-10 is fitted with a single Analog Devices dual channel ADC AD9608 device. The ADC samples
at 125MSPS and each digital ADC output channel is 10 bits wide, 1.8V LVCMOS. Refer to Red Pitaya Docs: Github
for the schematics of the 125-10. The ADC output is offset binary and converted to two’s complement in the firmware
running on the Zynq programmable logic (PL).
The Red Pitaya 125-10 is fitted with a single Analog Devices dual channel DAC AD9767 device. The DAC digital
input is offset binary, 10 bits, LVCMOS 3.3V and is converted from two’s complement inside the firmware running on
the Zynq programmable logic. The second channel of the DAC is not connected, which means the DAC is utilised in
the interleave mode - refer to DAC data sheet Red Pitaya Docs: Github.
Feel free to spend some time reading the data sheets and looking at the schematics. This will be important for the
bonus challenge at the end of the tutorial. Please note that the previous bonus challenge for the Red Pitaya 125-14
board has already been integrated into the toolflow.
Create a new model
Start Matlab and open Simulink (either by typing ‘simulink’ on the Matlab command line, or by clicking on the
Simulink icon in the taskbar). A template is provided for this tutorial with a pre-created firmware flashing LED
function and Red Pitaya XSG core config or platform block and Xilinx System Generator block. Get a copy of this
template and save it. Make sure the Red Pitaya XSG_core_config_block or platform block is configured for:
1. Hardware Platform: “RED_PITAYA_10:xc7z010” for the 10 bit board or “RED_PITAYA_14:xc7z010” for the
14 bit board
2. User IP Clock source: “sys_clk”
3. User IP Clock Rate (MHz): 125 (125MHz clock derived from 125MHz ADC on-board clock). This clock
domain is used for the Simulink design
The rest of the settings can be left as is. Click OK.
Add Reset logic
A very important piece of logic to consider when designing your system is how, when and what happens during reset.
In this example we shall control our resets via a software register. We shall have one reset to reset the Simulink design
counters and trigger the data capture snap blocks. Construct reset and control circuitry as shown below.
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Add a software register
Use a software register yellow block from the CASPER XPS Blockset -> Memory for the reg_cntrl block. Rename
it to reg_cntrl. Configure the I/O direction to be From Processor. Attach one Constant block from the Simulink ->
Sources section of the Simulink Library Browser to the input of the software register and make the value 0 as shown
above.
Add Goto Block
Add one Goto block from Simulink -> Signal Routing. Configure them to have the tags as shown (rst_cntrl). These
tags will be used by associated From (also found in Simulink -> Signal Routing) blocks in other parts of the design.
These help to reduce clutter in your design and are useful for control signals that are routed to many destinations. They
should not be used a lot for data signals as it reduces the ease with which data flow can be seen through the system.
Add Edge_Detect block
Add From blocks from Simulink -> Signal Routing rst_cntrl should go through an edge_detect block (rising and
active high) to create a pulsed rst signal, which is used to trigger and reset the counters in the design. This is located
in CASPER DSP Blockset -> Misc. Add Goto block rst from Simulink -> Signal Routing.
It should look as follows when you have added all the relevant registers:
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Add ADC and associated registers and gpio for debugging
We will now add the ADC yellow block in order to interface with the ADC device on the Red Pitaya.
Add the ADC yellow block for digital to analog interfacing
Add a Red Pitaya ADC yellow block from the CASPER XPS Blockset -> ADCs, as shown below. It will be used to
interface to the ADC device on the Red Pitaya. Rename it to adc. Double click on the block to configure it and set the
number of bits to be 10 bits wide. This will need to be changed for the 14 bit Red Pitaya board.
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Add the From block as shown below, which connects the reset to the ADC yellow block.
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Add registers and gpio to provide ADC debugging
Add one yellow-block software register to provide an ADC sample counter (32 bits). Name it as shown below. The
register should be configured to send its value to the processor. Connect them to the ADC yellow block as shown
below. Delay blocks are added through the design to show the different types of Xilinx Simulink blocks that are
available, but they are not really needed - you will find these under Xilinx Blockset -> Basic Elements in the Simulink
Library Browser.

In the event that you will be using the logic analyser, you will need to route the ADC data (channel 1) to the Logic
Analyser connector (E1) on the Red Pitaya. In order to do this you will need to add two gpio yellow-blocks from
CASPER XPS Blockset -> IO. The first GPIO is for the ADC data valid and the second GPIO yellow block is for the
ADC channel 1 10 bit data. It should be connected as shown below for the first gpio for the ADC data valid:
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It should be connected as shown below for the second gpio for the ADC 10 bit data on channel 1:
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You will now be able to monitor the ADC data using the logic analyser connected to E1 on the Red Pitaya - refer to
125-10 schematics Red Pitaya Docs: Github.
Add DAC
We will now add the DAC yellow block in order to interface with the DAC device on the Red Pitaya.
Add the DAC yellow block for digital to analog interfacing
Add a Red Pitaya DAC yellow block from the CASPER XPS Blockset -> DACs, as shown below. It will be used to
interface to the DAC device on the Red Pitaya. Rename it to dac. Double click on the block to configure it and set the
number of bits to be 10 bits wide. This will need to be changed for the 14 bit Red Pitaya board. Add the From block,
which connects the reset to the DAC yellow block and connect the ADC to the DAC as shown below.
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The ADC and DAC functionality is now implemented in your Simulink design. It is now time to setup the ADC data
capturing snap shot blocks.
Buffers to capture ADC Data Valid, ADC Channel 1 and ADC Channel 2
The ADC data valid, ADC data channel 1 and ADC data channel 2 (output) need to be connected to a bitfield snapshot
block for data capture analysis (located in CASPER DSP Blockset -> Scopes), as shown below. Using this block, we
can capture 1024 ADC samples, read it back and store them as files. These files can then be plotted using a Matlab
script and analysed.
Bitfield snapshot blocks are a standard way of capturing snapshots of data in the CASPER tool-set. A bitfield snap
block contains a single shared BRAM allowing capture of 32-bit words.
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The ctrl register in a snap block allows control of the capture. The least significant bit enables the capture. Writing a
rising edge to this bit primes the snap block for capture. The 2nd least most significant bit allows the choice of a trigger
source. The trigger can come from an external source or be internal and immediately. The 3rd most least significant
bit allows you to choose the source of the valid signal associated with the data. This may also be supplied externally
or be immediately enabled.
The basic principle of the snap block is that it is primed by the user and then waits for a trigger at which point it
captures a block of data and then waits to be primed again. Once primed the addr output register returns an address
of 0 and will increment as data is written into the BRAMs. Upon completion the addr register will contain the final
address. Reading this value will show that the capture has completed and the results may be extracted from the shared
BRAMs.
In the case of this tutorial, the arming and triggering is done via software. The trigger is the rst signal. The “we” signal
on the snapshot blocks is the ADC data valid signal. Configure and connect the snap blocks as shown above. The
delay is not really necessary, but if your data was not aligned then you could use delays for this. The following settings
should be used for the bitfield snapshot blocks: storage medium should be BRAM, number of samples (“2^?”) should
be 10, Data width 32, all boxes unchecked except “use DSP48s to implement counters”, Pre-snapshot delay should be
0.
You should now have a complete Simulink design. Compare it with the complete ADC and DAC interface tutorial
*.slx model provided to you before continuing if unsure.
Compilation
Press CTRL+D to compile the tutorial first and make sure there are no errors before compiling. If there are any errors
then a diagnostic window will pop up and the errors can be addressed individually.
It is now time to compile your design into an FPGA bitstream. This is explained below, but you can also refer to
the Jasper How To document for compiling your toolflow design. This can be found in the ReadtheDocs mlib_devel
documentation link:
https://casper-toolflow.readthedocs.io
In order to compile this to an FPGA bitstream, execute the following command in the MATLAB Command Line
window:
jasper_frontend

This will enable Vivado’s system generator to be run, and the windows below should pop up with the name of your
slx file in the window instead of tut_1. The same applies below in the output file path - tut_1 will be replaced with the
name of your slx file. In my case it is “tut_adc_dac”.
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The next step is to open a terminal session (ctrl+T) and change directory to where your git clone of the tutorials_devel
is located “../tutorials_devel/vivado_2018/red_pitaya” and source the “startsg startsg.local” script as shown below:

The next step is to cut the python text from the bottom of the MATLAB Command Line Window and paste it into your
terminal and press enter. It should look as follows:

This will run the process to generate the FPGA bitstream and output Vivado compile messages to the terminal along
the way.
Execution of this command will result in an output .bof and .fpg file in the ‘outputs’ folder in the working directory
of your Simulink model. Note: Compile time is approximately 10-15 minutes, so a pre-compiled binary (.fpg file) is
made available to save time.
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Programming the FPGA (Zynq PL)
Reconfiguration of the Red Pitaya’s Zynq is done via the casperfpga python library. The casperfpga package for
python, created by the SA-SKA group, wraps the Telnet commands in python. and is commonly used in the CASPER
community. We will focus on programming and interacting with the Programmable Logic (PL) of the Zynq using this
method.
Getting the required packages
These are pre-installed on the server in the workshop and you do not need to do any further configuration, but if you
are not working from the lab then refer to the How To Setup CasperFpga Python Packages document for setting up
the python libraries for casperfpga. This can be found in the “casperfpga” github repo located on GitHub and the
ReadtheDocs casperfpga documentation link:
https://github.com/casper-astro/casperfpga
https://casper-toolflow.readthedocs.io
Copy your .fpg file to your NFS server
As per the previous figure, navigate to the outputs folder and (secure)copy this across to a test folder on the workshop
server.
scp path_to/your/model_folder/your_model_name/outputs/your_fpgfile.fpg user@server:/
˓→path/to/test/folder/

Connecting to the board
SSH into the server that the Red Pitaya is connected to and navigate to the folder in which your .fpg file is stored.
Start interactive python by running:
ipython

Now import the Zynq control library. This will automatically pull-in the KATCP library and any other required
communications libraries.
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import casperfpga

To connect to the Red Pitaya we create an instance of the Red Pitaya board; let’s call it rp. The wrapper’s fpgaclient
initiator requires just one argument: the IP hostname or address of the Red Pitaya board. The hostname of the Red
Pitaya board can be found by looking at the top of Red Pitaya Ethernet connector e.g. RP-f0495e.local is the host
name on my board. If you ping your host name from the terminal then you will see the IP address. You can do this
from ipython by adding “! ping ”.
rp = casperfpga.CasperFpga(host='red_pitaya_name or ip_address', port=7147)

The first thing we do is configure the FPGA (Zynq PL).
rp.upload_to_ram_and_program('your_fpgfile.fpg')

You should notice that LED0 on the Red Pitaya is flashing, which indicates that the firmware is running. Congratulations, you just configured your Red Pitaya successfully! :).
All the available/configured registers can be displayed using:
rp.listdev()

The Zynq PL is now configured with your design. The registers can now be read back. For example, the ADC sample
count register can be read back from the FPGA by using:
rp.read_uint('adc_sample_cnt')

The value returned should be continually incrementing, which indicates that the ADC is successfully sampling the
input data.
If you need to write to the reg_cntrl register then do the following:
rp.registers.reg_cntrl.write(rst_cntrl = 'pulse'), this creates a pulse on the rst
signal

˓→

Try the following - add a “?” (leave out the brackets) to find out what the functions below does:
rp.is_connected()
rp.is_running()

Manually typing these commands by hand will be cumbersome, so it is better to create a Python script that will do all
of this for you. This is described below.
Running a Python script and interacting with the Zynq PL
A pre-written python script, ‘’tut_adc_dac.py” is provided. The code within the python script is well commented and
won’t be explained here. The user can read through the script in his/her own time. In summary, this script programs
the Zynq PL with your compiled design (.fpg file), writes to the reset control register, reads back the ADC snap shot
captured data and status registers while displaying them to the screen for analysis. In order to run this script you will
need to edit the file and change the target Red Pitaya IP address and the *.fpg file, if they are different. The script is
run using:
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python tut_adc_dac.py <red pitaya hostname/ip> -p -b <path to fpg file>

If everything goes as expected, you should see a whole bunch of text on your screen - this is the output of the snap
block and status register contents.
Analysing the Display Data
You should see something like this:
user@server:~$ python tut_adc_dac.py
connecting to Red Pitaya...
done
programming the Red Pitaya...
done
arming snapshot block...
done
triggering the snapshot and reset the counters...
done
reading the snapshot...
done
writing ADC data to disk ...
done
reading back the status registers...
adc_sample_cnt: 3689577
done
Displaying the snapshot block data...
ADC SNAPSHOT CAPTURED INPUT
----------------------------Num adc_data_valid adc_data_ch1 adc_data_ch2
[0] 1 -10 -1
[1] 1 6 -1
[2] 1 -6 -1
[3] 1 0 -1
[4] 1 -1 -2
[5] 1 -3 -2
[6] 1 1 -1
[7] 1 -6 -1
[8] 1 3 -1
[9] 1 -6 -1
[10] 1 3 -1
....
[589] 1 -6 -2
[590] 1 1 -1
[591] 1 -3 -1
[592] 1 -2 -1
[593] 1 1 -1
[594] 1 -5 -1
[595] 1 4 -1
[596] 1 -9 -1
[597] 1 6 -1
[598] 1 -9 -1
[599] 1 5 -1

The above results show that the ADC is sampling continuously and that there is just noise at the ADC input, as no
signal generator is connected. The ADC sample count should continue to increase each time this script file is run - try
it. You can also try and compile your Simulink design with a higher clock e.g. 200MHz. Does the ADC data valid
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signal stay high continually? If so, then why?
Setup the signal generator to have an amplitude of 2Vpp, a frequency of 4MHz and sinusoid signal. Check using the
oscilloscope that this is correct. Once satisfied connect the one end of the SMA cable to the signal generator output
and connect the other end to the Red Pitaya IN1. Remember to also connect the Red Pitaya OUT1 to the other channel
of the oscilloscope (needs a BNC to SMA Female) using another SMA to SMA cable. Change the frequency and
amplitude to 2MHz and to 1Vpp. What happens to the oscilloscope Red Pitaya OUT1 display? What is the frequency
and amplitude now? Try run the python script and see what happens? What is different in your results now?
Now connect the signal generator to Red Pitaya IN2 and the other channel of the oscilloscope to Red Pitaya OUT2
and repeat the above tests. What do you notice?
Remember those gpio yellow blocks you added for the logic analyser? Connect the logic analyser fly leads to connector
E1 on the Red Pitaya - do this while the system is powered off and the signal generator is off. Refer to diagram below
for E1 connector pin outs:
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Hint: Checkout schematics: pin 3 is the LSB and pin 12 is the MSB of the ADC data, pin 13 is the ADC data valid.
Hint: What trigger are you going to use to sample the ADC data on channel 1 - internal or external? Why?
Once you have connected everything up then configure the board and switch on the signal generator. Does the data
displayed on the logic analyser look similar to the data captured using the python script? How can you display a
sinusoid signal on the logic analyser?
There are 2 plots one for each ADC. Try compute the RMS LSB of each ADC channel. Is there anything besides noise
when the channel is unterminated or terminated? Hint: edit the script to compute the standard deviation with the ADC
inputs terminated.
Try and do an FFT (add windowing) of the captured ADC data by editing the script. What do you get? Does it make
sense? Hint: treat each channel as real data.
Bonus Challenge
You have gone through the ADC and DAC tutorial on the 125-10 board. Now go through the 14 bit design and then
port this tutorial to work on the 122-16 board. Good luck!
Hint: The Zynq pin outs are not the same. You will need to look at the 122-16 schematics. You will need to update
the simulink yellow blocks, python blocks and red_pitaya.yaml script.
Other notes
• iPython includes tab-completion. In case you forget which function to use, try typing library_name.tab
• There is also onboard help. Try typing library_name.function?
• Many libraries have onboard documentation stored in the string library_name.doc
• KATCP in Python supports asynchronous communications. This means you can send a command, register a callback
for the response and continue to issue new commands even before you receive the response. You can achieve much
greater speeds this way. The Python wrapper in the corr package does not currently make use of this and all calls are
blocking. Feel free to use the lower layers to implement this yourself if you need it!
Conclusion
This concludes the ADC and DAC Interface Tutorial for the Red Pitaya. You have learned how to utilize the ADC and
DAC interface on the Red Pitaya to sample incoming data and convert this sampled data to an analog signal. You have
learned to play around with Matlab’s data manipulation using the signal processing toolbox. You also learned how to
further use Python to program the Zynq PL, control the design and debug the design remotely using casperfpga. If you
managed to successfully port your tutorial to work with the 122-16 Red Pitaya then you would have gained important
hardware porting experience that will allow you to port to any hardware platform in the future.

2.1.14 Tutorial 3: Wide(-ish)band Spectrometer
Introduction
A spectrometer is something that takes a signal in the time domain and converts it to the frequency domain. In digital
systems, this is generally achieved by utilising the FFT (Fast Fourier Transform) algorithm.
When designing a spectrometer for astronomical applications, it’s important to consider the science case behind it. For
example, pulsar timing searches will need a spectrometer which can dump spectra on short timescales, so the rate of
change of the spectra can be observed. In contrast, a deep field HI survey will accumulate multiple spectra to increase
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the signal to noise ratio. It’s also important to note that “bigger isn’t always better”; the higher your spectral and time
resolution are, the more data your computer (and scientist on the other end) will have to deal with. For now, let’s skip
the science case and familiarize ourselves with an example spectrometer.
Setup
This tutorial comes with a completed model file, a compiled bitstream, ready for execution on Red Pitaya, as well as
a Python script to configure the Red Pitaya and make plots. Here
Spectrometer Basics
When designing a spectrometer there are a few main parameters of note:
• Bandwidth: The width of your frequency spectrum, in Hz. This depends on the sampling rate; for complex
sampled data this is equivalent to:

In contrast, for real or Nyquist sampled data the rate is half this:

as two samples are required to reconstruct a given waveform .
• Frequency resolution: The frequency resolution of a spectrometer, ∆f, is given by

,
and is the width of each frequency bin. Correspondingly, ∆f is a measure of how precise you can measure a frequency.
• Time resolution: Time resolution is simply the spectral dump rate of your instrument. We generally accumulate
multiple spectra to average out noise; the more accumulations we do, the lower the time resolution. For looking
at short timescale events, such as pulsar bursts, higher time resolution is necessary; conversely, if we want to
look at a weak HI signal, a long accumulation time is required, so time resolution is less important.
Simulink / CASPER Toolflow
Simulink Design Overview
If you’re reading this, then you’ve already managed to find all the tutorial files. By now, I presume you can open the
model file and have a vague idea of what’s happening. The best way to understand fully is to follow the arrows, go
through what each block is doing and make sure you know why each step is done. To help you through, there’s some
“blockumentation” in the appendix, which should (hopefully) answer all questions you may have. A brief rundown
before you get down and dirty:
• The all important Xilinx token is placed to allow System Generator to be called to compile the design.
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• In the MSSGE block, the hardware type is set to “RED_PITAYA_10:xc7z010” and clock rate is specified as
125MHz.
• In this tutorial, we use the 10-bit Red Pitaya. Make sure that the platform and ADC yellow blocks are configured
for 10 bits.
• The input signal is digitised by the ADC. The ADC runs at 125MHz, which gives a 62.5MHz nyquist sampled
spectrum. The RF inputs have a slightly narrow bandpass of 50MHz. The output range is a signed number in the
range 0 to 1023 (ie 0 bits after the decimal point). This is expressed as fix_10_0. This is a little non-standard.
You’ll notice that tutorials for other platforms have an ADC output between -1 and +1 and a binary point to
match.
• The Xilinx FFT is configured for 256 channels.
• You may notice delay blocks dotted in places of the design. It’s common practice to add these into the design
as it makes it easier to fit the design into the logic of the FPGA. It consumes more resources, but eases signal
timing-induced placement restrictions.
• The real and imaginary (sine and cosine value) components of the FFT are plugged into power blocks, to convert
from complex values to real power values by squaring.
• The requantized signals then enter the vector accumulators, which are simple_bram_vacc 32 bit vector accumulators. Accumulation length is controlled by the acc_cntrl block.
• The accumulated signal for each channel is then fed into a 32-bit snap block, accum0_snap and accum1_snap.
Without further ado, open up the model file and start clicking on things, referring the blockumentation as you go.
adc

The first step to creating a frequency spectrum is to digitize the signal. This is done with an ADC – an Analogue to
Digital Converter. In Simulink, the ADC is represented by a yellow block.
The ADC block converts analog inputs to digital outputs. Every clock cycle, the inputs are sampled and digitized to
10 bit binary point numbers in the range of -1024 to 1023 and are then output by the ADC. This is achieved through
the use of two’s-complement representation with the binary point set to 0. Simulink represents such numbers with a
fix_10_0 moniker.
ADCs often internally bias themselves to halfway between 0 and -1. This means that you’d typically see the output of
an ADC toggling between zero and -1 when there’s no input. It also means that unless otherwise calibrated, an ADC
will have a negative DC offset.
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In this design the ADC is clocked to 125MHz, generated from the Red Pitaya’s system clock. This gives us a bandwidth
of 62.5MHz, as Nyquist sampling requires two samples (or more) each second.
INPUTS
OUTPUTS
The ADC outputs are a data valid flag and two signals: i and q, which correspond to the coaxial inputs of the Red
Pitaya (inputs 0 and 1).
Xilinx FFT

This Red Pitaya tutorial utilizes the Xilinx FFT block – one for each channel of the ADC. adc_di and adc_dq route to
the real inputs on each FFT. Each block is configured for a 256 point transform.
INPUTS
OUTPUTS
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power

The power block computes the power of a complex number. Underneath the subsystem blocks, you see that the power
block will compute the power of its input by taking the sum of the squares of its real and imaginary components. The
output of the block is 31.0 bits.
INPUTS/OUTPUTS
simple_bram_vacc
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The simple_bram_vacc block is used in this design for vector accumulation. If you wanted a really long accumulation
(say a few hours), you’d have to use a block such as the qdr_vacc or dram_vacc. As the name suggests, the simple_bram_vacc is simpler so it is fine for this demo spectrometer. The FFT block outputs 256 frequency bins in total.
We have two of these bram vacc’s in the design, one for each port on the Red Pitaya. The vector length is set to 256
on both.
PARAMETERS
INPUTS/OUTPUTS
Snap Blocks

The final blocks, accum0_snap and accum1_snap, capture the data coming from the accumulators, which we will read
out the values of using the tut_spec.py script.
PARAMETERS
INPUTS/OUTPUTS
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Software Registers
There are a few control registers, led blinkers, and snap block dotted around the design too:
• reg_cntrl: Counter reset control. Pulse this high to reset the ADC and ADC counter.
• acc_len: Sets the accumulation length. Have a look in tut_spec.py for usage.
• sync_reg: Synchronizes the FFTs. Pulse this high to start/restart the FFT output.
• sync_cnt: Logs the number of syncs into the FFTs.
• fft_sync_inc: Logs the number of syncs leaving each FFT.
• acc_cnt: Accumulation counter. Keeps track of how many accumulations have been done.
• gpio_led: LED flashes while the bitcode is running.
There are a few additional software registers for debug purposes only.
If you’ve made it to here, congratulations, go and get yourself a cup of tea and a biscuit, then come back for part two,
which explains the second part of the tutorial – actually getting the spectrometer running, and having a look at some
spectra.
Configuration and Control
Hardware Configuration
The tutorial comes with a pre-compiled fpg file, which is generated from the model you just went through
(tut_spec.fpg)
Next, you need to set up your Red Pitaya. Power it on, making sure that:
• By default, the Red Pitaya takes RF inputs between -1 and +1 V though it can be configured for higher voltages.
• Connect inputs 0 and 1 to sine wave generators. The frequencies should be between 0 and 50 MHz.
The tut_spec.py spectrometer script
This short script does the following:
• calls the Red-Pitaya • uploads an fpg file • activates the reset registers • pulls data from the snap blocks • plots the
spectra.
Browse to where the tut_spec.py file is in a terminal and at the prompt type
python tut_spec.py -f <fpgfile name> -r <Red-Pitaya IP or hostname> -a <accumulation
length>

˓→

replacing with the IP address of your Red-Pitaya and with your fpg path and filename. You should see a spectrum like
this:
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In the plot, the blue solid line represents several spectra concatenated one after the next. You see that after each
accumulation – in this case 5 – the amplitude of the tones build. After the fifth spectrum, then the accumulation resets
and repeats. The data valid flag, shown by a red-dashed line scaled to the range of the plot, shows the indecies of
the last accumulation. We plot the valid accumulation in frequency space, you see the tone at 14 MHz. Inspect the
tut_spec.py script to see how this is done.
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Conclusion
If you have followed this tutorial faithfully, you should now know:
• What a spectrometer is and what the important parameters for astronomy are.
• Which CASPER blocks you might want to use to make a spectrometer, and how to connect them up in Simulink.
• How to connect to and control a Red Pitaya spectrometer using python scripting.
RFSoC
1. CASPER RFSoC README
2. Getting Started With RFSoC
3. RFSoC Platform Yellow Block and Simulink Overview Step-by-Step or Completed
4. Using the RFDC Step-by-Step or Completed
5. Spectrometer Tutorial Step-by-Step or Completed
6. 100 Gigabit Ethernet Step-by-Step or Completed

2.1.15 CASPER RFSoC README
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Introduction
This documentation aims to introduce Xilinx Zynq UltraScale+ RFSoC to the CASPER community along with the
platforms and capabilities currently supported in the CASPER tools. The hardware and design flexibility of RFSoC
within CASPER will continue to proliferate the design philosophy of CASPER of decreasing the time-to-science
metric and provide a way of bringing the needed capabilities to next generation instruments.
Before starting with the tutorials and reviewing the available platforms, the following is a brief introduction and
overview of the RFSoC architecture and its capabilities. The primary source of the information presented here is
Xilinx documentation and data sheets pertaining to the Zynq UltraScale+ RFSoC. Please reference those materials
(PG269, DS889, and DS926) for more details as this is a rehashing of only some high-level details.
The RFSoC
A high-level block diagram of the RFSoC package is shown in the below figure.

The RFSoC integrates programmable logic with the Zynq ARM (A53) processor, high speed serial transceivers, and
the RF Data Converters (RFDC); a hardened IP core implementing all RF functionality. The RFDC groups together
multi-gigasample per second ADCs (DACs) capable of direct sampling (synthesis) for RF signals up to 6 GHz (9.85
GHz). Additionally, these cores include digital down (up) converters, a mixer capable of a fixed coarse setting or
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fine frequency tuning by a numerically controlled oscillator (NCO), and interpolation and decimation filters. A block
diagram of the analog signal path for the ADCs is shown in the following figure.

The ADCs and DACs are grouped into “tiles” to some extent similar to the idea of other columnar tile components
of a Xilinx FPGA. In this case however, the ADCs or DACs and their supporting components populate the entire tile.
There are two different tile architectures found in RFSoC devices: quad-tile and dual-tile. The number of tiles found in
the device and their capabilities varies between RFSoC packages and generation. The quad- and dual-tile architectures
are depicted in the below figure.

As the RFDC is the focus of the RFSoC, in order to bring the functionality to CASPER an RFDC yellow block is
needed to access and configure the IP. This yellow block instances the underlying Vivado RFDC IP and interfaces to
the CASPER user in a similar fashion as would be presented to the hardware designer in Vivado providing many of
the same configuration options. This was done to maintain the flexibility of the RFDC and provide as much control as
possible over its configuration and provide that to the general CASPER user.
The RFDC yellow block is designed to detect the tile architecture (quad/dual) and the generation (gen 1/3) of the
2.1. Vivado
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selected platform as specified by an RFSoC platform yellow block. This provides a forward compatibility mechanism
as more RFSoC platforms are targeted in CASPER and as Xilinx inevitably produces future generations of the RFSoC.
Platforms

The CASPER library contains support and has been tested for the following RFSoC platforms:
• ZCU216
• ZCU208
• ZCU111
• PYNQ RFSoC 4x2
• PYNQ RFSoC 2x2
• HTG ZRF16-29DR
• HTG ZRF16-49DR
A summary of the board resources taken from the Xlinx RFSoC product selection guide is shown in the following
table. In the context of astronomy signal processing these features are ideal for small form factor and low power
digitizers streaming raw voltages over 2x100GbE, or suitable as modest sized channelizers using the available fabric
resources.
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Tutorials
Links
• Getting Started With RFSoC
• RFSoC Platform Yellow Block and Simulink Overview
• Using the RFDC
• Example Spectrometer
• 100GbE
Designs
• Tutorial Designs

2.1.16 Getting Started With RFSoC
Introduction
This tutorial will walk through the procedure to install the development branches of the CASPER tools needed to
target supported RFSoC platforms.
Environment Setup
Pre requisites
The recommended environment setup and software required is more or less consistent with the standard CASPER
setup. In this case, for RFSoC what you will need is:
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• Compatible Linux host operating system (tested on RHEL 7.9, 8.4 and Ubuntu 18.04 LTS, 20.04 LTS)
• Vivado 2021.1
• Matlab 2021a (with Simulink)
• Python 3 environment
• Development branches of the CASPER “toolflow” library mlib_devel and board communication library
casperfpga with RFSoC support
• Xilinx device tree repository
Some help and pointers for general toolflow and software installation can be found here. It is strongly recommended
to use an isolated runtime environment of python. This is done with a virtual environment using the venv python
package or some other tool with an environment manager such as conda. The following assumes an OS and required
vendor software has been installed.
Core Setup
With a compatible Linux OS, Vivado and Matlab installed (or installing. . . ), there are three core tasks to complete:
1. Prepare and install the core “toolfow” mlib_devel
2. Prepare and setup of the CASPER platform (usually the fun part)
3. Prepare and install the communication library casperfpga
Operating within a new python environment, begin by fetching the development branches and dependencies needed
to work with RFSoC. The following will assume a working directory called sandbox just as an isolated example
through this tutorial. Feel free to organize suitable to your preferences.
Toolflow Setup
$
$
$
$
$
$

cd </path/to>/sandbox
mkdir casper
cd casper
git clone https://github.com/casper-astro/mlib_devel.git
cd mlib_devel
git checkout -b m2021a origin/m2021a

# install pacakge dependencies
$ pip install -r requirements.txt
# initialize submodules
$ git submdoule init
$ git submodule update
#
$
$
$
$

fetch a copy of the xilinx device tree repo
cd </path/to>/sandbox
mkdir xilinx
cd xilinx
git clone https://github.com/xilinx/device-tree-xlnx.git

# update or create your `startsg.local` config file
$ cd </path/to>/sandbox/casper/mlib_devel
$ cp startsg.local.example ./startsg.local
(continues on next page)
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(continued from previous page)

# with you favorite text editor open `startsg.local` and update the following
# environment variables
XILINX_PATH=</path/to/your/Xilinx>/Vivado/2021.1
MATLAB_PATH=</path/to/your/Matlab>/R2021a
COMPOSER_PATH=</path/to/your/Xilinx>/Model_Composer/2021.1
JASPER_BACKEND=vitis
XLNX_DT_REPO_PATH=</path/to>/sandbox/xilinx/device-tree-xlnx
# The following is an example of my startsg.local
export XILINX_PATH=/opt/Xilinx/Vivado/2021.1
export MATLAB_PATH=/opt/MATLAB/R2021a
export COMPOSER_PATH=/opt/Xilinx/Model_Composer/2021.1
export PLATFORM=lin64
export JASPER_BACKEND=vitis
export XLNX_DT_REPO_PATH=/home/mcb/git/xilinx/device-tree-xlnx
# Start Matlab and System Generator
$ ./startsg

Platform Processor System Setup
These steps are generally platform agnostic as this focuses more on preparing and booting the processor system (PS).
However, there are some platform dependent hardware setup and procedures to be discussed later. Download the
casperized image for your target RFSoC board and locate a 16 GB micro SD card. We next start to unpack and flash
the image. The following uses the zcu216_casper.img as an example, the target .img download file would be
replaced in all subsequent commands.
# navigate to the download location of the compressed tar and unpack it
$ cd </path/to/downloads>
$ tar -xzf zcu216_casper.img.tar.gz
# the full uncompressed image `zcu216_casper.img` is now in the current directory
$ ls zcu216_casper.*
zcu216_casper.img zcu216_casper.img.tar.gz
# plug in the micro sd card, on OS's like Ubuntu the disk may auto mount,
# unmount before preceeding.
# Take note of the kernel registered block device
# such as `sdb, sdc, sdd, etc.`. This can be done with the `dmesg` utility e.g.,
$ dmesg
108821.527053] scsi host38: usb-storage 2-2:1.0
[108822.527801] scsi 38:0:0:0: Direct-Access
TS-RDF5 SD Transcend
TS38 PQ: 0
˓→ANSI: 6
[108822.528460] sd 38:0:0:0: Attached scsi generic sg3 type 0
[108822.829512] sd 38:0:0:0: [sdd] 31116288 512-byte logical blocks: (15.9 GB/14.8
˓→GiB)
[108822.830188] sd 38:0:0:0: [sdd] Write Protect is off
[108822.830197] sd 38:0:0:0: [sdd] Mode Sense: 23 00 00 00
[108822.830867] sd 38:0:0:0: [sdd] Write cache: disabled, read cache: enabled, doesnt
˓→support DPO or FUA
[108822.835071] sdd: sdd1 sdd2
[108822.837460] sd 38:0:0:0: [sdd] Attached SCSI removable disk
[109641.322489] sdd: sdd1 sdd2
(continues on next page)
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# in this example the sd card block device is `sdd`
# flash the sd card with the `dd` utility, wait until this completes. It can take
˓→awhile
# as we must wait to sync all the I/O, must also have root access
$ sudo dd if=zcu216_casper.img of=/dev/sdd bs=32MB

Take out the SD card and plug it into your platform board. Place the DIP switches that select the boot device to SD
mode. You are about ready to power-on the board.
Prior to booting the board, provide a connection to the 1GBE port and review the Network Configuration Section to
understand how communication will be established on the board. A micro-USB serial cable can be optionally attached
and the serial output from the processor can be monitored with a utility such as minicom. The serial port is configured
for baud 115200, 8 data bits, no parity, 1 stop bit. This output can be helpful to obtain the IP address if there is no
direct access to configure a DHCP server or a static IP address was not set before hand.
Power-on the board. As long as the IP address of the board is known there is no requirement at this time to log in. The
image comes pre-configured to be ready to interface with casperfpga. In this case, if the IP is known the last step
is to install casperfpga and test commmunications. Otherwise, using the serial connection login with the default
user casper and default password casper and run the ip addr command to learn the IP address of your board.
Setup Casperfpga
Next is to install casperfpga. The same Python 3 environment can be used to keep it simple.
$
$
$
$

cd </path/to>/sanbox/casper
git clone https://github.com/casper-astro/casperfpga.git
cd casperfpga
git checkout -b mega-merge origin/mega-merge

# install package requirments
$ pip install -r requirments.txt
# build and install `casperfpga`
$ pip install .

casperfpga is now installed and we can test connection with the platform. To do this we can run a few commands
in IPython. First, change out of the casperfpga directory as we want to reference the package we just installed
instead of the one in the casperfpga source directory.
Start an IPython session; In this example the ZCU216 IP address was assigned to 192.168.2.101.
In [1]: import casperfpga
In [2]: fpga = casperfpga.CasperFpga('192.168.2.101')
In [3]: fpga.is_connected()
Out[3]: True

This does not seem like an incredibly exciting result, but everything is setup and we are now ready to move on to testing
the toolflow installation and get more familiar with your platform image and casperfpga in the next tutorial.
Misc. Configuration
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Platform Network Configuration
Each platform image is configured by default to use DHCP to receive an IP address when the kernel boots. For the
ZCU216/208, ZCU111, and RFSoC2x2 platforms the first stage boot loader is configured to look at the EEPROM for
a MAC address, if a valid address is not found then a randomly generated one is created at each boot. Random MAC
generation or setting a static IP can be overridden by either manually writing a valid MAC to the EEPROM or using the
Linux kernel’s Network Manager configuration scripts. The HTG ZRF16-29/49DR boards boot with the static MAC
address 0a:4c:50:14:42:00 again, this can be overridden by using a Network Manager configuration script.
Manually Writing Platform MAC Address
The on board EEPROMs are interfaced over i2c. They can be programmed with the first stage boot loader’s (U-Boot)
i2c utility, with a Linux i2c utility or custom userspace application, and some boards will expose i2c header pins to
attach a serial programmer. As setting the MAC address in the EEPROM is a “set once and forget about” type of thing,
a quick an easy way is to use U-boot’s i2c utility.
With a micro-USB serial cable connected to the board begin to monitor the serial output from the processor. Power-on
the board and the serial console will begin to display boot progress starting with the first stage boot loader. After
reporting status of peripheral hardware the prompt “hit any key to stop autoboot:”. Before the count down ends,
interrupt with the keyboard starting the U-Boot command line interface. The output would have been similar to the
following:
Xilinx Zynq MP First Stage Boot Loader
Release 2020.2
Jul 15 2021 - 16:48:09
NOTICE: ATF running on XCZU49DR/silicon v4/RTL5.1 at 0xfffea000
NOTICE: BL31: v2.2(release):xilinx_rebase_v2.2_2020.1-10-ge6eea88b1
NOTICE: BL31: Built : 16:45:03, Jul 15 2021
U-Boot 2020.01 (Jul 15 2021 - 16:49:01 +0000)
Model: ZynqMP ZCU216 RevA
Board: Xilinx ZynqMP
DRAM: 4 GiB
PMUFW: v1.1
EL Level:
EL2
Chip ID:
zu49dr
NAND: 0 MiB
MMC:
mmc@ff170000: 0
In:
serial@ff000000
Out:
serial@ff000000
Err:
serial@ff000000
Bootmode: LVL_SHFT_SD_MODE1
Reset reason:
SOFT
Net:
ZYNQ GEM: ff0e0000, mdio bus ff0e0000, phyaddr 12, interface rgmii-id
Warning: ethernet@ff0e0000 (eth0) using random MAC address - 3a:b0:c7:80:96:3f
eth0: ethernet@ff0e0000
Hit any key to stop autoboot: 0
ZynqMP>

Notice the ‘Warning’ line informing that a random MAC address was created. We now begin to peek and poke using
the i2c utility.
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# get information from the i2c bus, look for the "eeprom" node
# on the zcu216 this is at address 54
ZynqMP> i2c bus
.
.
Bus 2: i2c@ff030000->i2c-mux@74->i2c@0 (active 2)
54: eeprom@54, offset len 2, flags 0
.
.
# target that bus
ZynqMP> i2c dev 2
Setting bus to 2
# we can get help on what the i2c utility can do
ZynqMP> i2c
i2c - I2C sub-system
Usage:
i2c bus [muxtype:muxaddr:muxchannel] - show I2C bus info
i2c crc32 chip address[.0, .1, .2] count - compute CRC32 checksum
i2c dev [dev] - show or set current I2C bus
i2c loop chip address[.0, .1, .2] [# of objects] - looping read of device
i2c md chip address[.0, .1, .2] [# of objects] - read from I2C deviceA
i2c mm chip address[.0, .1, .2] - write to I2C device (auto-incrementing)
.
.
.
# We will only need to read/write here, we can start by taking a peek at the
# first 16 bytes of the memory using the address reported by `i2c bus`.
# Depending on the platform this could be initialized or not, in the case of the
# ZCU216 and ZCU111 it is.
ZynqMP> i2c md 0x54 0x0 0x10
0000: 5a 43 55 32 31 36 ff ff 11 ff ff ff 99 ff ff ff
ZCU216..........
# The MAC address is stored as 6 bytes at offset 0x20 in the eeprom. First write
# the address we want to place in the eeprom inside U-Boot's scratchpad area in
# DDR memory
ZynqMP> mm.b 0x
00000000: 00 ? 0a
00000001: 00 ? 4c
00000002: 00 ? 50
00000003: 00 ? 41
00000004: 00 ? 43
00000005: 00 ? 41
00000006: 00 ? q
# now write from address 0x0 to the eeprom at address 0x20 and write those 6 bytes
ZynqMP> i2c write 0x00 0x54 0x20 0x6
# read back to make sure it worked as expected
ZynqMP> i2c md 0x54 0x20 0x6
0020: 0a 4c 50 41 43 41
.LPACA
# reboot the board
ZynqMP> reset
(continues on next page)
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# the first stage boot loader will start back up, reporting the same information
# as before, but this time the `Warning` should now read
.
.
Warning: ethernet@ff0e0000 using MAC address from ROM
.
.

The MAC address has been set and you can let the auto boot counter timeout and proceed to boot.

2.1.17 Tutorial 1: RFSoC Platform Yellow Block and Simulink Overview
In this tutorial, you will make a simple design for an rfsoc board using the CASPER toolflow. It will take you
through launching the toolflow, creating a valid CASPER design in Simulink, generating an .fpg and .dtbo file,
programming the .fpg and .dtbo file to a CASPER rfsoc board, and interacting with the hardware running on the
board using the casperfpga library through a python interface.
This tutorial assumes that you have already setup your environment correctly, as explained in the Getting Started With
RFSoC tutorial, specifically that the correct versions of Vivado and Matlab are installed. You should also have all the
programs and packages installed, configuration files set, and have successfully set up and tested your connection to
the rfsoc board.
Creating Your First Design
Create a New Model
Make sure you are in your previously set up environment and navigate to mlib_devel. Start Matlab by exectuing
startsg. This will properly load the Xilinx and CASPER libraries into Simulink, so long as your startsg.
local file is set correctly. Within Matlab, start Simulink by typing simulink into Matlab’s command line. Create
a new blank model and save it with an appropriate name.
Library Organization
There are three primary libraries in Simulink you will use when designing for your rfsoc board:
1. The CASPER XPS Library contains the CASPER “Yellow Blocks”. These blocks encapsulate interfaces to
your board’s hardware (ADCs, memory chips, CPUs, various ports, etc).
2. The CASPER DSP Library contains (often green) blocks that implement DSP functions (filters, FFTs, etc).
3. The Xilinx Library contains blue blocks which provide low-level fpga functionality (multiplexing, delaying,
adding, etc). It also contains the System Generator block, which contains information about the FPGA
you are using.
Add the Xilinx System Generator and CASPER Platform blocks
The first thing to add is the System Generator block, found using the Simulink Library Browser in Xilinx
Blockset->Basic Elements->System Generator. Add the block by clicking and dragging the block
into your design. See the Simulink documentation by Mathworks for other methods of finding and adding blocks to
your design.
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You can double-click on the added block to see its configuration. However, instead of configuring the System Generator ourselves, we will use a platform Yellow Block from the CASPER XPS Library to configure it. Locate the block
for the board you are using in CASPER XPS Blockset->Platforms-><your platform>. This example
uses the ZCU216 pltform block, so this example adds the ZCU216 Yellow Block to our Simulink model. All RFSoC
platfrom Yellow Blocks are similar in their configuration. The following is therefore easily applied to your specific
platform.
Note: The System Generator and XPS platform blocks are required by all CASPER designs
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Double-click on the added platform block to see its configuration.
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Confirm that the Hardware Platform parameter matches the platform you are using. The User IP Clock
Rate is the desired frequency for the IP of the design. For the RFSoC platform the adc_clk user IP clock source is
derived from the pl_clk coming from the first stage PLL in the clocking hierarchy for the RFDC. In most cases this
is an LMK creating the pl_clk in addition to the clock that drives the RFDC tiles. This frequency coming from the
LMK as pl_clk is what is to be entered into the RFPLL PL Clock Rate field. In other words, this is the clock
rate the design is expecting to produce the clock frequency for the user IP clock.
Before proceeding briefly review the clocking information for your target platform and any additional
setup/configuration required:
• ZCU216
• ZCU208
• ZCU111
• RFSoC2x2
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• RFSoC4x2
• ZRF16
Set the User IP Clock Rate and RFPLL PL Clock Rate as follows for your target RFSoC platform:
# ZCU216
User IP Clock Rate: 250, RFPLL PL Clock Rate: 125
# ZCU208
User IP Clock Rate: 250, RFPLL PL Clock Rate: 125
# ZCU111
User IP Clock Rate: 245.76, RFPLL PL Clock Rate: 122.88
# RFSoC 4x2
User IP Clock Rate: 245.76, RFPLL PL Clock Rate: 122.88
# RFSoC 2x2
User IP Clock Rate: 245.76, RFPLL PL Clock Rate: 15.36
# ZFR16
User IP Clock Rate: 250, RFPLL PL Clock Rate: 50

The Example Design
In order to demonstrate the basic use of hardware interfaces and software interaction, this design will implement three
different functions on the board:
1. A Flashing LED
2. A Software Controllable Counter
3. A Software Controllable Adder
The final design will look something like this:
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Function 1: Flashing LED
We can create a flashing LED by using a 27-bit counter. On the ZCU216, the default clock given by its CASPER
platform block is 250 MHz, which will toggle the most significant bit on the 27 bit counter about every 0.27 seconds.
The principle is the same for any clock rate on any board. We can output this most significant bit to an LED on the
board, causing the LED to flash at about 50% duty cycle every so many seconds (half a second for this example).
Step 1: Add a counter
Add a blue counter block to the design. It can be found in Xilinx Blockset->Basic Elements->Counter.
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Double-click the block to access its parameters, and set it to free running, 27-bits, unsigned. This will set the counter
to count from 0 to (2^27)-1, wrap back to zero, and continue.
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Step 2: Add a slice block to select the MSB
Now that we have a counter, we want to select just the most significant bit so that we can send it to an LED. Do this
by adding a blue slice block, found in Xilinx BLockset->Basic Elements->Slice.

Double-click on the slice block to modify it. There are several ways to use the slice block to grab the bit we want. For
this example, we will select the MSB by indexing from the upper end and selecting the first bit.
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Step 3: Add a GPIO Block
Next we want to access an LED to send that bit to. We can access the correct FPGA output pin by using a GPIO block.
GPIO blocks allow you to route signals from Simulink to various FPGA pins. Add a yellow GPIO block, found in
CASPER XPS Library->IO->gpio.
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Double-click the gpio block and set it to the led I/O group. Set the I/O direction to out, the data type to
boolean, the data bitwidth to 1, and the GPIO bit index to 0. This tells the toolflow that it will be connecting
a 1-bit input to LED0.
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Step 4: Add a terminator
To prevent warnings (from MATLAB & Simulink) about unconnected outputs, terminate all unused outputs using a
Terminator block.

Step 5: Connect the design
If you haven’t done so already, rename the blocks to sensible names, such as counter_led instead of counter. You
can do this by double-clicking the name on the blocks.
Connect the blocks together by clicking and dragging from teh output arrow on one block and dragging it to the input
arrow on another block.
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And you’re done with the flashing LED!
Function 2: Software Controllable Counter
Next we will design a hardware counter that we can start, stop, reset, and read using software. The design will look
similar to the flashing LED we just finished.
Step 1: Add the software registers
In order to interact with the hardware while it’s running, we need some software registers.
For our
counter, we want two software registers, one to control the counter, and another to read it’s current value.
Add two yellow software_register blocks to the design, found in CASPER XPS
Blockset->Memory->software_register.
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On one of the software_register blocks, set the I/O direction to From Processor. This will allow a
value from the software to be sent to the FPGA hardware. This block will be the counter controller.
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On the other software_register block, set the I/O direction to To Processor. This will allow the
FPGA hardware to send a value to the software when prompted. This block will be what allows us to read the counter.
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Set both registers to a bitwidth of 32-bits and rename them something sensible. The names of the blocks here are the
names used to access them from casperfpga. Do not use spaces, slashes, or other funny characters for these
names. In this example, they are named counter_control and counter_value.
See that the registers have sim inputs and outputs. These allow you access the blocks in Simulink for simulation and
test purposes. A sim input port can be fed inputs by simulink blocks, and a sim output port can be read by simulink
2.1. Vivado
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blocks.
So that the counter runs during simulation,
add a simulink constant block (found in
Simulink->Sources->Constant), set it to 1, and connect it to the ‘sim’ input of the counter controller register.
To monitor the counter’s value in simulation, add a simulink scope block (found in Simulink->Sinks->Scope)
and connect it to the sim output of the counter value register.
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Note that these white simulink blocks will not be compiled to the fpga hardware. They are for simulation purposes
only. Only blue System Generator blocks are acutally compiled. Yellow blocks are required to interface white simulink
blocks to the blue System Generator blocks.
Step 2: Add the counter
Add another counter block the same way we did before. You can also copy the existing counter block by the usual copypaste or by ctrl-click-drag-drop. Open it’s paramters and set it to free running, unsigned, 32-bits, with synchronous
reset port and enable port turned on.
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Step 3: Add the slice blocks
We want to be able to control the enable and reset ports on this new counter with the counter control register we made
before. We can do this by slicing out one bit of the register for the enable port and slicing out another bit for the reset
port. Alternatively, we could use two seperate registers, one for the reset and one for the enable, but as the registers
are 32-bits each, that would be wasteful.
Add two new slice blocks (or copy them from the flashing LED function). Configure one slice block for the enable by
setting it to boolean output, specifying the range as Lower bit location + width, offset 0, and relative to
LSB of input.

Configure the other slice block for the reset with the same approach, but setting the offset to 1.
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Step 4: Connect the design
Connect the blocks together. Take time to make the design look neat as well, renaming and resizing blocks as needed.

And that concludes this counter!
Function 3: Software Controllable Adder
The last function we will implement is a software controllable adder. We will be able to give the adder two value over
software, it will add in the hardware, and we will be able to read the result back using software.
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Step 1: Add the software registers
Add two software registers and configure them as inputs (From Processor). These will let us specify the values to
add. Add another register and configure it as an output (To Processor), so that we can read back the result. Name
them something reasonable. Remember that the register names are how they will be accessed by the software.
Step 2: Add the adder block
Add a blue adder/subtractor block to the design, found in Xilinx Blockset->Math->AddSub. Check its configuration and make sure it is set to addition.
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The output register is 32-bits. If we add two 32-bit numbers, we will have 33-bits.
There are a number of ways of fixing this:
• limit the input bitwidth(s) with slice blocks limit the output bitwidth with
• slice blocks create a 32-bit adder.
For this example, we will configure the AddSub block to be a 32-bit adder. In its configuration, under the Output
tab, set it to unsigned 32-bits. Also set its overflow to Saturate. This way if two very large numbers are
added, it will just return its max (2^32-1).
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Step 3: Add the scope and simulation inputs
Add simulink scope and constant blocks to the output register and input registers. Set the constant blocks to something
so we can check the adder in simulation.
Step 4: Connect the design
Connect all the blocks together, name things properly, and adjust/resize the design so it is easy to look at. Of course,
these can all be done as you go, and probably should be done as you go.

Now the adder is done!
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Extra Design Function (RFSoC2x2 only)
Make sure to have added the software register and GPIO needed to remove RESET from the LMK PLL chip so that it
can be programmed later on. See the clocking section of the RFSoC2x2 platform page.
Simulating the design

With all hardware functions configureed has hooked up, we can simulate the design with Simulink.
Under the simulate section of the simulation tab on the ribbon, set the stop time to the number of clock cycles
you want to simulate. This example uses 10. Note that (at least in MATLAB R2020b) it says that the stop time is in
seconds, but this is actually clock cycles because of the way the toolflow and CASPER blocks are configured.

Press Run to simulate the design. Once the simulation is done, and assuming there are no errors, you can double-click
the scopes to view the output signals. You should see the counter incrementing once every clock cycle and the adder
should show you the result of the addition. You may have to scale the scopes to see the results properly.
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Once everything looks like it should, you’re ready to compile for the FPGA!
Compiling
We now have a design with three independent functions all working off the same FPGA clock. From here, compiling
the design is easy, so long as your environment was set up correctly.
To compile the design, go to the MATLAB command line and enter
>> jasper

Depending on your computing resources compilation of this design will take between 10 and 25 mins.
The jasper command will run the various parts of the build process. The first part uses Xilinx’s System Generator
to compile any Xilinx blocks in the design to a circuit that can be implemented on the FPGA, i.e., HDL code.
The second part runs Vivado’s synthesis, implementation and place and route tools creating the physical hardware
design for the FPGA. Lastly, the toolflow creates the final output .fpg and .dtbo files that are used to program
the FPGA using CASPER software framework. The .fpg file contains the bitstream that Vivado created as well as
meta-data that describes the yellow blocks from the simulink design and their configurations. The .dtbo is a new
output product of the toolflow targeting SoC platforms like the RFSoC.
Similar to the meta-data that is created for CASPER softawre the .dtbo is the device tree overlay binary containing
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somewhat similar meta data information but taragetd to the software drivers that will be loaded by the processor system
when programming the FPGA. After Vivado syntheis and bitstream generation the toolflow exports the platform
hardware definition to use Xilinx’s software tools (the Vitis flow) to generate software produts to interface with the
hardware design. The .dtbo is one of those software products. The .dtbo is now used in conjunction with the .fpg
file where the .fpg is used to first program the FPGA followed by application of the device tree overlay. In this design
there are no IP that take advantage of this and so the resulting .dtbo will be mostly empty (the MPSoC is always
present in the design). Both the .fpg and .dtbo file will be placed in the outputs folder in the working directory
of the Simulink model. The files will be named using the simulink file name and the date/time that compilation began.
Note that the .dtbo must be placed in the same directory as the .fpg and have the same name (except for the
extension). Meaning if the .fgp file name is changed from the compiled default, the .dtbo must also be updated as
well.
Programming the FPGA
Reconfiguration on any CASPER platform is typically done using the casperfpga python library. However, before
we use casperfpga we are going to instead manually connect to the board to program the clocks needed for the
user design. This is done to briefly introduce the processing system and idea that as a user the processor is there to be
used if needed.
Programming the onboard clocks for the RFSoC can be done using the rfdc yellow block and associated RFDC
casperfpga object (to be introduced in the next tutorial). However this does not use the rfdc yellow block
meaning an RFDC object is not automatically present on the software side. There are other ways to program these
clocks using casperfpga but instead we can also use a basic software utility that is distributed with each platform
to do this.
shell into the board using an ssh client, the default username is casper with password casper. For example,
$ ssh casper@your.ip.address.here

In the home directory there is a bin directory containing a few utilities for some of the board on-board peripherals.
Specifically, each platform will have a utility to program the PLLs that are to drive the sample clock or PLL for the
RFDC. Take a look at that directory, it is shown here for all the platforms.
casper@alpaca-1:~$ ls bin/
prg_8a34001 prg_clk104_rfpll

reset_rfpll

zcu216_probe_sfp

The program to configure the LMK/LMX PLLs for the RFDC all accept a .txt formatted hexdump file from TICS
with the commandline switch -lmk or -lmk to indicate the target PLL.
casper@alpaca-1:~$ ./bin/prg_clk104_rfpll
must specify -lmk|-lmx
./bin/prg_clk104_rfpll -lmk|-lmx <path/to/clk/file.txt>

The distributed clock files for the platform are stored in /lib/firmare. As mentioned above, designs for RFSoC
use pl_clk coming from the on board LMK to generate the User IP clock. Program the LMK using the corresponding platforms utility (before proceeding make sure to have reviewed your platforms page for required clocking
configuration and setup):
# ZCU216
casper@alpaca-1:~$ sudo ./bin/prg_clk104_rfpll -lmk /lib/firmware/250M_PL_125M_SYSREF_
˓→10M.txt
# ZCU111
casper@alpaca-zcu111:~$ sudo ./bin/prg_rfpll -lmk /lib/firmware/122M88_PL_122M88_
˓→SYSREF_7M68_clk5_12M8.txt
(continues on next page)
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(continued from previous page)

# RFSoC 4x2
casper@rfsoc4x2:~$ sudo ./bin/prg_rfpll -lmk /lib/firmware/rfsoc4x2_PL_122M88_REF_
˓→245M76.txt
# RFSoC 2x2
casper@rfsoc2x2:~$ sudo ./bin/prg_rfpll -lmk /lib/firmware/rfsoc2x2_lmk04832_12M288_
˓→PL_15M36_OUT_122M88_CLK12_15M36.txt
# ZRF16
casper@htg-zrf16:~$ sudo ./bin/prg_rfpll -lmk /lib/firmware/zrf16_LMK_CLK1REF_10M_
˓→LMXREF_50M_PL_OUT_50M_nosysref.txt

Each platform has an LED connected to the status pin of the LMK that should now be lit indicating that PLL is locked.
The LMXs could also be programmed in the same way using the -lmx switch and a corresponding LMX hexdump
file but this is not needed here as those drive the sample clock or internal PLL reference clock for the RFDC.
With the clock to drive the user design configured we can now continue to use casperfpga to program the FPGA
and interact with our design. You should have installed and used this in the Getting Started tutorial to check your
connection to your board.
Step 1: Copy the .fpg file to where you need it
Navigate to the prevously mention ‘outputs’ folder and copy the .fpg file to wherever you are going to be running
your ipython session from. ro
Step 2: Connect to the board
Assuming that your board is on, configured, and on the same network you are working on, connect to the board the
same way demonstrated in the Getting Started tutorial:
$ ipython
In [1]: import casperfpga
In [2]: fpga = casperfpga.CasperFpga('ipaddress.of.board')
In [3]: fpga.is_connected()
Out[3]: True

If the output of is_connect() is true, you’re good to go.
We can now program the fpga with the .fpg file with the following:
In [4]: fpga.upload_to_ram_and_program('/path/to/your_fpgfile.fpg')

Interacting with the board
The design we created is now running on the board! You should see the first function working by observing the
blinking LED on the board. From here we can check to see if the software registers in the design worked. If you forgot
what the registers were named, you can use listdev() to get a list of available registers:
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In [5]: fpga.listdev()
Out[5]:
['a',
'b',
'counter_control',
'counter_value',
'sum_a_b',
'sys_block',
'sys_board_id',
'sys_clkcounter',
'sys_rev',
'sys_rev_rcs',
'sys_scratchpad']

Let’s test the adder function first. Reading and writing to the registers can be done with write_int() and
read_int():
In [6]: fpga.write_int('a',15)
In [7]: fpga.write_int('b',35)
In [8]: fpga.read_int('sum_a_b')
Out[8]: 50

Lastly, let’s test the controllable counter:
In [9]: fpga.read_uint('counter_value')
Out[9]: 0
In [10]: fpga.write_int('counter_control',1)
In [11]: fpga.read_uint('counter_value')
Out[11]: 1103388123
In [12]: fpga.read_uint('counter_value')
Out[12]: 1849175237
In [13]: fpga.read_uint('counter_value')
Out[13]: 2590065552
In [14]: fpga.write_int('counter_control',0)
In [15]: fpga.read_uint('counter_value')
Out[15]: 1159837158
In [16]: fpga.read_uint('counter_value')
Out[16]: 1159837158
In [17]: fpga.write_int('counter_control',2)
In [18]: fpga.read_uint('counter_value')
Out[18]: 0

We can see that the counter starts at 0 and does not start counting until it receives the proper signal in the proper
register. We can also see that the counter wraps properly, and stops and resets as expected according the signals and
registers we designed. Note that read_uint() is used here to read the counter properly (otherwise it would have
reported a negative value half the time).
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Conclusion
In this tutorial, you have gone through the process of using startsg to initiate the toolflow, used Simulink to create a
design, called jasper to compile and obtain a .fpg and .dtbo file, and use casperfpga to program and interact
with your rfsoc board. Congratulations!

2.1.18 Tutorial 2: The RFDC Interface
Introduction
In this tutorial we introduce the RFDC Yellow Block and its configuration interface for dual- and quad-tile RFSoCs
with a simple design that captures ADC samples and places them in a BRAM. Software control of the RFDC through
casperfgpa is also demonstrated with captured samples read back and briefly analyzed. This tutorial assumes
you have already setup your CASPER development environment as described in the Getting Started tutorial and
are familiar with the fundamentals of starting a CASPER design and communicating with your rfsoc board using
casperfpga from the previous tutorial
The Example Design
In this example we will configure the RFDC for a dual- and quad-tile RFSoC to sample RF signals over a bandwidth
centered at 1500 MHz. There are a few different ways this could be accomplished between the two different tile
architectures of the RFSoC on these platforms. However, in this tutorial we target configuration settings that are as
common as possible, use a various number of the RFDC features, yet still be able to point out a some of the differences
between the quad- and dual- tile architectures of the RFSoC. Where platform specific settings are required beyond what
is needed as a quad- or dual-tile RFSoC those differences will be identifed.
This design will:
• Set sample rates appropriate for the different architectures
• Use the internal PLLs to generate the sample clock
• Output complex basebanded I/Q samples
• Use the decimator
• Use the fine frequency mixer (NCO)
• Set the target Nyquist zone
To get a picture of where we are headed, the final design will look like this for quad-tile platforms:
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And this for dual-tile platforms:
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This design is a “snapshot” capture on two inputs on quad-tile platforms and one input on dual-tile platforms placing
raw ADC samples in a BRAM that are read out using casperfpga for analysis. The design could easily be extended
with more snapshot blocks to capture outputs from the remaining ports but what is shown here is sufficient for the scope
of this tutorial.
Step 1: Add the XSG and RFSoC platform yellow block
Add a Xilinx System Generator block and a platform yellow block to the design, as demonstrated in tutorial
1. While the above example layouts used the ZCU111 as the example for a dual-tile RFSoC and the ZCU216 as
the example for a quad-tile platform, these steps for a design targeting the other RFSoC platforms is similar for its
respective tile architecture.
Configure the User IP Clock Rate and PL Clock Rate for your platform as:
# ZCU216
User IP Clock Rate: 250, RFPLL PL Clock Rate: 125
# ZCU208
User IP Clock Rate: 250, RFPLL PL Clock Rate: 125
# ZCU111
(continues on next page)
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User IP Clock Rate: 245.76, RFPLL PL Clock Rate: 122.88
# RFSoC 4x2
User IP Clock Rate: 245.76, RFPLL PL Clock Rate: 122.88
# RFSoC 2x2
User IP Clock Rate: 245.76, RFPLL PL Clock Rate: 15.36
# ZFR16
User IP Clock Rate: 250, RFPLL PL Clock Rate: 50

Step 2: Place and configure the RFDC yellow block
Add an rfdc yellow block, found in CASPER XPS Blockset->ADCs->rfdc.

The rfdc yellow block automatically understands the target RFSoC part and derives the corresponding tile architecture, subsequently rendering the correct configuration view. For both architecutres the first half of the configuration
view is identical. This is the portion of the configuration that sets the enabled tiles, sample rate, use of internal PLLs,
inclusion of multi-tile synchronization infrastructure, and displays tile clocking information.
For a quad-tile platform configure this section as:
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For a dual-tile platform configure this section as:

The ADC Tile checkboxes will enable or disable the corresponding tile in the design. The tile numbers are in reference to their respective package placement designation. Tile 224 through 227 maps to Tile 0 through 3, respectively.
The rfdc yellow block will redraw after applying changes when a tile is selected. The sample rate for each architecture is automatically checked against the min. and max. sample rates supported for the platform. The Enable Tile
PLLs checkbox will enable the internal PLL for all selected tiles. When this option is enabled the Reference
Clock drop down provides a list of frequencies that can be used to drive the PLLs to generate the sample clock for
the ADCs. If Enable Tile PLLs is not checked, this will display the same value as the Sampling Rate field
indicating the part is expecting an extenral sample clock to drive the ADCs.
A few behaviors to keep in mind:
• The sample rate set is currently applied to all enabled tiles.
• The Required AXI4-Stream Clock field indicates what the User IP Clock Rate of the platform yellow block must be set. There is a DRC within the toolflow that checks to make sure the values
match. However, this does require that the CASPER designer make sure the two fields remain in sync.
• The RFDC IP has an optional adc_clk output for each ADC tile. The Clock Out value indicates
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that selected frequency. Currently, this is not a selectable clock to drive user logic and is therefore not
implemented. RFSoC platform blocks can be extended to target this clock.
• Gen 3 RFSoCs introduce the ability of “clock forwarding” PG269 Ch.4, Clocking between tiles. The
underlying implentation of the rfdc yellow block is aware of the capability as it is required to do DRC
checks to validate the design. The framework therefore exists and needs to be built out. However, the
ability to readily control this from the configuration view is not available yet. Instead, the platform configuration .yaml file currently keys off the rfdc for what to expect regarding how a tile will resolve
receiving its sample clock.
The next configuration section in the GUI configures the operation behavior of the ADCs within a tile. For a quad-tile
platform configure this section as:

For a dual-tile platform configure this section as: .. image:: ../../_static/img/rfsoc/tut_rfdc/rfdc-dt-tile-config.png
Currently, the selected configuration will be replicated across all enabled tiles. Meaning, that for right now, different
ADCs within a tile can be configured differently to the extent that they meet the same required AXI4 stream clock
requirment, but that same behavior will be applied to all tiles equally.
The Enable ADC checkbox enables the corresponding ADC. Under “Data Settings”, Digital Output Data
selects the output format of ADC samples where Real bypasses the mixing signal path and I/Q will use that mixer
providing complex basebanded samples. In this example we select I/Q as the output format using the Fine mixer
setting allowing for us to tune the NCO frequency. For more information on the capabilities of both the coarse and fine
mixer and NCO examples see PG269 Ch.4, RF-ADC Mixer with Numerical Controlled Oscillator.
The Decimation Mode drop down displays the available decimation rates that can be applied for the generation
platform targeted. Sample per AXI4-Stream Cycle indicate how many 16-bit ADC words are output per
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clock cycle. The Required AXI4-Stream clock field here displays the effective User IP clock that would be
required for the configuration of the decimator and number of samples per clock. These fields are to match for all
ADCs within a tile.
The Nyquist Zone setting selects either the first (odd, 0 <= f <= fs/2) or second (even, fs/2 <= f <= fs). In this
example, for the quad-tile we target Zone 2 with an NCO Frequency of 0.5 and the dual-tile has Zone 1 with
an NCO Frequency of -1.5.
With these configurations applied to the rfdc yellow block, both the quad- and dual-tiles are outputting 4 adc words
(64-bit) complex basebanded I/Q data centered at 1500 MHz. In the case of the quad-tile design with a sample rate of
2000 Msps and decimation of 4x the effective bandwidth spans from 1250 to 1750 MHz. For the dual-tile design
the effective bandwidth spans approx. from 1008.5 MHz to 1990.5 MHz.
Step 3: Update the platform yellow block
As mentioned above, when configuring the rfdc the yellow block reports the required AXI4-Stream sample clock.
This corresponds to the User IP Clk Rate of the platform block. In this step that field for the platform yellow
block would be updated to match what the rfdc reports, along with the RFPLL PL Clk frequency that will be
generating the clock used for the user design.
It is possible that for this tutorial nothing is needed to be done here, but it is a reminder that in general this will need
to be done.
Step 4: Place and configure the Snapshot blocks
Next we want to be able to capture the data the ADCs are producing. The green bitfield_snapshot block from
the CASPER DSP Blockset library can be used to do this. Add a bitfield_snapshot block to the design, found
in CASPER DSP Blockset->Scopes->bitfield_snapshot.
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Configure the snapshot block as follows:
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Now we hook up the bitfield_snapshot block to our rfdc block. In its current configuration, the snapshot
block takes two data inputs, a write enable, and a trigger. For both quad- and dual-tile platforms, wire the first two
data output streams from the rfdc to the two in_* ports of the snapshot block.
For the quad-tile platforms this is m00_axis_tdata and m10_axis_tdata. The first digit in the signal name
corresponds to the tile index, 0 for the first, 1 for the second, etc. The second digit in the signal name corresponds to
the adc index, in this case 0 is the first ADC input on each tile. In both Real and I/Q digital output modes quad-tile
platforms output all data bits on the same bus. So in this example, with 4 samples per clock this results in 2 complex
samples ordered {I1, Q1, I0, Q0}. Where in each ADC word, the most recent sample is at the MSB of the
word. With the snapshot block configured to capture 2^14 128-bit words this is a total of 2^15 complex samples
on both ports.
For dual-tile platforms in I/Q digital output modes, the inphase and quadarature data are produced from different
ports. In this mode the first digit of the signal name corresponds ot the tile index just as in the quad-tile. But the
second digit is 0 for inphase and 1 for quadrature data. In this example then, with 4 sample per clock this is 4
complex samples with the two complex components coming from different ports, m00_axis_tdata for inphase
data ordered {I3, I2, I1, I0} and m01_axis_tdata with quadrature data ordered {Q3, Q2, Q1, Q0}.
When configured in Real digital output mode the second digit is 0 for the first ADC and 2 for the second. With the
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snapshot block configured to capture 2^14 128-bit words this is a total of 2^16 complex samples for the one port.
Next, we’re just going to leave write enable high, so add a blue Xilinx constant block (Xilinx Blockset->Basic
Elements->Constant), connect it to the snapshot we port, and configure it as follows:
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A blue Xilinx block is used here instead of a white simulink block because we want the constant 1 to exist in the
synthesized hardware design.
Lastly, we want to be able to trigger the snapshot block on command in software.
To do this,
we will use a yellow software_register and a green edge_detect block (CASPER DSP
Blockset->Misc->edge_detect).
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Set the I/O direction of the software register to From Software, change the Bitfield names to [start],
set Bitfield widths to 1 and Bitfield types to 2. Connect this blocks output to the input of the edge
detect block. Rename the register to snapshot_ctrl. This is the name for the register that is visible in software.
Remember this name for later should you name it differently. Connect the output of the edge detect block to the trigger
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port on the snapshot block. Now when we write a 1 to the software register, it will be converted into a pulse to trigger
the snapshot block.
Step 5: Validate the design
The design is now complete! For a quad-tile platform it should have turned out like:

And this for dual-tile platforms:
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You can connect some simulink constant blocks to get rid of simulink unconnected port warnings, or leave them if they
do not bother your. Validate the design by running the simulation. In this case, there’s nothing to see in the simulation,
but can press ctrl+d to only update and validate the diagrams connections and that port widths and data types are
consistent. Make sure to save!
Step 6: Build!
As explained in tutorial 2, all you have to do to build the design is run the jasper command in the MATLAB
command window, assuming your environment was set up correctly and you started MATLAB by using the startsg
command. The toolflow will take over from there and eventually produce an .fpg file. When running this example,
depending on your build machine hardware synthesis could take from 15-30 minutes.
As briefly explained in the first tutorial the toolflow will run one extra step that previous users may now notice. After
Vivado syntheis and bitstream generation the toolflow exports the platform hardware definition to use Xilinx’s software
tools (the Vitis flow) to generate software produts to interface with the hardware design.
In this step the software platform hardware definition is read parsing the design for IP with an associated software
driver. This is done in two steps, the hardware platform is ran first against Xilinx software tools and then a second
pass is taken augmenting those output products as neccessary with any CASPER specificy additions. The result is any
software drivers that interact with user IP. In the case of the previous tutorial there was no IP with a corresponding
driver (other than the underlying Zynq processor). However, here we are using the rfdc that has a fully configurable
software component that we want to communicate with in software. The resulting output at this step is the .dtbo or
2.1. Vivado
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device tree binary overlay which is a binary representation of the device tree containing information for
software dirvers that is is applied at runtime in software after the new bitstream is programmed.
Note: For the RFDC casperfpga object and corresponding software driver to function correctly this .dtbo must
be created and when programming the board must reside in the same level with the same name as the .fpg (but using
the .dtbo extension) when using casperfpga for programming.
Make sure then that the final bit of
tut_rfdc-YYYY-MM-dd-hh-mm.dtbo.

output

of

the

toolflow

build

now

reports

Created

Testing the Design
Before starting this segment power-cycle the board. This is to force a hard reset of the on-board RFPLL clocking
network. After the board has rebooted, start IPython and establish a connection to the board using casperfpga in
the normal way.
$ ipython
In [1]: import casperfpga
In [2]: zcu216 = casperfpga.CasperFpga('192.168.2.101')
In [3]: zcu216.upload_to_ram_and_program('/path/to/tut_rfdc.fpg')

This is our first design with the RFDC in it. When the RFDC is part of a CASPER design the toolflow automatically
includes meta information to indicate to casperfpga that it should instantiate an RFDC object that we can use to
manipulate and interact with the software driver components of the RFDC.
In [4]: zcu216.adcs
Out[4]: ['rfdc']

We can create a reference to that RFDC object and begin to exercise some of the software components included with
the that object.
In [5]: rfdc_zcu216 = zcu216.adcs['rfdc']

We first initialize the driver; a doc string is provided for all functions and so we can always use IPythons help ?
mechanism to get more information of a methods signature and a brief description of its functionality.
In [6]: rfdc_zcu216.init?
Signature: rfdc.init(lmk_file=None, lmx_file=None, upload=False)
Docstring:
Initialize the rfdc driver, optionally program rfplls if file is present.
Args:
lmk_file (string, optional): lmk tics hexdump (.txt) register file name
lmx_file (string, optional): lmx tics hexdump (.txt) register file name
upload (bool, optional): inidicate that the configuration files are local to the
˓→client and
should be uploaded to the remote, will overwrite if exists on remote filesystem
Returns:
True if completed successfully
Raises:
KatcpRequestFail if KatcpTransport encounters an error
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The init() method allows for optional programming of the on-board PLLs but, to demonstrate some more of the
casperfpga RFDC object functionality run init() without any arguments. This simply initializes the underlying
software driver with configuration parameters for future use.
In [7]: rfdc_zcu216.init()
Out[7]: True

We can query the status of the rfdc using status()
In [8]: rfdc_zcu216.status()
ADC0: Enabled 1, State: 6 PLL:
ADC1: Enabled 1, State: 6 PLL:
ADC2: Enabled 1, State: 6 PLL:
ADC3: Enabled 1, State: 6 PLL:
Out[8]: True

0
0
0
0

the status() method displys the enabled ADCs, current “power-up sequence” state information of the tile and the
state of the tile PLL (locked, or not). This information can be helpful as a first glance in debugging the RFDC should
the behavior not match the expected. The mapping of the State value to its significance is found in PG269 Ch.4,
Power-on Sequence. In this case 6 indicates that the tile is waiting on a valid sample clock.
Note: RFSoC2x2 only provides a sample clock to tile 0 and 1 and as it uses a Gen 1 part that does not have the ability
to forward sample clocks tiles 1 and 3 for that platform will always halt at State: 6.
As the board was power-cycled before programming any configuration of the on-board PLLs was reset. To advance the
power-on sequence state machine to completion we need to program the PLLs. The RFDC object incorporates a few
helper methods to program the PLLs and manage the available register files: progpll(), show_clk_files(),
upload_clk_file(), del_clk_file().
First take a look at progpll():
In [9]: rfdc_zcu216.progpll?
Signature: rfdc.progpll(plltype, fpath=None, upload=False, port=None)
Docstring:
Program target RFPLL named by ``plltype`` with tics hexdump (.txt) register file
˓→named by
``fpath``. Optionally upload the register file to the remote
Args:
plltype (string): options are 'lmk' or 'lmx'
fpath (string, optional): local path to a tics hexdump register file, or the name
˓→of an
available remote tics register file, default is that tcpboprphserver will look
˓→for a file
called ``rfpll.txt``
upload (bool): inidicate that the configuration file is local to the client and
should be uploaded to the remote, this will overwrite any clock file on the remote
by the same name
port (int, optional): port to use for upload, default to ``None`` using a random
˓→port.
Returns:
True if completes successfuly
Raises:
KatcpRequestFail if KatcpTransport encounters an error

To program a PLL we provide the target PLL type and the name of the configuration file to use. Optionally, we can
upload a file for later use. With upload set to False this indicates that the target file already exists on the remote
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processor for PLL programming. As the current CASPER supported RFSoC platforms use various TI LMX/LMX
chips as part of the RFPLL clocking infrastructure the progpll() method is able to parse any hexdump export of a
TI TICS Pro file (the .txt formatted file).
show_clk_files() will return a list of the available clock files that are available for reuse; The distributed
CASPER image for each platform provides the clock files needed for this tutorial. We use those clock files with
progpll() to initialize the sample clock and finish the RFDC power-on sequence state machine. Follow the code
relevant for your selected target (make sure to have reviewed your platforms [page](./readme.md#platforms) for any
required setup):
# clock files for different platforms
# ZCU216
In [10]: c = rfdc_zcu216.show_clk_files()
In [11]: c
Out[11]: ['250M_PL_125M_SYSREF_10M.txt']
In [12]: rfdc_zcu216.progpll('lmk', c[0])
Out[12]: True
# ZCU111
In [13]: c = rfdc_zcu111.show_clk_files()
In [14]: c
Out[14]: ['122M88_PL_122M88_SYSREF_7M68_clk5_12M8.txt',
'LMX_REF_122M88_OUT_245M76.txt']
In [15]: rfdc_zcu111.progpll('lmk', c[0])
Out[15]: True
In [16]: rfdc_zcu111.progpll('lmx', c[1])
Out[16]: True
# RFSoC 4x2
In [17]: c = rfdc_rfsoc4x2.show_clk_files()
In [18]: c
Out[18]: ['rfsoc4x2_LMX_REF_245M76_OUT_491M52.txt',
'rfsoc4x2_PL_122M88_REF_245M76.txt']
In [19]: rfdc_rfsoc4x2.progpll('lmk', c[1])
Out[19]: True
In [20]: rfdc_rfsoc4x2.progpll('lmx', c[0])
Out[20]: True
# RFSoC 2x2
In [21]: c = rfdc_2x2.show_clk_files()
In [22]: c
Out[22]: ['rfsoc2x2_lmk04832_12M288_PL_15M36_OUT_122M88.txt',
'LMX_REF_122M88_OUT_245M76.txt']
In [23]: rfdc_2x2.progpll('lmk', c[0])
Out[23]: True
(continues on next page)
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In [24]: rfdc_2x2.progpll('lmx', c[1])
Out[24]: True
# ZRF16
In [25]: c = rfdc_zrf16.show_clk_files()
In [26]: c
Out[26]: ['rfsoc2x2_lmk04832_12M288_PL_15M36_OUT_122M88.txt',
'zrf16_LMX_REF_50M_OUT_250M.txt']
In [27]: rfdc_zrf16.progpll('lmk', c[0])
Out[27]: True
In [28]: rfdc_zrf16.progpll('lmx', c[1])
Out[28]: True

With the clocks programmed we can now check the status of the rfdc and it should now report that the tiles have
locked their internall PLLs and have completed the power-on sequence by displaying a state value of 15.
In [25]: rfdc_zcu216.status()
ADC0: Enabled 1, State: 15 PLL:
ADC1: Enabled 1, State: 15 PLL:
ADC2: Enabled 1, State: 15 PLL:
ADC3: Enabled 1, State: 15 PLL:
Out[25]: True

1
1
1
1

The remaning methods, upload_clk_file() and del_clk_file() are available methods used to manage the
clock files available for programming.
The ADC is now sampling and we can begin to interface with our design to copy back samples from the BRAM and
take a look at them. The following are a few helper methods that can be used for this example.
def toSigned(v, bits):
mask = 1 << (bits-1)
return -(v & mask) | (v & (mask-1))
def capture_snapshots(fpga):
snapshot_data = {}
for ss in fpga.snapshots:
ss.arm()
fpga.registers.snapshot_ctrl.write(start='pulse')
for ss in fpga.snapshots:
dat = ss.read(arm=False)['data']
for (k,v) in dat.items():
snapshot_data[k] = v
return snapshot_data
def deinterleave_dual(I, Q, bits=16):
x = []
for (i, q) in zip(I, Q):
I0 = toSigned(0xffff & (i >> 0) ,
I1 = toSigned(0xffff & (i >> 16),
I2 = toSigned(0xffff & (i >> 32),
I3 = toSigned(0xffff & (i >> 48),

bits)
bits)
bits)
bits)
(continues on next page)
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Q0
Q1
Q2
Q3

=
=
=
=

toSigned(0xffff
toSigned(0xffff
toSigned(0xffff
toSigned(0xffff

x0
x1
x2
x3

=
=
=
=

I0
I1
I2
I3

+
+
+
+

&
&
&
&

(q
(q
(q
(q

>>
>>
>>
>>

0) ,
16),
32),
48),

bits)
bits)
bits)
bits)

1j*Q0
1j*Q1
1j*Q2
1j*Q3

x.append(x0)
x.append(x1)
x.append(x2)
x.append(x3)
return x
def deinterleave_quad(samples, bits=16):
x = []
for s in samples:
I0 = toSigned(0xffff & (s >> 0) , bits)
Q0 = toSigned(0xffff & (s >> 16), bits)
I1 = toSigned(0xffff & (s >> 32), bits)
Q1 = toSigned(0xffff & (s >> 48), bits)
x0 = I0 + 1j*Q0
x1 = I1 + 1j*Q1
x.append(x0)
x.append(x1)
return x

The capture_snapshot() method help extract data from the snapshot block by iterating over the snapshot blocks
in this design (only one right now) and arming them to look for a pulse event and then toggles the software register
snapshot_ctrl to trigger the capture event. If in the design process this software register name is different than
shown here that would need to be updated in this method. Same with the bitfield name of the software register.
Here it was called start when configuring software register yellow block.
Using these methods to capture data for a quad- or dual-tile platform and then plotting the first few time samples for
the real part of the signal would look something like the following (make sure to replace the fpga variable with your
casperfpga object instance):
import numpy as np
import matplotlib.pyplot as plt
# quad-tile
def qt_capture(fpga):
adc_dat = capture_snapshots(fpga)
m00 = adc_dat['m00']
m10 = adc_dat['m10']
x_m00 = np.array(deinterleave_quad(m00, 16))
x_m10 = np.array(deinterleave_quad(m10, 16))
return (x_m00, x_m10)
(continues on next page)
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N = 100
n = np.arange(0,N)
x_m00, x_m10 = qt_capture(fpga)
fig, ax = plt.subplots(2,1, sharey='row')
ax[0].plot(n, np.real(x_m00[0:N])); ax[0].set_title('Tile 0 Ch.0'); ax[0].grid(True);
ax[1].plot(n, np.real(x_m10[0:N])); ax[1].set_title('Tile 1 Ch.0'); ax[1].grid(True);
˓→plt.show();
# dual-tile
def dt_capture(fpga):
adc_dat = capture_snapshots(fpga)
I = adc_dat['m00']
Q = adc_dat['m01']
x = np.array(deinterleave_dual(I, Q, 16))
return x
N = 100
n = np.arange(0, N)
x = dt_capture(fpga)
plt.plot(np.real(x[0:N])); plt.title('Tile 0 Ch.0'); plt.grid(); plt.show();

Conclusion
In this tutorial it was shown how to configure and use the rfdc yellow block for both dual- and quad-tile RFSoC
platforms. An example design was built for both architectures sampling an RF signal centered in a band at 1500 MHz.
It was shown how to use casperfpga to access the RFDC object, initialize the driver, and use some of the methods
provided to program the onboard PLLs. The example design allowed us to capture samples into a BRAM and read
those back into software for more analysis.

2.1.19 Tutorial 3: Example Spectrometer
Introduction
In this tutorial will go over building a simple spectrometer using CASPER DSP and hardware yellow blocks for
RFSoC.
This tutorial assumes that the casper-ite is familiar wth the RFDC Interface tutorial. This also assumes that the
CASPER development environment is setup for RFSoC as described in the Getting Started tutorial. A brief walkthrough of example of the spectrometer design, software control of the spectrometer will be given in this tutorial.
However, it is also beneficial to become learn how to interact with the FPGA using casperfpga as demonstrated in
the simulink platform introduction.
A spectrometer is an analysis filter bank that takes for its input a time domain signal and transforms it to a frequency
domain representation. In digital systems, this is typically achieved by utilising the FFT (Fast Fourier Transform)
algorithm. However, with a modest increase in compute, better spectral bin performance can be improved by using a
Polyphase Filter Bank (PFB) based approach.
When designing a spectrometer for astronomical applications, it is important to consider the target science case. For
example, pulsar timing searches typically require a spectrometer that can dump spectra on short timescales. This allows
the rate of change of the spectral content to be finely observed. In contrast, a deep field HI survey will accumulate
multiple spectra to increase the signal to noise ratio above a detectable threshold. It is important to note that “bigger
isn’t always better” here; the higher your spectral and time resolution are, the more data your computer (and scientist
on the other end) will have to deal with. For now however, we skip the target science case and rather look to more
familiarize ourselves with an example spectrometer design.
2.1. Vivado
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Setup
This tutorial comes with a completed simulink model files for RFSoC platforms. There are different examples for
configuring the RFSoC in different operational modes. Those files can be found here.
Spectrometer Basics
When designing a spectrometer there are a few main parameters of note:
• Bandwidth: The width of your frequency spectrum, in Hz. This depends on the sampling rate; for complex
sampled data this is equivalent to:

In contrast, for real or Nyquist sampled data the rate is half this:

as two samples are required to reconstruct a given waveform.
• Frequency resolution: The frequency resolution of a spectrometer, ∆f, is given by:

and is the width of each frequency bin. This parameter is a measure of how precise you can measure a frequency, or
rather its frequency resolution.
• Time resolution: Time resolution is simply the spectral dump rate of your instrument. We generally accumulate
multiple spectra to average out noise; the more accumulations we do, the lower the time resolution. For looking
at short timescale events, such as pulsar bursts, higher time resolution is necessary; conversely, if we want to
look at a weak HI signal, a long accumulation time is required, so time resolution is less important.
Simulink / CASPER Toolflow
Simulink Design Overview
If you’re reading this, hopefully you’ve managed to find the model files. Open a model file of your choice and have a
look around to start to get a vague idea of what’s happening. The best way to understand fully is to follow the dataflow
arrows starting from the RFDC. Then read a few of the comment boxes and design annotations. Also, it is worthwhile
to go through what each block is doing and make sure you know why each block is configured the way it is. To help
you through, there is some “blockumentation” in the following part of the tutorial. That blockumentation will try to
highlight some of the important ports and parameters to the blocks and their configuration to help guide to answers for
the questions you may have.
A brief rundown of some top-level details are as follows before you get down and dirty:
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• There are two styles of spectrometer tutorial model files. One that configures the RFDC data output mode
to output in real sample mode. The others configure the RFDC to use the digital down converter and output
complex data samples from the RFDC.
• The comment boxes above the RFDC yellow block in these model spectrometer designs comment on the RFDC
sample rate, output data type, and number of samples per clock on the output interface of the RFDC.
• The all-important Xilinx token is placed to allow System Generator to be called to compile the design.
• In the platform yellow block, the hardware Platform is set to the target RFSoC platform (e.g.,
“ZCU216:xczu49dr”) and the User IP clock rate must be specified. Recall from the RFDC Interface that the
User IP Clock Rate (MHz) field must match the reported clock rate in the RFDC yellow block.
• Input signals are digitized by the RFDC. These samples presented in parallel at the output of the RFDC each
clock cycle. The output data type will be expressed as a simulink fixed point integers (e.g., fix_128_0).
• The parallel time samples pass through the pfb_fir_real and fft_wideband_real blocks
(pfb_fir and fft blocks when the RFDC is configured to output complex data samples). Together these
blocks implement a polyphase filter bank.
• When the data output is real from the RFDC the FFT size is selected to be 212 = 4096 points. Because the
CASPER wideband FFT outputs only the positive frequency bins we will have a 211 = 2048 channel filter bank.
• When the data output is complex from the RFDC the FFT size is selected to be 211 = 2048.
• You may notice Xilinx delay blocks dotted all over the design. It’s common practice to add these into the
design as helps the design meet timing. It consumes more resources, but eases signal timing-induced placement
restrictions.
• The frequency bin outputs of the PFB passed through power blocks. This block converts from complex-valued
outputs to real-valued power.
• The bin power enters the vector accumulators, vacc0 and vacc1. These are simple_bram_vacc 64-bit vector
accumulators. Accumulation length is controlled by the acc_cntrl block. The accumulation length is set in
software controlled by casperfpga.
• The accumulated signal is then fed into a BRAM yellow blocks.
Continue further to familiarize yourself with the model file. Clicking around, opening configuration windows and
refer to the blockumentation as needed.
RFDC
The first step to creating a frequency spectrum is to digitize the signal. This is done with an ADC (analog-to-digital
converter). For RFSoC, the ADC is represented by the RFDC (RF Data Converter) yellow block. Work through the
RFDC tutorial if you not already familiar with this block.
The RFDC converts analog inputs to digital outputs. Every clock cycle, the inputs are sampled and digitized to a 14bit, 2’s complement binary number representation. These samples are packed and MSB aligned into 16-bit words and
presented in parallel on the output interface. This means we can represent numbers from -32768 through to 32767,
including the number 0. Simulink represents such numbers as a fix_32_0 data type. As an example, when the RFDC
is configured in real mode with 8 samples per clock, the output data type is fix_128_0. For more information about
the output data representation of the RFDC refer to the RFDC product guide.
Recall from the RFDC tutorial that when the RFDC is configured in real -> I/Q output mode quad-tile and
dual-tile RFSoCs have differing behavior. For dual-tile platforms, in both Real and I/Q digital output modes these
platforms output all data bits on the same bus. So for example, with 4 samples per clock this results in 2 complex
samples ordered {I1, Q1, I0, Q0}. Where in each ADC word, the most recent sample is at the MSB of the
word.
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For dual-tile platforms in I/Q digital output modes, the inphase and quadarature data are produced from different
ports. In this mode the first digit of the signal name corresponds ot the tile index (same for quad-tiles). But, the second
digit is 0 for inphase and 1 for quadrature data from the first ADC on the tile. The second ADC will then have 2
for inphase data and 3 for quadrature data. For example, with 4 sample per clock this is 4 complex samples with the
two complex components coming from different ports, m00_axis_tdata for inphase data on tile 0 ADC 0 ordered
{I3, I2, I1, I0} and m01_axis_tdata for tile 0 ADC 1 with quadrature data ordered {Q3, Q2, Q1,
Q0}. When configured in Real digital output mode the second digit is 0 for the first ADC and 2 for the second.
Block Configuration The following configuration examples are for the RFDC from the rfsoc4x2_tut_spec.
slx model file. Refer to the RFDC block in each model file for their respective configuration.
For the RFSoC 4x2, each tile tab is configured the same with Enable Tile selected and clock configuration set
as follows.Note that the Required AXI4-Stream Clock (MHz) field matches the clock of the RFSoC 4x2
platform block.

Each of the ADCs are configured as shown in the following following image. The output data mode is Real with decimation factor set to 2x and 8 samples per cycle. This will present an interface with simulink data type fix_128_0
to the design.
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When operating the RFSoC 4x2 with the complex data mode spectrometer example (rfsoc4x2_tut_spec_cx.
slx) the ADC tiles are configured as shown in the following image. The output data mode is now I/Q still with a
decimation factor of 2x and 8 samples per clock. The Mixer Type is set to Fine with Real -> I/Q mode
enabled and the NCO frequency set to -0.98304. Refer again to the RFDC tutorial and the RFDC product guide for
how these parameters affect the RFDC operation. But, the result is that with the digital down converter active the input
signal is first shifted by the fine frequency mixer and then passed through to the decimation filters.

Munge blocks
The munge blocks in these designs are responsible for reordering the output data from the RFDC. This is required
because the RFDC outputs time samples with the newest time samples in the MSB and CASPER blocks want the
oldest sample in the MSB (top of CASPER blocks, e.g., port 0). When the RFDC is configured to output the 8 real
samples this just reversing the word order as shown in the following image for the munge block configuration.
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With quad-tile platforms (e.g., ZCU216) when configured to output complex samples it is the same approach. This is
because the samples are interleaved real/imaginary on the same bus. This translates to changes in the munge block to
adjust the bitwidths and division sizes.
With the RFSoC 4x2 and other dual-tile platforms, when configured to output complex samples we have to build the
interleaved real/imaginary samples before sending them to the pfb_fir block. To do this, the real and imaginary
parts of the samples coming from the output of the RFDC on their respective interfaces are first combined with a
bus_create block. The munge then reorders the blocks. The following figure graphical shows how the divisions
are reordered and their respective index for when the output is 4 samples per clock. Here I<#> represents the real
time sample at sample index # and the same for Q<#> but corresponding to the imaginary sample. In these examples,
I3 and Q3 correspond to the newest time sample and I0 and Q0 are the oldest.
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The colors in this figure are used to track the sample input position relative to the output position. Also note that
that the “munge reorder index” column places the 0-th element at the MSB with the highest value at the LSB.
The 3rd column top-to-bottom is then what is input to the Division Packing Order field of the munge
block. The resulting vector used in as the munge block parameter is the reordered column entered top to bottom
from this table. In the RFSoC 4x2 design there are 8 samples per clock. Take a look at the munge block in the
rfsoc4x2_tut_spec_cx.slx model and this example to see if you can follow how the complex samples are
created.
Polyphase FIRs
There are two main blocks required for a polyphase filter bank. The first is a polyphase FIR block and the second is
the FFT. Depending on the input data type DSP different blocks can be used to take save hardware resources when
possible. For real valued time samples the pfb_fir_real block is used. When the data are complex the pfb_fir is used
instead. A polyphase FIR works by dividing the input time signal into parallel “taps” then applies finite impulse
response filters (FIR). The output of this block is still a time-domain signal. When combined with an FFT, this
constitutes a polyphase filter bank. The fft_wideband_real block is used following the pfb_fir. The fft block is follows
the pfb_fir. The complex valued inputs are the generalized implementation of these DSP algorithms. Review the
real-valued and complex-valued RFSoC example designs to see more of the differences.
The following descriptions are for the pfb_fir_real block but the general pfb is configured similar.
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INPUTS/OUTPUTS
Port
sync
pol<#>_in<#>

Data Type
bool
inherited

Description
A sync pulse should be connected here.
The (real) time-domain stream(s).

PARAMETERS
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Parameter
Size of PFB

Description
This parameter is to match the FFT size we are to have.

Number of taps
The number of taps in the PFB FIR filter. Each tap uses
2 real multiplier
cores and requires buffering the data streams for
2*PFBSize samples.
Generally, more taps means less inter-channel spectral
leakage, but more
logic is used. There are diminishing returns after about
8 taps or so.
Windowing function
Which windowing function to use (this allows trading
passband ripple for
steepness of rolloff, etc). Hamming is the default and
best for most
purposes.

Number of Simultaneous
Inputs

The number of parallel time samples which are
presented to the core
each clock.

Make biplex
0 (not making it biplex) is default. Double up the
inputs to match with a
biplex FFT.
Input bitwidth
The number of bits in each real and imaginary sample
input to the PFB. The
ADC outputs 16-bit data.
Output bitwidth
The number of bits in each real and imaginary sample
output from the PFB.
This should match the bit width in the FFT that
follows. 18 bits is
recommended as a minimum. Recommended values
depend on the DSP
architecture for the FPGA.
Coefficient bitwidth

2.1. Vivado
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than or equal to the input bit width.
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CASPER FFTs
The FFT block you use is is the most important part of the design to understand. The cool green of the FFT blocks
hide the complex and confusing FFT butterfly biplex algorithms that are under the hood. You do need to have a
working knowledge of it though, so I recommend reading Chapter 8 and Chapter 12 of Smith’s free online DSP guide
at (http://www.dspguide.com/). Parts of the documentation below are taken from the fft_wideband_real block
documentation. When the RFDC outputs complex time samples the fft block needs to be used instead. Similarly, see
the fft block documentation for more information.

INPUTS/OUTPUTS
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Port
sync

Description
Like many of the blocks, the FFT needs a heartbeat to
keep it sync’d.

shift
Sets the shifting schedule through the FFT. Bit 0
specifies the behavior of stage 0, bit 1 of stage 1, and
so on. If a stage is set to shift (with bit = 1), then every
sample is divided by 2 at the output of that
stage. This strategy will always prevent overflow. This
is the strategy chosen in these deigns.
in<#>

Input data (real for wideband fft, complex for general
fft)

out<#>
The number of ports is the number of simultaneous bin
outputs produces. For a real input signal, the outputs
FFTs spectrum’s left and right halves are mirror images
(complex conjugate symmetric). The block does not
output the imaginary (negative channel) indices.
Thus, for a 4096-point FFT, 2048 channels are output.
This is why there are half the number of parallel
outputs. Each of these parallel FFT outputs will
produce sequential channels on every clock cycle. On
the
first clock cycle (after a sync pulse, which denotes the
start), frequency channel zero is on port 0,
frequency channel one is on port 1 and so forth. Each
of those are now complex-valued numbers. Then on the
clock cycle this process repeats where the previous bin
count left off.

PARAMETERS
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Parameter
Size of FFT

Description
How many points the FFT will have. The number of
output channels will be
half this when the wideband real fft if used as
previously explained.

Input/output bitwidth
The number of bits in each real and imaginary sample
as they are carried
through the FFT. Each FFT stage will round numbers
back down to this
number of bits after performing a butterfly
computation. This has to match
what the pfb_fir is throwing out.
Number of simultaneous inputs
The number of parallel time samples which are
presented to the FFT core
each clock.
Coefficient bitwidth
The amount of bits for each coefficient. 18 is default.
Unscramble output
Some reordering is required to make sure the frequency
channels are output
in canonical frequency order. If you’re absolutely
desperate to save as
much RAM and logic as possible you can disable this
processing, but you’ll
have to make sure you account for the scrambling of
the channels in your
downstream software. For now, because our design will
comfortably fit on
the FPGA, leave the unscramble option checked.
Overflow Behavior
Indicates the behavior of the FFT core when the value
of a sample exceeds
what can be expressed in the specified bit width. Here
we’re going to use
Wrap, since Saturate will not make overflow corruption
better behaved.
Add Latency
Mult Latency
BRAM Latency
Convert Latency
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Power

The power block computes the power of a complex number. The power block typically has a latency of 5 and will
compute the power of its input by taking the sum of the squares of its real and imaginary components.
INPUTS/OUTPUTS
Port
c

Direction
IN

Data Type
2*BitWidth Fixed point

Description
A complex number whose
higher BitWidth bits are
its real part and lower
BitWidth bits are its
imaginary part.

power

OUT

UFix_(2*BitWidth)_(2*BitWidth-1) | The computed
power of the input complex number.

PARAMETERS
Parameter
Bit Width

Variable
BitWidth

Description
The number of bits in its input.

Sync Gen
CASPER DSP blocks require a sync pulse as a periodic heartbeat to keep the data path flowing. This can be either a
1 PPS pulse or something generated internal to the design. We use an internal approach in this design with the sync
gen block. For more information about configuring this block please refer to the CASPER Sync Memo for how the
reorders are to be setup for this block if the FFT size were to change in your designs.
Vector Accumulator
The simple_bram_vacc block is used in this design for vector accumulation. Vector growth is approximately 28
bits each second. As the name suggests, the simple_bram_vacc is simpler so it is fine for this demo spectrom2.1. Vivado
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eter. Each vector accumulator will capture a fraction of the total output bandwidth in parallel. This means that the
frequency bins will need to be interleaved to reconstruct the output spectrum when read back out. With N parallel
output frequency bins we will have N vector accumulators, each containing, 2FFT_SIZE /N bins.

PARAMETERS
Parameter
Vector length

Description
The length of the input/output vector. Set to store the
fraction of spectrum as explained above.

no. output bits
As there is bit growth due to accumulation, we need to
set this higher than the input bits.
Binary point (output)
Where the binary point is placed in the accumulated
output.

INPUTS/OUTPUTS
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Port
new_acc

Description
A boolean pulse should be sent to this port to signal a
new accumulation. We can’t directly use the sync
pulse, otherwise this would reset after each spectrum.
The acc_cntrl keeps track of the accumulation
to send this pulse.

din/dout

Data input and output. The output depends on the no.
output bits parameter.

valid
The output of this block will only be valid when it has
finished accumulating (signaled by a boolean pulse
sent to new_acc). This will output a boolean 1 while
the vector is being output, and 0 otherwise.

2.1. Vivado
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Shared BRAMs

The final blocks are shared the BRAMs, which we will read out the values of using the python script.
PARAMETERS
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Parameter
Output data type
Address width

Description
Unsigned
2^(Address width) is the number of Data Width
words of the implemented BRAM. In the this design
it must be set to store at least the number of output bins
each shared bram will receive. Timing
issues can be a problem with bitwidths higher than 13.

Data Width
The Shared BRAM may have a data input/output width
of either 8, 16, 32, 64, or 128 bits. This is
set to match the vector accumulator output.
Data binary point
The binary point should be set to zero. The data going
to the processor will be converted to a
value with this binary point and the output data type.
Initial values
Sample rate

This is a test vector for simulation only.
Set this to 1.

INPUTS/OUTPUTS
Port
Addr
data_in
we
data_out

Description
Address to be written to with the value of data_in, on
that clock, if write enable is high.
The input data.
The write enable port.
Writing the data to a register. This is simply terminated
in the design, as the data has finally reached
its final form and destination.

Software Registers
There are a few control registers, led GPIOs, and snapshot blocks within the design:
• cnt_rst: Counter reset control. Pulse this high to reset all counters back to zero.
• acc_len: Sets the accumulation length. See python script help string for usage.
• sync_cnt: Sync pulse counter. Counts the number of sync pulses issued. Can be used to figure out board uptime
and confirm that your design is being clocked correctly.
• acc_cnt: Accumulation counter. Keeps track of how many accumulations have been done.
• led0_sync: The led0_sync light flashes each time a sync pulse is generated.
• led1_new_acc: This lights up led1 each time a new accumulation is triggered.

2.1. Vivado
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• led2_acc_clip: This lights up led2 whenever clipping is detected.
If you’ve made it to here, congratulations. Take a break and then come back for part two, which explains the second
part of the tutorial – actually getting the spectrometer running, and having a look at some spectra.
Configuration and Control
Hardware Configuration
Make sure the RFSoC platform board is running the proper Linux image as explained in the Getting Started tutorial
and that clocks are running (e.g., ZCU216 requires clocking module board be installed). You will also need test signals
at the inputs of the RFSoC.
The tutorial .slx model files for different platforms are found here. Extending the files to a different platform not yet
provided is possible following this tutorial. Open one of the example model files and run the jasper command in
the matlab command prompt to build the .fpg and .dtbo files (found in model projects outputs/ folder). After
this completes, we can now run and configure casperfpga to communicate with the hardware design to readout
and plot output spectra!
Python
We assume here working with the RFSoC 4x2 and provided rfsoc4x2_tut_spec.py script for reading output.
But, these instructions and files can be extended to other platforms.
There are two prebuilt model files: one using the RFDC configured to output real time samples and the other enabling
the digital down converter to output complex time samples. For the real spectrometer design the RFDC is set to sample
at 3932.16 MHz with a decimation rate of 2x. The spectrometer uses the fft_wideband_real set to a transform
size of 4096. The number of output bins is only the positive frequency with a a size of 2048. This is an effective
bandwidth from 0 to 983.04 MHz. The complex spectrometer design is also set to sample at 3932.16 MHz with a
decimation rate of 2x. However, in this design the fine mixer is used with the NCO set to -983.04 MHz. The FFT
is set to transform to a size of 2048. With sufficient anti-alias filtering the effective bandwidth of this design is from 0
to 1966.08 MHz.
It may be helpful to first run the python script in the two operating modes before going through the script. This can
help identify what the script does by knowing before what is being presented.
To get help information from the script you can run:
python rfsoc4x2_tut_spec.py -h

The general syntax to run the script is as follows. Either an IP address or hostname can be given to connect to the
board. The string real or cx must be provided. This is to setup how to read out and display the spectra. The -b
option is used to program the board with a specified .fpg file. If no file is provided the prebuilt .fpg files are used.
The -a option is used to specify which adc input to plot. The value can be 0, 1, 2, or 3. The default is 0. The -l
option is used to specify the accumulation length. The -s option can be used if you know the design has already been
previously programmed and is running. If not, it will be expected to a problem.
Run in real mode using the prebuilt model. I am assuming here a hostname of rfsoc4x2 for the board:
python rfsoc4x2_tut_spec.py rfsoc4x2 real

Assuming all goes well and with a plot window should appear updating the spectrum periodically, with the spectrum
accumulation count displayed in the title. An example is shown in the following figure. Here a tone at 800 MHz is
present on the input of the RFSoC and appears as expected 800 MHz.
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Now run the complex mode design:
python rfsoc4x2_tut_spec.py rfsoc4x2 cx

Similar to the real mode, a plot should shortly appear. As an example, the same 800 MHz tone is present as shown.

As an example of something more interesting, the following output is from the complex version of the design with
wideband noise filtered to a passband from about 1280-1780 MHz and a tone present in that passband at 1520 MHz.

2.1. Vivado
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Conclusion
If you have followed this tutorial faithfully, you should now know:
• What a spectrometer is and what the important parameters for astronomy are.
• Which CASPER blocks you might want to use to make a spectrometer, and how to connect them up in Simulink.
• How to connect to and control a the RFSoC spectrometer using python scripting.

2.1.20 Tutorial 4: 100GbE
Introduction
This tutorial will introduce and demonstrate functionality of using the 100GbE yellow block with the RFDC over
two parts. The first part is used as a simple example to get familiar with the 100GbE yellow block and to test your
hardware setup. The second part of this tutorial will stream and packetize time samples from the RFDC and send them
over 100GbE to a server and demonstrate a simple catcher and processing script for processing packets received from
the RFSoC.
Contents
• Tutorial 4: 100GbE
– Introduction
* Prerequisites and Common Troubleshooting
– Simulink / CASPER Toolflow
* Part 1: Testing the 100GbE yellow block
* 100 GbE Yellow Block
* Observing Packets at the NIC
* Part 2: Streaming from the RFDC
* RFDC
* Munge blocks
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* Packetizer
– Simple Packet Capture and Processing with Python
* Script Overview
* Running the Scripts
– Conclusion
– Appendix and Reference
* Memory Map and Software Programmable Interface

Prerequisites and Common Troubleshooting
• Make sure the CASPER development environment is setup for RFSoC as described in the Getting Started
tutorial. This includes the initialization of the git submodules.
• The use of the integrated UltraScale+ 100G CMAC requires that the no charge license be downloaded and
included with your licenses. That can be acquired here following the instructions under the section titled “Activation Instructions”. After the license has been added you can check the status of the license using the Vivado
License Manager. This is can be accessed from in Vivado going to Help > Manage License. Or it can be opened
from the Xilinx Information Center (XIC) Manage Installs Tab > Manage License. If the license has succussfully been included a line starting with cmac_usplus should appear in the licenses table. You may need to
refresh the license cache if it has not been updated to reflect the cmac_usplus license. For more license
related issues the managing licenses documentation from Xilinx may help here.
• A 100GbE QSFP28 NIC installed in a server.
• A 100GBASE-SR4 QSFP28 active optical cable (AOC) or 100GBASE-CR4 QSFP28 direct attach copper cable
(DAC). Fiber is recommended as it has been tested more frequently.
• All possible network hardware configurations (transceivers, cables, NICs, etc.) have not been tested and as such
results may vary based on your chosen hardware.
• When working with fiber, the transceivers must be coded to match the vendor for the hardware they plug into
(e.g., NIC, switch). When the pluggable transceiver is to be used with the FPGA the “Generic” coded module
should be purchased. But, in some cases it has been reported that vendor compatible transceivers have worked
with the FPGA. Examples of hardware that would be purchased for using 100GbE between an RFSoC and a
Mellanox 100GbE NIC would be: generic compatible 100GBASE-SR4 module, MTP fiber cable, and Mellanox
Compatible 100GBASE-SR4 module. Other vendor transceivers and fiber should work as long as this scheme
is followed.
• When working with copper, cables longer than 3m may not work well. It is required to check the datasheets for
the NIC (and switch) for compatibility with copper and the supported cable lengths they can drive.
• A 100GbE switch is optional but can be used with this tutorial to switch packets if wanting to test as part of a
larger network.
• This design is (and others will typically always will be) setup to send Jumbo Ethernet packets. If no packets
show up, make sure the NIC (and switch if used) are configured to have their MTU set to 9000 bytes. Otherwise
packets can be filtered out by the OS and not received.
• Configuring the RFDC was covered in the RFDC Interface tutorial. Refer back to this tutorial for any questions
regarding the RFDC or what might be done to change the parameters to fit a different requirement.

2.1. Vivado

329

CASPER Tutorials Documentation, Release 0.1

Simulink / CASPER Toolflow
This tutorial comes with completed simulink model files for a few RFSoC platforms. Those files can be found in the
tutorials design repository. In this tutorial we will be working with the RFSoC 4x2 specific files. These examples
can be used to derive the same functionality for other RFSoC platforms if not already provided, or as a starting
point to extend for use with different application requirements. There are also prebuilt .fpg and .dtbo files in the
prebuilt/ directory.
Part 1: Testing the 100GbE yellow block
Part one of this tutorial will use the rfsoc4x2_tut_onehundred_gbe.slx model file. As with previous tutorials, the best way to get familiar with what is happening in the design is to first explore the model and identify the
blocks in the design. This model does not have a lot going on with it. It is only a minimal working example to get bits
into the 100GbE and begin transmitting. Make sure to also open a few blocks configuration windows to review how
each are configured.
A breif overview of the design:
• The Xilinx System generator Token must be placed in the design.
• Right in the middle is the 100GbE yellow block. This block sends and receives UDP/IPv4 packets. These
tutorials only exercise the transmit capabilities but the receive side of the core is functional. A bit of “blockumentation” follows this section and explains some of the ports and configuration parameters of the block.
• The data tx_data port of the 100GbE yellow block is a 512-bit bus. The incoming data for this design is
a simple 32-bit free-running counter. Since the port is expecting a 512-bit signal a cast block is used to
zero-extend the signal to the required 512-bit width.
• The logic generating the tx_valid is a comparison of the free-running counter against a constant. And the
tx_end_of_frame comes from an edge detect for when there is a falling edge on that valid signal.
• The relational block outputs a tx_valid of high for 132 clocks when the counter is greater than the defined
constant value. With 132 clocks of 64-byte words the total packet payload size is 132*64 = 8448 bytes.
With the additional 42 bytes for Ethernet, IP and UDP the total packet length is 8480 bytes. These are the sizes
of packets we should expect to see coming into the design.
• The end of frame signal is also sent to a pulse extender and drives one of the boards LEDs for some visual
feedback (and satisfaction) that the design is working and transmitting packets.
• The tx_byte_enable is a 64-bit signal and acts as a mask of valid bytes at the tx_data port. This must
be set to all 1's except when transmitting the last valid word of a frame that is less than 512-bits. In this case,
data must be in the lower bits of the 64-byte data bus corresponding to their location in the byte enable signal.
This signal must be continuous in the LSBs.
• The tx_dest_ip is the destination IP address in the IPv4 header of the packet and is hardcoded with a constant
to “10.17.16.10”
• The tx_dest_port is the UDP port and hardcoded to a constant of 60000
When you have recreated this design and have successfully finished the jasper flow, or you want to use the prebuilt
products, go to the section Observing Packets at the NIC for the next step of part 1.
100 GbE Yellow Block
INPUTS/OUTPUTS
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Port
rst

Data Type
bool

tx_data

UFix_512

Description
Resets the core. Active high. Link
is lost entire core re-initialized.
Input data to the core. The least
significant bytes are transmitted
first.

tx_valid

bool
Valid signal indicating the data
present at the tx_data port
should be clocked into the core.
Note that after the end of a frame
the valid signal must be held low
before accepting new data for a
few cycles while the core starts to
flush the internal FIFO.

tx_dest_ip

UFix_32

tx_dest_port

UFix_16

tx_end_of_frame

bool

The destination IP address in the
IPv4 header.
The destination port in the UDP
header.
Indicates that the current valid data
is the last to be clocked into
the core and should begin
transmitting. This must be received
in the
same cycle that a tx_valid is
also asserted. After the end of a
frame has been received the
tx_valid must remain low for a
few
cycles to flush the internal FIFOs of
the core.

tx_byte_enable

UFix_64
64-bit signal and acts as a mask of
valid bytes at the tx_data
port. This must be set to all 1's
except when
transmitting the last valid word of a
frame that is less than
512-bits. In this case, data must be
in the lower bits of the
64-byte data bus corresponding to
their location in the byte enable
signal. This signal must be
continuous in the LSBs.
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Parameter
Port

Description
Indicates the physical port this core will map to on
platforms where
multiple physical QSFP28 interfaces are present.

Shallow RX FIFO
Used to limit the amount of memory allocated to the
RX FIFO. When RAM
is a limited resource for designs this can save on RAM
but the DSP
must be ready to receive data without overruning the
FIFO.
Enable Large TX Frames
Incoming pipeline delay

Enables the support for Jumbo frames
The number of registers to add for pipelining on the
input. This may
help a design where timing is tight.

Enable fabric on startup
Use default parameters to initialize fields for
Ethernet/IPv4/UDP
frames. All configuration parameters and ARP cache is
also software
programmable.
Fabric MAC address
Initial value of the MAC address used as the source
MAC address in the
Ethernet frame. Software programmable after startup.
Fabric IP address
Initial value of the source IP address used in the IPv4
frame of the
packet. Software programmable after startup.
Fabric UDP port
Initial value of the source port used used in the UDP
frame of the
packet. Software programmable after startup.
Fabric gateway
The last octet of the gateway residing in the same
subnet as the core
using subnet mask 255.255.255.0.
Enable CPU RX
Enable CPU TX
2.1.
TTLVivado

Not implemented
Not implemented
Time to live value used in packets
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Observing Packets at the NIC
Using the prebuilt rfsoc4x2_tut_onehundred_gbe output products or one that you have produced from recreating the tutorial it is now time to program the FPGA and begin to observe packets at the NIC. The 100GbE tutorial
design is setup to begin transmitting after being programmed without needing to pull anything out of reset. The
100GbE CMAC is setup to use RS-FEC by default and so after programming there is a small training period on the
link to establish a complete connection and begin transmitting.
Before programming the RFSoC platform, make sure the cable connection is made between the RFSoC and server,
you know the name of the ethernet interface that the 100GbE is assigned (e.g., eth0 or in the predictable name format
like enp*), and have an application such as wireshark on the connected server. Note that using wireshark and other
packet sniffer applications to capture and analyze raw ethernet packets by default requires elevated (root) permissions
to operate.
With this in mind all that is needed is to connect to the RFSoC platform and program the FPGA.
import casperfpga
rfsoc = casperfpga.CasperFpga('<ip_address_or_hostname>')
rfsoc.upload_to_ram_and_program('</path/to>/rfsoc4x2_tut_onehundred_gbe.fpg')

After a short period of time packets should begin to appear at the NIC and presented by the capture utility. The
following is an example screenshot from wireshark.
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In this screenshot the end of the UDP header is highlighted showing the source and destination ports. The very next
sequence of bytes begins the packet payload and we can see the 32-bit counter value is present. The counter value is
incrementing by one with each new 64-byte segment.
Part 2: Streaming from the RFDC
In this part of the tutorial, instead of transmitting data from a free-running counter we now interface with the
RFDC buffering time samples and sending them to the 100GbE yellow block. A python script is then used to capture, parse, perform a simple spectrometer operation, and plot the spectra. The model file for this design is the
rfsoc4x2_stream_rfdc_100g.slx. Prebuilt products for this are also provided in the prebuilt/ directory
with the python scripts in the py/ directory.
Open the model file and look over the design. There is a little more going on this time, but if having previously
completed the RFDC interface or example spectrometer tutorials some of the components of the design may already
be familiar. Follow the flow of the RFDC data samples from the RFDC through to the 100GbE. The following is an
overview of some of the models componets:
2.1. Vivado
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RFDC
The RFDC is configured similar to the parameters that were chosen in the example spectrometer tutorial. Review that
tutorial again if there are any questions regarding the setup of the RFDC.
Munge blocks
Because we will ultimately be working with this data in the server we will need to packetize the data. The way this
is done is an implementation dependent decision. Therefore, for reasons similar to the example spectrometer tutorial
where samples were expected in a particular order for the DSP blocks we again use munge blocks on the output of the
RFDC for bit-twiddling to reorder the ADC samples in a way that will make parsing the packets in the server more
convenient.
Recall that different RFSoC platforms have different ADC tile architectures: quad- and dual-tile. The way data is
presented on their interfaces is dependent on the the data output mode configuration: Real or I/Q. Quad- and dualtile platforms present the data in different between the different configurations of their output data type. Revist the
RFDC interface tutorial and example spectrometer tutorial where this is explained a little more. The RFDC product
guide PG269 is also an important reference whenever questions of the RFDC come up.
For working with samples at the server we choose here to reorder the data to have complex (real/imaginary) ordered
samples with the oldest time sample positioned in the LSBs of the word. This way as the data are clocked into the
packetizer the oldest sample will be the first 4 bytes of the packet and advance time in sequence. With the RFSoC
4x2 and other dual-tile platforms, when configured to output complex samples we have to build the interleaved
real/imaginary samples before sending them to packetizer portion of the design. To do this, the real and imaginary
parts of the samples coming from the output of the RFDC on their respective interfaces are first combined with a
bus_create block. The munge then reorders the blocks. The following figure graphical shows how the divisions
are reordered and their respective index for when the output is 4 samples per clock. Here I<#> represents the real
time sample at sample index # and the same for Q<#> but corresponding to the imaginary sample. In these examples,
I3 and Q3 correspond to the newest time sample and I0 and Q0 are the oldest.

The colors in this figure are used to track the sample input position relative to the output position. Also note that
that the “munge reorder index” column places the 0-th element at the MSB with the highest value at the LSB. The
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3rd column top-to-bottom is then what is input to the Division Packing Order field of the munge block.
The resulting vector used in as the munge block parameter is the reordered column entered top to bottom from this
table. In this design for the RFSoC 4x2 there are 8 samples per clock. Take a look at the munge block in the
rfsoc4x2_tut_spec_cx.slx model and this example to see if you can follow how the complex samples are
created.
Packetizer
Between the mux that selects the adc output from the RFDC to the the 100GbE yellow block is effectively our “packetizer”. This is a very simple packetizer, but it gets the job done. The first part of our packetizer up to the bus_create
block is a sort of “ping-pong” approach used to do a 2:1 serial-to-parallel conversion. The samples out of the RFDC are
Fix_256 but we need a 512-bit version. Two registers are used to clock the 256-bit samples into the bus_create
block that is attached to a FIFO block. A counter is used selecting the LSB to “ping-pong” back and forth between
the two registers and indicate when a valid 512-bit parallel word is clocked into the FIFO. In this serial-to-parallel
conversion the oldest 256-bit sequence of samples is stored in the lower 256-bits of the 512-bit word.
The FIFO is used to buffer the time samples until 128 512-bit words have been stored. The FIFO is configured to
output on the dcount port the number of words currently stored. When 128 words are clocked into the FIFO this
triggers an incremement to the packet sequence counter that is used to create the first 512-bit word of our packet (the
packet header) and then on the next cycle the read enable for clocking data out of the FIFO begins. The data and the
read enable (used as the valid on the 100GbE) are then pipelined to the 100GbE yellow block. On the 128th read the
“end of frame” is generated sending out the full packet count + rfdc samples payload. With 128 64-byte
words and a 64-byte header for the packet sequence count this is an expected received packet payload of 8256 bytes.
With the additional 42 byte Ethernet/IPv4/UDP framing the total packet size is 8298 bytes.
Simple Packet Capture and Processing with Python
Script Overview
We assume here working with the RFSoC 4x2 and the provided python scripts under the py/ directory. These scripts
can be extended for use with other platforms looking to implement similar functionality.
There are two scripts that are to be ran together in this example: a catcher, and a listener. The catcher
(implemented in tut_100g_catcher.py) is the packet sniffer. It will open an Ethernet interface and capture
and buffer raw Ethernet packets. Because opening a raw packet socket requires elevated (root) permissions it is
required to run this script as root. It may not be desirable to do everything as root, so the listener (implemented in
tut_100g_listener.py) creates a simple socket for the cathcer to forward the received packets to. The listener
then parses the packets, does some simple packet filtering, extracts the packet payload (ADC time samples), performs a
simple spectrometer operation, and plots the data. With 16 complex time samples per 512-bit word, and the packetizer
sending 128 words per packet, there are 2048 time samples per packet. The FFT size chosen for this spectrometer was
a 1024.
Before going through the code, it will help to go over what is being done and have first ran the scripts. This will help
identify what is being done by knowing before what is being presented.
The listener and catcher implement a simple state machine where the listener is to be started first accepting
configuration parameters for its arguments. These parameters are the RFSoC platform (casperfpga server) to
connect to, the the ADC port to capture data on, and the number of packets to catch in a sequence. The listener
then configures the RFSoC and sets up the socket for the catcher to connect to.
This same information is preneted by running the tut_100g_listener.py with the -h switch
./tut_100g_listener.py -h
Usage: tut_100g_listener.py <HOSTNAME_or_IP> [options]
(continues on next page)
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(continued from previous page)

-h, --help
show this help message and exit
-n NUMPKT, --numpkt=NUMPKT
Set the number of packets captured in sequence and
then sent to listener. Must be power of 2. default is 2**8
-s, --skip
Skip programming and begin to plot data
-b FPGFILE, --fpg=FPGFILE
Specify the fpg file to load
-a ADC_CHAN_SEL, --adc=ADC_CHAN_SEL
adc input to select values are 0,1,2, or 3. deafult is 0

The catcher is then started by passing the name of the ethernet interface it is to conenct to. It then opens that
interface and connects to the listener socket. The listener will post the number of packets to capture in a
sequence and wait for the listener to report that it is “ready” to start receiving packet sequences. After a sequence
of packets has been sent the catcher waits until the listener is “ready” again before catching and sending the
next sequence of packets.
The listener unpacks the sequence of packets parsing each packets IPv4/UDP header, payload packet count header,
and packet payload data. The data is then transformed using an FFT, averaged over all the packets received in the
sequence, and updates the plot of the spectra. After it plots it reports that it is “ready” to process the next packet
sequence. This sequence repeats back and forth between the listener and the catcher until terminted with a
keyboard interrupt at the catcher (also ending the listener).
Running the Scripts
With the above in mind, let’s run them!
First start the listener. If you are using your .fpg file that you created in this tutorial you would use the -b flag
with the path to the .fpg. Otherwise, the prebuilt is used by default. An example using the prebuilt and connecting
to an RFSoC with hostname rfsoc4x2, transmitting packets from the third ADC port, and setting the number of
packets received in a sequence to 256 would be:
python tut_100g_listener.py rfsoc4x2 -n 256 -a 3

After starting the listener the following output should be reported:
using prebuilt fpg file at ../prebuilt/rfsoc4x2/rfsoc4x2_tut_100g_stream_rfdc.fpg
Connecting to rfsoc4x2
Programming FPGA with ../prebuilt/rfsoc4x2/rfsoc4x2_tut_100g_stream_rfdc.fpg...
done
setting capture on adc port 3
waiting for catcher to connect

At this point the catcher can be started. In the following the Ethernet interface that is opened is enp193s0f0.
python tut_100g_catcher.py enp193s0f0

A plot should then appear and continue to update with an increasing number of packet sequence counts reported in
the title of the plot and by the catcher process. The catcher process will have also reported the configuration
parameters received from the listener with a prompt to end the programs with a keyboard interrupt (Ctrl-c).
With an input on the RFSoC 4x2, and if all goes well, an example of the output should look like the following. Here a
tone is injected starting at 500 MHz and stepping through the spectrum up to 1750 MHz.
Like in the example sepctrometer, a more interesting signal could be used at the input of the RFSoC. In the following,
a wideband noise source is filtered to a passband from about 1280-1780 MHz with a tone present starting in that
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passband at 1520 MHz. The tone is then moved around that passband and ends back at 1520 MHz.
Conclusion
High-rate data transport is a critical component of digital radio astronomy instrumentation. This tutorial has demonstrated the functionality and use of the 100GbE yellow block on RFSoC platforms. Additionally, the manipulation of
the output data from the RFDC with a simple packetization scheme has been demonstrated. More common packetizer implementations will vary in complexity, but the fundamentals lie in being able to manipulate data ordering and
buffering. Capturing, parsing, and processing Ethernet packets received at NIC from the FPGA is typically where
data reduction in a science backend begins. This simple example provides a starting point for being able to work with
the fundamentals of capturing and working with Ethernet packets. When lossless data streams are required it is more
typical to use optimized dediated high-throughput pipelines. In these frameworks where the NIC and CPU perform
the packet capturing functions the computation is typically performed on a GPU. These function are also distributed
over many threads and optimized for performance and throughput. In this tutorial we did not focus on processor
performance, but rather focused on the fundamentals that lead in that direction.
Appendix and Reference
Memory Map and Software Programmable Interface
This section of the tutorial will not provide a complete explanation of everything that can be done with the software
interface, but rather demonstrate breifly some of the software programmable capabilities of the 100GbE core through
casperfpga that can be further explored by the casper-ite.
When using casperfpga the memory map for the platform can be accessed using the listdev() command. This
was demonstrated and explained briefly in the Platform Getting Started tutorial. A quick example is as follows:
import casperfpga
rfsoc = casperfpga.CasperFpga('<ip_address_or_hostname>')
rfsoc.upload_to_ram_and_program('/path/to/design.fpg')
rfsoc.listdev()

The rfsoc Casperfpga object here returns a list of all the registers in the memory map. With a 100GbE yellow
block in the design the registers that make up that core’s memory mapy will be present. These can be accessed using
the normal read_uint/write_int casperfpga methods.
However, when a 100GbE is present in the design the casperfpga object will build a 100GbE object that abstracts
working with the core by providing methods that manage the lower-level read and writes. For example, with the
tutorial design programmed on the FPGA we can get a reference the 100GbE object and configure the IP address and
MAC after startup
# get the eth core
eth = rfsoc.gbes['onehundred_gbe']
# get core information
ip = '10.17.16.61'
mac = 0x02a202000203
# configure core
eth.configure_core(mac, ip, 60000)

If ever in doubt however, all can be configured from the memory map
rfsoc.write_int('gmac_reg_mac_address_l_0', (mac & 0xffffffff))
rfsoc.write_int('gmac_reg_mac_address_h_0', (mac >> 32) & 0xffff)
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The 100GbE also has an ARP table that can be programmed. The following is an example for how to do this:
# a configuration dictionary with IP/MAC key-value pairs
c = {
'arp': {
10.17.16.10: 0x0c42a1a39a06,
.
.
.
10.17.16.61: 0x0c42a1a3992e
}
}
# set arp table
for k, v, in c['arp'].items():
print("Configuring arp values for {:s}".format(k))
for ip, mac in v.items():
print(ip, hex(mac))
eth.set_single_arp_entry(ip, mac)

2.2 ISE
ROACH1/2
1. Introduction Tutorial
2. 10GbE Tutorial
3. Spectrometer Tutorial
4. Correlator Tutorial

2.2.1 Tutorial 1: Introduction to Simulink
In this tutorial, you will create a simple Simulink design using both standard Xilinx system generator blockset, as well
as library blocks specific to CASPER boards (so-called “Yellow Blocks”). At the end of this tutorial, you will know
how to generate an fpg file, program it to a CASPER FPGA board, and interact with your running hardware design
using casperfpga via a Python Interface.
Creating Your Design
Create a New Model
Start MATLAB via executing the startsg command, as described here. This ensures that necessary Xilinx and CASPER
libraries are loaded into development environment by Simulink. When MATLAB starts up, open Simulink by typing
simulink on the MATLAB command line. Start a new model, and save it with an appropriate name. With Simulink,
it is very wise to save early and often.
There are some Matlab limitations you should be aware-of right from the start:
• Do not use spaces in your filenames or anywhere in the file path as it will break the toolflow.
• Do not use capital letters in your filenames or anywhere in the file path as it will break the toolflow.
• Beware block paths that exceed 64 characters. This refers to not only the file path, but also the path to any
block within your design.
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– For example, if you save a model file with a name ~/some_really_long_filename.slx, and have a block
called in a submodule the longest block path would be: some_really_long_filename_submodule_block.
– If you use lots of subsystems, this can cause problems.
Library organization
There are three libraries which you will use when you design firmware in Simulink.
1. The CASPER XPS Library contains “Yellow Blocks” – these are blocks which encapsulate interfaces to hardware
(ADCs, Memory chips, CPUs, Ethernet ports, etc.)
2. The CASPER DSP Library contains (mostly green) blocks which inplement DSP functions, like filters, FFTs,
etc.
3. The Xilinx Library contains blue blocks which provide low-level functionality such as multiplexing, delaying,
adding, etc. The Xilinx library also contains the super-special System Generator block, which contains information about the type of FPGA you are targeting.
Add Xilinx System Generator and XSG core config blocks
Add a System generator block from the Xilinx library by locating the Xilinx Blockset library’s Basic Elements subsection and dragging a System Generator token onto your new file.
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Do not configure it directly, but rather add a platform block representing the system you care compiling for. These can
be found in the CASPER XPS System Blockset library. For ROACH2, you need an XPS_core_config block.
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Double click on the platform block that you just added. The Hardware Platform parameter should match the platform
you are compiling for. For ROACH2 you have to set this from a drop-down list, for newer platforms it should automatically be set to the correct board type. Once you have selected a board, you need to choose where it will get its
clock. In designs including ADCs you probably want the FPGA clock to be derived from the sampling clock, but for
this simple design (which doesn’t include an ADC) you should use the platform’s on-board clock. To do this, set the
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User IP Clock Source to sys_clk. The sys_clk rate is 100 MHz, so you should set this for User IP Clock Rate in the
block.
The configuration yellow block knows what FPGA corresponds to which platform, and so it will automatically configure the System Generator block which you previously added.
The System Generator and XPS Config blocks are required by all CASPER designs
Flashing LED
To demonstrate the basic use of hardware interfaces, we will make an LED flash. With the FPGA running at ~100MHz
(or greater), the most significant bit (MSB) of a 27 bit counter will toggle approximately every 0.67 seconds. We can
output this bit to an LED on your board. Most (all?) CASPER platforms have at least four LEDs, with the exact
configuration depending on the board. We will make a small circuit connecting the top bit of a 27 bit counter to one
of these LEDs. When compiled this will make the LED flash with a 50% duty cycle approximately once a second.
Add a counter
Add a counter to your design by navigating to Xilinx Blockset -> Basic Elements -> Counter and dragging it onto your
model.
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Double-click it and set it for free running, 27 bits, unsigned. This means it will count from 0 to 2^27 - 1, and will then
wrap back to zero and continue.
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Add a slice block to select the MSB
We now need to select the most significant bit (MSB) of the counter. We do this using a slice block, which Xilinx
provides. Xilinx Blockset -> Basic Elements -> Slice.

Double-click on the newly-added slice block. There are multiple ways to select which bit(s) you want. In this case, it
is simplest to index from the upper end and select the first bit. If you wanted the least significant bit (LSB), you can
also index from that position. You can either select the width and offset, or two bit locations.
Set it for 1 bit wide with offset from top bit at zero. As you might guess, this will take the 27-bit input signal, and
output just the top bit.
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Add a GPIO block
From: CASPER XPS library -> gpio.
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In order to send the 1-bit signal you have sliced off to an LED, you need to connect it to the right FPGA output pin. To
do this you can use a GPIO (general-purpose input/output) block from the XPS library, this allows you to route a signal
from Simulink to a selection of FPGA pins, which are addressed with user-friendly names. Set it to use ROACH2’s
LED bank as output. Once you’ve chosen the LED bank, you need to pick which LED you want to output to. Set the
GPIO bit index to 0 (the first LED) and the data type to Boolean with bitwidth 1. This means your Simulink input is a
1 bit Boolean, and the output is LED0.
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Add a terminator
To prevent warnings (from MATLAB & Simulink) about unconnected outputs, terminate all unused outputs using a
Terminator:
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From: Simulink -> Sinks -> Terminator
You can also use the Matlab function XlAddTerms, run in the MATLAB prompt, to automatically terminate your
unused outputs.
Connect your design
It is a good idea to rename your blocks to something more sensible, like counter_led instead of just counter. Do this
simply by double-clicking on the name of the block and editing the text appropriately.
To connect the blocks simply click and drag from the ‘output arrow’ on one block and drag it to the ‘input arrow’ of
another block. Connect the blocks together: Counter -> Slice -> gpio as showing in digram below.
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Remember to save your design often.
Software control
To demonstrate the use of software registers to control the FPGA from a computer, we will add registers so that the
counter in our design can be started, stopped, and reset from software. We will also add a register so that we can
monitor the counter’s current value too. By the end of this section you will create a system that looks like this:

Slice_circuit.png
Add the software registers
We need two software registers:
1. To control the counter, and
2. To read its current value.
From the CASPER XPS System Blockset library, drag two software registers into your design.
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SW_reg_select2.p
Set the I/O direction to From Processor on the first one (counter control) to enable a value to be set from software and
sent to your FPGA design. Set it to To Processor on the second one (counter value) to enable a value to be sent from
the FPGA to software. Set both registers to a bitwidth of 32 bits.
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Rename the registers to something sensible, the names you give them here are the names you will use to access
them from software. Do not use spaces, slashes and other special characters in these. Perhaps counter_ctrl and
counter_value to represent the control and output registers respectively.
Also note that the software registers have sim_reg and sim_out ports. The input port provides a means of simulating
this register’s value (as would be set by the runtime software) using the sim_reg line. The output port provides a means
to simulate this register’s current FPGA-assigned value.
For now, set the sim_reg port to constant one using a Simulink-type constant. This can be found in Simulink ->
Sources, and will enable the counter during simulations.

During simulation we can monitor the counter’s value using a scope (Simulink -> Sinks):
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Here is a good point to note that all blocks from the Simulink library are usually white in colour, and will not be
compiled into hardware. i.e. They are present for simulation only. Xilinx blocks are usually blue in colour with the
Xilinx logo, and will be compiled to hardware.
You need to use gateway blocks whenever connecting a Simulink-provided block (like a scope or sine-wave generator)
to and from a Xilinx block. This will sample and quantize the Simulink signals so that they are compatible with the
Xilinx world. Some blocks (like the software register) provide a gateway internally, so you can feed the input of a
software register with a Xilinx signal, and monitor its output with a Simulink scope. However, in general, you must
manually insert these gateways where appropriate. Simulink will issue warnings for any direct connections between
the Simulink and Xilinx domains.
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Add the counter
You can do this either by copying your existing counter block (copy-paste, or ctrl-click-drag-drop) or by placing a new
one from the library. Configure it with a reset and enable port as follows:
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Add the slice blocks
Now we need some way to control the enable and reset ports of the counter. We could do this using two separate
software registers, but this is wasteful since each register is 32 bits anyway.
So we’ll use a single register and slice out one bit for enabling the counter, and another bit for resetting it. Either copy
your existing slice block (copy-paste it or hold ctrl while dragging/dropping it) or add two more from the library.
The enable and reset ports of the counter require boolean values (which Simulink interprets differently from ordinary
1-bit unsigned numbers). Configure the slices as follows:
Slice for enable:

Slice for reset:
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Connect it all up
Now we need to connect all these blocks together. To neaten things up, consider resizing the slice blocks and hiding
their names. Their function is clear enough from their icon without needing to see their names.
Do so by right-clicking and unchecking Format → Show Block Name. You could do this with the counter too, but it’s
not a good idea with the software registers, because otherwise you wouldn’t know how to address them when looking
at your diagram.
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Adder
To demonstrate some simple mathematical operations, we will create an adder. It will add two numbers on demand and
output the result to another software register. Almost all astronomy DSP is done using fixed-point (integer) notation,
and this adder will be no different.
We will calculate a+b = sum_a_b.
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Add the software registers
Add two more input software registers. These will allow us to specify the two numbers to add. Add another output
register for the sum output.
Either copy your existing software register blocks (copy-paste or holding ctrl while dragging/dropping it) or add three
more from the library. Set the I/O direction to From Processor on the first two and set it to To Processor on the third
one.
Add the adder block
Locate the adder/subtractor block, Xilinx Blockset -> Math -> AddSub and drag one onto your design. This block can
optionally perform addition or subtraction. Let’s leave it set at it’s default, for addition.
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The output register is 32 bits. If we add two 32 bit numbers, we will have 33 bits.
There are a number of ways of fixing this:
• limit the input bitwidth(s) with slice blocks
• limit the output bitwidth with slice blocks
• create a 32 bit adder.
Since you have already seen slice blocks demonstrated, let’s try to set the AddSub block to be a 32 bit saturating adder.
On the second tab, set it for user-defined precision, unsigned 32 bits.
Also, under overflow, set it to saturate. Now if we add two very large numbers, it will simply return 2^32 -1.
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Add the scope and simulation inputs
Either copy your existing scope and simulation constants (copy-paste or ctrl-drag) or place a new one from the library
as before. Set the values of the simulation inputs to anything you like.
Connect it all together
Like this:
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Simulating
The design can be simulated with clock-for-clock accuracy directly from within Simulink. Set the number of clock
cycles that you’d like to simulate and press the play button in the top toolbar.

You can watch the simulation progress in the status bar in the bottom right. It will complete in the blink of an eye for
this small design with just 10 clock cycles.
You can double-click on the scopes to see what the signals look like on those lines. For example, the one connected to
the counter should look like this:

The one connected to your adder should return a constant, equal to the sum of the two numbers you entered. You
might have to press the Autoscale button to scale the scope appropriately.

Once you have verified that that design functions as you’d like, you’re ready to compile for the FPGA. . .
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Compiling
Essentially, you have constructed three completely separate little instruments.
1. You have a flashing LED,
2. A counter which you can start/stop/reset from software, and
3. A simple adder.
These components are all clocked off the same clock source specified in your platform’s properties, but they will
operate independently.
In order to compile this to an FPGA bitstream, execute the following command in the MATLAB Command Line
window. THIS COMMAND DEPENDS WHICH PLATFORM YOU ARE TARGETING:
>> casper_xps

When a GUI pops up, click “Compile!”. This will run the complete build process, which consists of two stages. The
first involving Xilinx’s System Generator, which compiles any Xilinx blocks in your Simulink design to a circuit which
can be implemented on your FPGA. While System Generator is running, you should see the following window pop
up:

After this, the second stage involves synthesis of your design through Vivado, which goes about turning your design
into a physical implementation and figuring out where to put the resulting components and signals on your FPGA.
Finally the toolflow will create the final output fpg file that you will use to program your FPGA. This file contains
the bitstream (the FPGA configuration information) as well as meta-data describing what registers and other yellow
blocks are in your design. This file will be created in the ‘bit_files’ directory. Note: Compile time is approximately
15-20 minutes.
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Programming the FPGA
Reconfiguration of CASPER FPGA boards is achieved using the casperfpga python library, created by the SA-SKA
group.
Getting the required packages
These are pre-installed on the server in the workshop and you do not need to do any further configuration. However,
should you want to run these tutorials on your own machines, you should download the latest casperfpga libraries from
here.
Copy your .fpg file to your Server
As per the previous figure, navigate to the outputs folder and (secure)copy this across to a test folder on the workshop
server. Instructions to do this are available here
Connecting to the board
SSH into the server that the ROACH board is connected to and navigate to the folder in which your .fpg file is stored.
Start interactive python by running:
$ ipython

Now import the fpga control library. This will automatically pull-in the KATCP library and any other required communications libraries.
import casperfpga

To connect to the board we create a CasperFpga instance; let’s call it fpga. The CasperFpga constructor requires just
one argument: the IP hostname or address of your FPGA board.
fpga = casperfpga.CasperFpga('<roach2 hostname or ip_address>')

The first thing we do is program the FPGA with the .fpg file which your compile generated.
fpga.upload_to_ram_and_program('<your_fpgfile.fpg>')

Should the execution of this command return true, you can safely assume the FPGA is now configured with your
design. You should see the LED on your board flashing. Go check! All the available/configured registers can be
displayed using:
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fpga.listdev()

The adder and counter can be controlled by writing to and reading from registers added in the design using:
fpga.write_int('a',10)
fpga.write_int('b',20)
fpga.read_int('sum_a_b')

With any luck, the sum returned by the FPGA should be correct.
You can also try writing to the counter control registers in your design. You should find that with appropriate manipulation of the control register, you can make the counter start, stop, and return to zero.
fpga.write_int('counter_ctrl', 1)
fpga.read_uint('counter_value')

Conclusion
This concludes the first CASPER Tutorial. You have learned how to construct a simple Simulink design, program an
FPGA board and interact with it with Python using casperfpga. Congratulations!
While the design you made might not be very complicated, you now have the basic skills required to build more
complex designs which are covered in later tutorials.

2.2.2 Tutorial 2: 10GbE Interface
Introduction
In this tutorial, you will create a simple Simulink design which uses the ROACH2’s (or ROACH1’s) 10GbE ports to
send data at high speeds to another port. This could just as easily be another FPGA board or a computer with a 10GbE
network interface card. In addition, we will learn to control the design remotely, using a supplied Python library for
KATCP.
In this tutorial, a counter will be transmitted through one SFP+ port and back into another. This will allow a test of the
communications link. This test can be used to test the link between boards and the effect of different cable lengths on
communication robustness.
Background
ROACH2 boards have four SFP+ ports on a single 10GbE Mezzanine Card. The Ethernet interface is driven by an
on-board 156.25MHz crystal oscilator. This clock is then multiplied up on the FPGA by a factor of 66. Thus, the speed
on the wire is actually 156.25MHz x 66 = 10.312.5 Gbps. However, 10GbE over single-lane SFP+ connectors uses
64b/66b encoding, which means that for every 66 bits sent, 66 bits are actually transmitted. This is to ensure proper
clocking, since the receiver recovers and locks-on to the transmitter’s clock and requires edges in the data. Imagine
transmitting a string of 0xFF or 0b11111111. . . which would otherwise generate a DC level on the line, now an extra
two bits are introduced which includes a zero bit which the receiver can use to recover the clock and byte endings. See
here for more information.
For this reason, we actually get 10Gbps usable data rate. CASPER’s 10GbE Simulink core sends and receives UDP
over IPv4 packets. These IP packets are wrapped in Ethernet frames. Each Ethernet frame requires a 38 byte header,
IPv4 requires another 20 bytes and UDP a further 16. So, for each packet of data you send, you will incur a cost of at
least 74 bytes. I say at least, because the core will zero-pad some headers to be on a 64-bit boundary. You will thus
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never achieve 10Gbps of usable throughput, though you can get close. It pays to send larger packets if you are trying
to get higher throughputs.
The maximum payload length of the CASPER 10GbE core is 8192 bytes (implemented in BRAM) plus another 512
(implemented in distributed RAM) which is useful for an application header. These ports (and hence part of the 10
GbE cores) run at 156.25MHz, while the interface to your design runs at the FPGA clock rate (sys_clk, adcX_clk
etc). The interface is asynchronous, and buffers are required at the clock boundary. For this reason, even if you send
data between two ROACH boards which are running off the same hard-wired clock, there will be jitter in the data. A
second consideration is how often you clock values into the core when you try to send data. If your FPGA is running
faster than the core, and you try and clock data in on every clock cycle, the buffers will eventually overflow. Likewise
for receiving, if you send too much data to a board and cannot clock it out of the receive buffer fast enough, the receive
buffers will overflow and you will lose data. In our design, we are clocking the FPGA at 100 MHz, with the cores
running at 156.25MHz. We can thus clock data into the TX buffer continuously without worrying about overflows.
Create a new model
Start Matlab and open Simulink (either by typing ‘simulink’ on the Matlab command line, or by clicking on the
Simulink icon in the taskbar). A template is provided for Tut2 with a pre-created packet generator in the tutorials_devel
git repository. Get a copy of this template and save it. Make sure the XSG_config_block is configured for ROACH2
(or ROACH1, if that’s what you’re using). Specify a clock frequency of 100 MHz and the clock source “sys_clock”.
Add reset logic
A very important piece of logic to consider when designing your system is how, when and what happens during reset.
In this example we shall control our resets via a software register. We shall have two independent resets, one for the
10GbE cores which shall be used initially, and one to reset the user logic which may be used more often to restart the
user part of the system. Construct reset circuitry as shown below.

Add a software register
Use a software register yellow block from the CASPER XPS System Blockset for the rst block. Rename it to rst.
It used to be that every register you inserted had to be natively 32-bits, and you were responsible for slicing these
32 bits into different signals if you want to control multiple flags. The latest block can implicitly break the 32-bit
registers out into separate names signals, so we’ll use that. The downside is there are a bunch of settings to configure
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– you need to set up the names and data types of your register subfields. The settings you need are ‘”NOTE: due to
missing MATLAB licenses on the 2017 conference servers, you can’t use do this for ROACH2.”’ For ROACH2 take
the default block, configure the I/O direction to be From Processor and then manually slice the bottom bit of the output
to make the cnt_rst signal, and bit 1 to make the core_rst signal. You can check the example ROACH2 design to see
how to do this.
Add Goto blocks
Add two Goto blocks from Simulink->Signal Routing. Configure them to have the tags as shown (core_rst and
cnt_rst). These tags will be used by associated From (also found in Simulink->Signal Routing) blocks in other parts
of the design. These help to reduce clutter in your design and are useful for control signals that are routed to many
destinations. They should not be used a lot for data signals as it reduces the ease with which data flow can be seen
through the system.
Add 10GbE and associated registers for data transmission
We will now add the 10GbE block to transmit a counter at a programmable rate.
Add a 10GbE block for data transmission
Add a ten_GbE yellow block from the CASPER XPS System Blockset. It will be used to transmit data and we shall
add another later to receive data. Rename it gbe0. Double click on the block to configure it and set it to be associated
with SFP+ port 0. If your application can guarantee that it will be able to use received data straight away (as our
application can), shallow receive buffers can be used to save resources. This optimisation is not necessary in this case
as we will use a small fraction of resources in the FPGA.
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Add registers to provide the target IP address and port number
Add two yellow-block software registers to provide the destination IP address and port number for transmission with
the data. Name one dest_ip and the other dest_port. The registers should be configured to receive their values from
the processor. Connect them to the appropriate inputs of the gbe0 10GbE block as shown. A Slice block is required to
use the lower 16 bits of data from the dest_port register. Constant blocks from Simulink->Sources with 0 values are
attached to the simulation inputs of the software registers. The destination port and IP address are not important in this
system as it is a loopback example. Add a From block from Simulink->Signal Routing and set the tag to use core_rst,
this enables one to reset the block.

Create a subsystem to generate a counter to transmit as data
We will now implement logic to generate a counter to transmit as data. This is already included in the Template for
Tut 2. Some details are provided here for completeness.
Construct a subsystem for data generation logic
It is often useful to group related functionality and hide the details. This reduces drawing space and complexity of the
logic on the screen, making it easier to understand what is happening. Simulink allows the creation of Subsystems to
accomplish this.
These can be copied to places where the same functionality is required or even placed in a library for use in other
projects and by other people. To create a subsystem, one can highlight the logical elements to be encapsulated, then
right-click and choose Create Subsystem from the list of options. You can also simply add a Subsystem block from
Simulink->Ports & Subsystems.
Subsystems inherit variables from their parent system. Simulink allows one to create a variable whose scope is only a
particular subsystem. To do this, right-click on a subsystem and choose the Create Mask option. The mask created for
that particular subsystem allows one to add parameters that appear when you double-click on the icon associated with
the subsystem.
The mask also allows you to associate an initialisation script with a particular subsystem. This script is called every
time a mask parameter is modified and the Apply button clicked. It is especially useful if the internal structure of a
subsystem must change based on mask parameters. Most of the interesting blocks in the CASPER library use these
initialisation scripts.
Drop a subsystem block into your design and rename it pkt_sim. Then double-click on it to add logic.

372

Chapter 2. Tutorial Instructions

CASPER Tutorials Documentation, Release 0.1

Add a counter to generate a certain amount of data
Add a Counter block from Xilinx Blockset->Basic Elements and configure it to be unsigned, free-running, 32-bits,
incrementing by 1 as shown. Add a Relational block, software register and Constant block as shown. In simulation
this circuit will generate a counter from 0 to 49 and then stop counting. This will allow us to generate 50 data elements
before stopping.
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Add a counter to limit the data rate
As mentioned earlier in this tutorial, it is impossible to supply data to the 10GbE transmission block at the full clock
rate. This would mean transmitting a 64-bit word at 200MHz, and the 10GbE standard only supports up to 156.25MHz
data transmission. We thus want to generate data in bursts such that the transmission FIFOs do not overflow. We thus
add circuitry to limit the data rate as shown below. The logic that we have added on the left generates a reset at a
fixed period determined by the software register. This will trigger the generation of a new packet of data as before. In
simulation this allows us to limit the data rate to 50/200 * 200MHz = 50MHz. Using these values in actual hardware
would limit the data rate to (50/(8/10*156.25)) = 4Gbps.

Finalise logic including counter to be used as data
We will now finalise the data generation logic as shown below. To save time, use the existing logic provided with
the tutorial. Counter1 in the illustration generates the actual data to be transmitted and the enable register allows this
data stream to the transmitting 10GbE core to be turned off and on. Logic linked to the eof output port provides an
indication to the 10GbE core that the final data word for the frame is being sent. This will trigger the core to begin
transmission of the frame of data using the IP address and port number specified.
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Receive blocks and logic
The receive logic is is composed of another 10GbE yellow block with the transmission interface inputs all tied to 0
as no transmission is to be done, however Simulink requires all inputs to be connected. Connecting them to 0 should
ensure that during synthesis the transmission logic for this 10GbE block is removed. Double click on the block to
configure it and set it to be associated with SFP+ port 1.
Buffers to capture received and transmitted data
The casperfpga Python package contains all kinds of methods to interact with your 10GbE cores. For example,
grabbing packets from the TX and RX stream, or counting the number of packets sent and received are all supported,
as long as you turn on the appropriate functionality in the 10GbE yellow block. The settings we’ll use are –
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You can see how to use these functions in the software that accompanies this tutorial.
LEDs and status registers
You can also sprinkle around other registers or LEDs to monitor status of core parameters, or give visual feedback that
the design is doing something sane. Check out the reference model for some examples of potentially useful monitoring
circuitry.
Compilation
Compiling this design takes approximately 20 to 30 minutes. A pre-compiled binary (.fpg file) is made available to
save time.
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Programming and interacting with the FPGA
A pre-written python script, ‘’roach2_tut_tge.py” is provided. This script programs the fpga with your complied design
(.fpg file) configures the 10GbE Ports and initiates data transfer. The script is run using:
./roach2_tut_tge.py <ROACH_IP_ADDRESS>

If everything goes as expected, you should see a whole bunch of lines running across your screen as the code sets
up the IP/MAC parameters of the 10GbE cores and checks their status, and that the data the cores are sending
and receiving are consistent. Have a look at this code to see how one uses the more advanced (i.e. more complex
that read_int, and write_int) methods casperfpga makes available. Documentation for casperfpga is still a work in
progress(!) but the basic idea is that when you instantiate a CasperFpga, the software intelligently builds python objects into this instance, based on what you put in your design. For example, your Ethernet cores should show up as
objects CasperFpga.gbes.<simulink_block_name> (or CasperFpga.gbes[‘simulink_block_name’]) which have useful
methods like “setup”, which sets the core’s IP/MAC address, or “print_10gbe_core_details” wich will print out useful
status information, like the current state of the core’s ARP cache. iPython and tab-complete are your friend here, there
are lots of handy methods to discover. (I’m still discovering them now :) )
The control software should be(!) well-commented, to explain what’s going on behind the scene as the software
interacts with your FPGA design.
Conclusion
This concludes Tutorial 2. You have learned how to utilize the 10GbE ports on a ROACH to send and receive UDP
packets. You also learned how to further use the Python to program the FPGA and control it remotely using some of
the OOP goodies avaiable in casperfpga.

2.2.3 Tutorial 3: Wideband Spectrometer
Introduction
A spectrometer is something that takes a signal in the time domain and converts it to the frequency domain. In digital
systems, this is generally achieved by utilising the FFT (Fast Fourier Transform) algorithm. However, with a little bit
more effort, the signal to noise performance can be increased greatly by using a Polyphase Filter Bank (PFB) based
approach.
When designing a spectrometer for astronomical applications, it’s important to consider the science case behind it. For
example, pulsar timing searches will need a spectrometer which can dump spectra on short timescales, so the rate of
change of the spectra can be observed. In contrast, a deep field HI survey will accumulate multiple spectra to increase
the signal to noise ratio. It’s also important to note that “bigger isn’t always better”; the higher your spectral and time
resolution are, the more data your computer (and scientist on the other end) will have to deal with. For now, let’s skip
the science case and familiarize ourselves with an example spectrometer.
Setup
This tutorial comes with a completed model file, a compiled bitstream, ready for execution on ROACH, as well as a
Python script to configure the ROACH and make plots. Here
Spectrometer Basics
When designing a spectrometer there are a few main parameters of note:
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• Bandwidth: The width of your frequency spectrum, in Hz. This depends on the sampling rate; for complex
sampled data this is equivalent to:

In contrast, for real or Nyquist sampled data the rate is half this:

as two samples are required to reconstruct a given waveform .
• Frequency resolution: The frequency resolution of a spectrometer, ∆f, is given by

,
and is the width of each frequency bin. Correspondingly, ∆f is a measure of how precise you can measure a frequency.
• Time resolution: Time resolution is simply the spectral dump rate of your instrument. We generally accumulate
multiple spectra to average out noise; the more accumulations we do, the lower the time resolution. For looking
at short timescale events, such as pulsar bursts, higher time resolution is necessary; conversely, if we want to
look at a weak HI signal, a long accumulation time is required, so time resolution is less important.
Simulink / CASPER Toolflow
Simulink Design Overview
If you’re reading this, then you’ve already managed to find all the tutorial files. Jason has gone to great effort to create
an easy to follow simulink model that compiles and works. By now, I presume you can open the model file and have a
vague idea of what’s happening. The best way to understand fully is to follow the arrows, go through what each block
is doing and make sure you know why each step is done. To help you through, there’s some “blockumentation” in the
appendix, which should (hopefully) answer all questions you may have. A brief rundown before you get down and
dirty:
• The all important Xilinx token is placed to allow System Generator to be called to compile the design.
• In the MSSGE block, the hardware type is set to “ROACH:sx95t” and clock rate is specified as 200MHz.
• The input signal is digitised by the ADC, resulting in four parallel time samples of 8 bits each clock cycle. The
ADC runs at 800MHz, which gives a 400MHz nyquist sampled spectrum. The output range is a signed number
in the range -1 to +1 (ie 7 bits after the decimal point). This is expressed as fix_8_7.
• The four parallel time samples pass through the pfb_fir_real and fft_wideband_real blocks, which together
constitute a polyphase filter bank. We’ve selected 212=4096 points, so we’ll have a 211=2048 channel filter
bank.
• You may notice Xilinx delay blocks dotted all over the design. It’s common practice to add these into the design
as it makes it easier to fit the design into the logic of the FPGA. It consumes more resources, but eases signal
timing-induced placement restrictions.
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• The real and imaginary (sine and cosine value) components of the FFT are plugged into power blocks, to
convert from complex values to real power values by squaring. They are also scaled by a gain factor before
being quantised. . .
• These power values are then requantized by the quant0 block, from 36.34 bits to 6.5 bits, in preparation for
accumulation. This is done to limit bit growth.
• The requantized signals then enter the vector accumulators, vacc0 and vacc1, which are simple_bram_vacc 32
bit vector accumulators. Accumulation length is controlled by the acc_cntrl block.
• The accumulated signal is then fed into software registers, odd and even.
Without further ado, open up the model file and start clicking on things, referring the blockumentation as you go.
adc

The first step to creating a frequency spectrum is to digitize the signal. This is done with an ADC – an Analogue to
Digital Converter. In Simulink, the ADC daughter board is represented by a yellow block. Work through the “iADC
tutorial” if you’re not familiar with the iADC card.
The ADC block converts analog inputs to digital outputs. Every clock cycle, the inputs are sampled and digitized to 8
bit binary point numbers in the range of -1 to 1 and are then output by the ADC. This is achieved through the use of
two’s-compliment representation with the binary point placed after the seven least significant bits. This means we can
represent numbers from -128/128 through to 127/128 including the number 0. Simulink represents such numbers with
a fix_8_7 moniker.
ADCs often internally bias themselves to halfway between 0 and -1. This means that you’d typically see the output of
an ADC toggling between zero and -1 when there’s no input. It also means that unless otherwise calibrated, an ADC
will have a negative DC offset.
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The ADC has to be clocked to four times that of the FPGA clock. In this design the ADC is clocked to 800MHz, so
the ROACH will be clocked to 200MHz . This gives us a bandwidth of 400MHz, as Nyquist sampling requires two
samples (or more) each second.
INPUTS
OUTPUTS
The ADC outputs two main signals: i and q, which correspond to the coaxial inputs of the ADC board. In this tutorial,
we’ll only be using input i. As the ADC runs at 4x the FPGA rate, there are four parallel time sampled outputs: i0, i1,
i2 and i3. As mentioned before, these outputs are 8.7 bit.
pfb_fir_real

There are two main blocks required for a polyphase filter bank. The first is the pfb_fir_real block, which divides
the signal into parallel ‘taps’ then applies finite impulse response filters (FIR). The output of this block is still a
time-domain signal. When combined with the FFT_wideband_real block, this constitutes a polyphase filterbank.
INPUTS/OUTPUTS
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As the ADC has four parallel time sampled outputs: i0, i1, i2 and i3, we need four parallel inputs for this PFB
implementation.
PARAMETERS
fft_wideband_real

The FFT_wideband_real block is the most important part of the design to understand. The cool green of the FFT
block hides the complex and confusing FFT butterfly biplex algorithms that are under the hood. You do need to have a
working knowledge of it though, so I recommend reading Chapter 8 and Chapter 12 of Smith’s free online DSP guide
at (http://www.dspguide.com/). Parts of the documentation below are taken from the [[Block_Documentation | block
documentation]] by Aaron Parsons and Andrew Martens.
INPUTS/OUTPUTS
PARAMETERS
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power

The power block computes the power of a complex number. The power block typically has a latency of 5 and will
compute the power of its input by taking the sum of the squares of its real and imaginary components. The power
block is written by Aaron Parsons and online documentation is by Ben Blackman. In our design, there are two power
blocks, which compute the power of the odd and even outputs of the FFT. The output of the block is 36.34 bits; the
next stage of the design re-quantizes this down to a lower bitrate.
INPUTS/OUTPUTS
PARAMETERS
quant

The quant0 was written by Jason Manley for this tutorial and is not part of the CASPER blockset. The block requantizes from 36.34 bits to 6.5 unsigned bits, in preparation for accumulation by the 32 bit bram_vacc block. This
block also adds gain control, via a software register. The tut3.py script sets this gain control. You would not need
to re-quantize if you used a larger vacc block, such as the 64bit one, but it’s illustrative to see a simple example of
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re-quantization, so it’s in the design anyway. Note that the sync_out port is connected to a block, acc_cntrl, which
provides accumulation control.
INPUTS/OUTPUTS
PARAMETERS
None.
simple_bram_vacc

The simple_bram_vacc block is used in this design for vector accumulation. Vector growth is approximately 28
bits each second, so if you wanted a really long accumulation (say a few hours), you’d have to use a block such
as the qdr_vacc or dram_vacc. As the name suggests, the simple_bram_vacc is simpler so it is fine for this demo
spectrometer. The FFT block outputs 1024 cosine values (odd) and 1024 sine values, making 2048 values in total.
We have two of these bram vacc’s in the design, one for the odd and one for the even frequency channels. The vector
length is thus set to 1024 on both.
PARAMETERS
INPUTS/OUTPUTS
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Even and Odd BRAMs

The final blocks, odd and even, are shared BRAMs, which we will read out the values of using the tut3.py script.
PARAMETERS
INPUTS/OUTPUTS
Software Registers
There are a few control registers, led blinkers, and snap block dotted around the design too:
• cnt_rst: Counter reset control. Pulse this high to reset all counters back to zero.
• acc_len: Sets the accumulation length. Have a look in tut3.py for usage.
• sync_cnt: Sync pulse counter. Counts the number of sync pulses issued. Can be used to figure out board uptime
and confirm that your design is being clocked correctly.
• acc_cnt: Accumulation counter. Keeps track of how many accumulations have been done.
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• led0_sync: Back on topic: the led0_sync light flashes each time a sync pulse is generated. It lets you know your
ROACH is alive.
• led1_new_acc: This lights up led1 each time a new accumulation is triggered.
• led2_acc_clip: This lights up led2 whenever clipping is detected.
There are also some snap blocks, which capture data from the FPGA fabric and makes it accessible to the Power PC.
This tutorial doesn’t go into these blocks (in its current revision, at least), but if you have the inclination, have a look at
their documentation. In this design, the snap blocks are placed such that they can give useful debugging information.
You can probe these through KATCP, as done in Tutorial 1, if interested. If you’ve made it to here, congratulations, go
and get yourself a cup of tea and a biscuit, then come back for part two, which explains the second part of the tutorial
– actually getting the spectrometer running, and having a look at some spectra.
Configuration and Control
Hardware Configuration
The tutorial comes with a pre-compiled bof file, which is generated from the model you just went through (tut3.bof)
Copy this over to you ROACH boffiles directory, chmod it to a+x as in the other tutorials, then load up your ROACH.
You don’t need to telnet in to the ROACH; all communication and configuration will be done by the python control
script called tut3.py.
Next, you need to set up your ROACH. Switch it on, making sure that:
• You have your ADC in ZDOK0, which is the one nearest to the power supply.
• You have your clock source connected to clk_i on the ADC, which is the second on the right. It should be generating
an 800MHz sine wave with 0dBm power.
The tut3.py spectrometer script
Once you’ve got that done, it’s time to run the script. First, check that you’ve connected the ADC to ZDOK0, and
that the clock source is connected to clk_i of the ADC. Now, if you’re in linux, browse to where the tut3.py file is in a
terminal and at the prompt type
./tut3.py <roach IP or hostname> -b <boffile name>

replacing with the IP address of your ROACH and with your boffile. You should see a spectrum like this:
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In the plot, there should be a fixed DC offset spike; and if you’re putting in a tone, you should also see a spike at the
correct input frequency. If you’d like to take a closer look, click the icon that is below your plot and third from the
right, then select a section you’d like to zoom in to. The digital gain (-g option) is set to maximum (0xffff_ffff) by
default to observe the ADC noise floor. Reduce the gain (decrease the value (for a -10dBm input 0x100)) when you
are feeding the ADC with a tone, as not to saturate the spectrum.
Now you’ve seen the python script running, let’s go under the hood and have a look at how the FPGA is programmed
and how data is interrogated. To stop the python script running, go back to the terminal and press ctrl + c a few times.
iPython walkthrough
The tut3.py script has quite a few lines of code, which you might find daunting at first. Fear not though, it’s all pretty
easy. To whet your whistle, let’s start off by operating the spectrometer through iPython. Open up a terminal and type:
ipython

and press enter. You’ll be transported into the magical world of iPython, where we can do our scripting line by line,
similar to MATLAB. Our first command will be to import the python packages we’re going to use:
import corr,time,numpy,struct,sys,logging,pylab

Next, we set a few variables:
katcp_port = 7147
roach = 'enter IP address or hostname here'
timeout = 10

Which we can then use in FpgaClient() such that we can connect to the ROACH and issue commands to the FPGA:
fpga = corr.katcp_wrapper.FpgaClient(roach,katcp_port, timeout)

We now have an fpga object to play around with. To check if you managed to connect to your ROACH, type:
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fpga.is_connected()

Let’s set the bitstream running using the progdev() command:
fpga.progdev('tut3.bof')

Now we need to configure the accumulation length and gain by writing values to their registers. For two seconds and
maximum gain: accumulation length, 2*(2^28)/2048, or just under 2 seconds:
fpga.write_int('acc_len',2*(2**28)/2048)
fpga.write_int('gain',0xffffffff)

Finally, we reset the counters:
fpga.write_int('cnt_rst',1)
fpga.write_int('cnt_rst',0)

To read out the integration number, we use fpga.read_uint():
acc_n = fpga.read_uint('acc_cnt')

Do this a few times, waiting a few seconds in between. You should be able to see this slowly rising. Now we’re ready
to plot a spectrum. We want to grab the even and odd registers of our PFB:
a_0=struct.unpack('>1024l',fpga.read('even',1024*4,0))
a_1=struct.unpack('>1024l',fpga.read('odd',1024*4,0))

These need to be interleaved, so we can plot the spectrum. We can use a for loop to do this:
interleave_a=[]
for i in range(1024):
interleave_a.append(a_0[i])
interleave_a.append(a_1[i])

This gives us a 2048 channel spectrum. Finally, we can plot the spectrum using pyLab:
pylab.figure(num=1,figsize=(10,10))
pylab.plot(interleave_a)
pylab.title('Integration number %i.'%acc_n)
pylab.ylabel('Power (arbitrary units)')
pylab.grid()
pylab.xlabel('Channel')
pylab.xlim(0,2048)
pylab.show()

Voila! You have successfully controlled the ROACH spectrometer using python, and plotted a spectrum. Bravo! You
should now have enough of an idea of what’s going on to tackle the python script. Type exit() to quit ipython. tut3.py
notes ==
Now you’re ready to have a closer look at the tut3.py script. Open it with your favorite editor. Again, line by line is
the only way to fully understand it, but to give you a head start, here’s a few notes:
Connecting to the ROACH
To make a connection to the ROACH, we need to know what port to connect to, and the IP address or hostname of our
ROACH. The connection is made on line 96:
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fpga = corr.katcp_wrapper.FpgaClient(...)

The katcp_port variable is set on line 16, and the roach variable is passed to the script at the terminal (remember that
you typed python tut3.py roachname). We can check if the connection worked by using fpga.is_connected(), which
returns true or false:
if fpga.is_connected():

The next step is to get the right bitstream programmed onto the FPGA fabric. The bitstream is set on line 15:
bitstream = 'tut3.bof'

Then the progdev command is issued on line 108:
fpga.progdev(bitstream)

Passing variables to the script
Starting from line 64, you’ll see the following code:
from optparse import OptionParser
p = OptionParser()
p.set_usage('tut3.py <ROACH_HOSTNAME_or_IP> [options]')
p.set_description(__doc__)
p.add_option('-l','--acc_len',dest='acc_len',
type='int', default=2*(2**28)/2048,
help='Set the number of vectors to accumulate between dumps. default is 2*(2^28)/2048,
˓→ or just under 2 seconds.')
p.add_option('-g', '--gain', dest='gain',
type='int',default=0xffffffff,
help='Set the digital gain (6bit quantisation scalar). Default is 0xffffffff (max),
˓→good for wideband noise. Set lower for CW tones.')
p.add_option('-s', '--skip', dest='skip', action='store_true',
help='Skip reprogramming the FPGA and configuring EQ.')
opts, args = p.parse_args(sys.argv[1:])
if args==[]:
print 'Please specify a ROACH board. Run with the -h flag to see
˓→options.\nExiting.'
exit()
else:
roach = args[0]

all

What this code does is set up some defaults parameters which we can pass to the script from the command line. If the
flags aren’t present, it will default to the values set here.
Conclusion
If you have followed this tutorial faithfully, you should now know:
• What a spectrometer is and what the important parameters for astronomy are.
• Which CASPER blocks you might want to use to make a spectrometer, and how to connect them up in Simulink.
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• How to connect to and control a ROACH spectrometer using python scripting.
In the following tutorials, you will learn to build a correlator, and a polyphase filtering spectrometer using an FPGA
in conjunction with a Graphics Processing Unit (GPU).

2.2.4 Tutorial 4: Wideband Pocket Correlator
Introduction
In this tutorial, you will create a simple Simulink design which uses the iADC board on ROACH and the CASPER
DSP blockset to process a wideband (400MHz) signal, channelize it and output the visibilities through ROACH’s PPC.
By this stage, it is expected that you have completed tutorial 1 and tutorial 2 and are reasonably comfortable with
Simulink and basic Python. We will focus here on higher-level design concepts, and will provide you with low-level
detail preimplemented.
Background
Some of this design is similar to that of the previous tutorial, the Wideband Spectrometer. So completion of tutorial 3
is recommended.
Interferometry
In order to improve sensitivity and resolution, telescopes require a large collection area. Instead of using a single,
large dish which is expensive to construct and complicated to maneuver, modern radio telescopes use interferometric
arrays of smaller dishes (or other antennas). Interferometric arrays allow high resolution to be obtained, whilst still
only requiring small individual collecting elements.
Correlation
Interferometric arrays require the relative phases of antennas’ signals to be measured. These can then be used to
construct an image of the sky. This process is called correlation and involves multiplying signals from all possible
antenna pairings in an array. For example, if we have 3 antennas, A, B and C, we need to perform correlation across
each pair, AB, AC and BC. We also need to do auto-correlations, which will give us the power in each signal. ie AA,
BB, CC. We will see this implemented later. The complexity of this calculation scales with the number of antennas
squared. Furthermore, it is a difficult signal routing problem since every antenna must be able to exchange data with
every other antenna.
Polarization
Dish type receivers are typically dual polarized (horizontal and vertical feeds). Each polarization is fed into separate
ADC inputs. When correlating these antennae, we differentiate between full Stokes correlation or a half Stokes
method. A full Stokes correlator does cross correlation between the different polarizations (ie for a given two antennas,
A and B, it multiplies the horizontal feed from A with the vertical feed from B and vice-versa). A half stokes correlator
only correlates like polarizations with each other, thereby halving the compute requirements.
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The Correlator
The correlator we will be designing is a 4 input correlator as shown below. It uses 2 inputs from each of two ADCs. It
can be thought of as a 2-input full Stokes correlator or as a four input single polarization correlator.

Setup
The lab at the workshop is preconfigured with the CASPER libraries, Matlab and Xilinx tools. Start Matlab.
Creating Your Design
Create a new model
Having started Matlab, open Simulink (either by typing simulink on the Matlab command line, or by clicking the
Simulink icon in the taskbar). Create a new model and add the Xilinx System Generator and XSG core config blocks
as before in Tutorial 1.
System Generator and XSG Blocks

390

Chapter 2. Tutorial Instructions

CASPER Tutorials Documentation, Release 0.1

By now you should have used these blocks a number of times. Pull the System Generator block into your design from
the Xilinx Blockset menu under Basic Elements. The settings can be left on default.
The XSG block can be found under the CASPER XPS System Blockset. Set the Hardware platform to ROACH:sx95t,
the Clock Source to adc0_clk and the rest of the configuration as the default.
Make sure you have an ADC plugged into ZDOK0 to supply the FPGA’s clock!
Sync Generator

The Sync Generator puts out a sync pulse which is used to synchronize the blocks in the design. See the CASPER
memo on sync pulse generation for a detailed explanation.
This sync generator is able to synchronize with an external trigger input. Typically we connect this to a GPS’s 1pps
output to allow the system to reset on a second boundary after a software arm and thus know precisely the time at
which an accumulation was started. To do this you can input the 1pps signal into either ADCs’ sync input. The sync
pulse allows data to be tagged with a precise timestamp. It also allows multiple ROACH boards to be synchronized,
which is useful if large numbers of antenna signals are being correlated.
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ADCs

Connection of the ADCs is as in tutorial 3 except for the sync outputs. Here we OR all four outputs together to produce
a sync pulse sampled at one quarter the rate of the ADC’s sample clock. This is the simplest way of dealing with the
four sync samples supplied to the FPGA on every clock cycle, but means that our system can only be synchronized to
within 3 ADC sample clocks.
Logic is also provided to generate a sync manually via a software input. This allows the design to be used even in the
absence of a 1 pps signal. However, in this case, the time the sync pulse occurs depends on the latency of software
issuing the sync command and the FPGA signal triggering. This introduces some uncertainty in the timestamps
associated with the correlator outputs. We will not use the 1pps in this tutorial although the design has the facility to
do this hardware sync’ing.
Set up the ADCs as follows and change the second ADC board’s mask parameter to adc1. . .
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Throughout this design, we use CASPER’s bus_create and bus_expand blocks to simplify routing and make the design
easier to follow.

For the purposes of simulation, it can be useful to put simulation input signals into the ADCs. These blocks are pulse
generators in the case of sync inputs and any analogue source for the RF inputs (noise, CW tones etc).

2.2. ISE

393

CASPER Tutorials Documentation, Release 0.1

394

Chapter 2. Tutorial Instructions

CASPER Tutorials Documentation, Release 0.1

Control Register

This part of the Simulink design sets up a software register which can be configured in software to control the correlator. Set the yellow software register’s IO direction as from processor. You can find it in the CASPER_XPS System
blockset. The constant block input to this register is used only for simulation.
The output of the software register goes to three slice blocks, which will pull out the individual parameters for use
with configuration. The first slice block (top) is setup as follows:
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The slice block can be found under the Xilinx Blockset → Control Logic. The only change with the subsequent slice
blocks is the Offset of the bottom bit. They are, from top to bottom, respectively,16, 17 & 18.
After each slice block we put an edge_detect block, this outputs true if a boolean input signal is true this clock and
was false last clock. Found under CASPER DSP Blockset → Misc.
Next are the delay blocks. They can be left with their default settings and can be found under Xilinx Blockset →
Common.
The Goto and From bocks can be found under Simulink-> Signal Routing. Label them as in the block diagram above.
Clip Detect and status reporting
To detect and report signal saturation (clipping) to software, we will create a subsystem with latching inputs.
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The internals of this subsystem (right) consist of delay blocks, registers and cast blocks.
The delays (inputs 2 - 9) can be keep as default. Cast blocks are required as only unsigned integers can be concatenated.
Set their parameters to Unsigned, 1 bit, 0 binary points Truncated Quantization, Wrapped Overflow and 0 Latency.
The Registers (inputs 10 - 33) must be set up with an initial value of 0 and with enable and reset ports enabled. The
status register on the output of the clip detect is set to processor in with unsigned data type and 0 binary point with a
sample period of 1.
PFBs, FFTs and Quantisers
The PFB FIR, FFT and the Quantizer are the heart of this design, there is one set of each for the 4 outputs of the
ADCs. However, in order to save resources associated with control logic and PFB and FFT coefficient storage, the
four independent filters are combined into a single simulink block. This is configured to process four independent data
streams by setting the “number of inputs” parameter on the PFB_FIR and FFT blocks to 4.

Configure the PFB_FIR_generic blocks as shown below:
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There is potential to overflow the first FFT stage if the input is periodic or signal levels are high as shifting inside the
FFT is only performed after each butterfly stage calculation. For this reason, we recommend casting any inputs up to
18 bits with the binary point at position 17 (thus keeping the range of values -1 to 1), and then ownshifting by 1 bit to
place the signal in one less than the most significant bits.
The fft_wideband_real block should be configured as follows:
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The Quantizer Subsystem is designed as seen below. The quantizer removes the bit growth that was introduced in the
PFB and FFT. We can do this because we do not need the full dynamic range.
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The top level view of the Quantizer Subsystem is as seen below.
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LEDs
The following sections are more periphery to the design and will only be touched on. By now you should be comfortable putting the blocks together and be able to figure out many of the values and parameters. Also feel free to consult
the reference design which sits in the tutorial 4 project directory or ask any questions of the tutorial helpers.
As a debug and monitoring output we can wire up the LEDs to certain signals. We light an LED with every sync pulse.
This is a sort of heartbeat showing that the design is clocking and the FPGA is running.
We light an error LED in case any ADC overflows and another if the system is reset. The fourth LED gives a visual
indication of when an accumulation is complete.
ROACH’s LEDs are negative logic, so when the input to the yellow block is high, the LED is off. Since this is the
opposite of what you’d normally expect, we invert the logic signals with a NOT gate.
Since the signals might be too short to light up an LED and for us to actually see it (consider the case where a single
ADC sample overflows; 1/800MHz is 1.25 nS – much too short for the human eye to see) we add a negedge delay
block which delays the negative edge of a block, thereby extending the positive pulse. A length of 2^23 gives about a
10ms pulse.

ADC RMS
These blocks calculate the RMS values of the ADCs’ input signals. We subsample the input stream by a factor of four
and do a pseudo random selection of the parallel inputs to prevent false reporting of repetitive signals. This subsampled
stream is squared and accumulated for 2^16 samples.
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The MAC operation
The multiply and accumulate is performed in the dir_x (direct-x) blocks, so named because different antenna signal
pairs are multiplied directly, in parallel (as opposed to the packetized correlators’ X engines which process serially).
Two sets are used, one for the even channels and another for the odd channels. Accumulation for each antenna pair
takes place in BRAM using the same simple vector accumulator used in tut3.
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CONTROL:
The design starts by itself when the FPGA is programmed. The only control register inputs are for resetting counters
and optionally sync’ing to external signal.
Sync LED provides a “heartbeat” signal to instantly see if your design is clocked sensibly.
New accumulation LED gives a visual indication of data rates and dump times.
Accumulation counter provides simple mechanism for checking if a new spectrum output is available. (poll and
compare to last value)
Software
The python scripts are located in the tut4 tutorial directory. We first need to run poco_init.py to program the FPGA
and configure the design. Then we can run either the auto or the cross correlations plotting scripts (plot_poco_auto.py
and plot_poco_cross.py).
poco_init.py
print('Connecting to server %s on port %i... '%(roach,katcp_port)),
fpga = corr.katcp_wrapper.FpgaClient(roach, katcp_port,
timeout=10,logger=logger)
(continues on next page)
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(continued from previous page)

time.sleep(1)
if fpga.is_connected():
print 'ok\n'
else:
print 'ERROR connecting to server %s on port %i.\n'%
(roach,katcp_port)
exit_fail()
print '------------------------'
print 'Programming FPGA...',
if not opts.skip:
fpga.progdev(boffile)
print 'done'
else:
print 'Skipped.'
print 'Configuring fft_shift...',
fpga.write_int('fft_shift',(2**32)-1)
print 'done'
print 'Configuring accumulation period...',
fpga.write_int('acc_len',opts.acc_len)
print 'done'
print 'Resetting board, software triggering and resetting error
counters...',
fpga.write_int('ctrl',1<<17) #arm
fpga.write_int('ctrl',1<<18) #software trigger
fpga.write_int('ctrl',0)
fpga.write_int('ctrl',1<<18) #issue a second trigger
print 'done'

In previous tutorials you will probably have seen very similar code to the code above. This initiates the katcp wrapper
named fpga which manages the interface between the software and the hardware. fpga.progdev programs the boffile
onto the FPGA and fpga.write_int writes to a register.
poco_adc_amplitudes.py
This script outputs in the amplitudes (or power) of each signal as well as the bits used. It updates itself ever second or
so.
ADC amplitudes
-------------ADC0 input I: 0.006 (0.51 bits used)
ADC0 input Q: 0.004 (0.19 bits used)
ADC1 input I: 0.005 (0.45 bits used)
ADC1 input Q: 0.004 (0.19 bits used)
-----------------------------------

poco_plot_auto.py
This script grabs auto-correlations from the brams and plots them. Since there are 4 inputs, 2 for each ADC there are
4 plots. Some plots will be random if there is no noise source or tone being inputted into ADC. Ie plots 3 and 4.
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poco_plot_cross.py This script grabs cross-correlations from the brams and plots them. This plotshows the crosscorrelation of AB.
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